Teamcenter 12

Release Notes
# Contents

Overview of product release notes ...................................................... 1-1

Teamcenter Rapid Start release notes .................................................. 2-1

Installation and upgrade release notes ................................................. 3-1

Installation ......................................................................................... 3-1
  General installation ........................................................................... 3-1
  Audit Manager installation ................................................................. 3-8
  Lifecycle Visualization installation ....................................................... 3-9
Upgrade ................................................................................................. 3-9
  General upgrade ................................................................................ 3-9
  Access Manager upgrade .................................................................... 3-13
  Classification upgrade ........................................................................ 3-13

Usage release notes .............................................................................. 4-1

4th Generation Design .......................................................................... 4-1
Business Modeler IDE ............................................................................ 4-3
Change Manager ................................................................................... 4-4
Classification ....................................................................................... 4-7
Client for Office .................................................................................... 4-10
Content Management ............................................................................ 4-14
Data Exchange ...................................................................................... 4-15
Document Management ........................................................................ 4-16
Extensions for Office ............................................................................ 4-17
Global Services ..................................................................................... 4-18
GM Overlay ......................................................................................... 4-20
Lifecycle Interoperability Services ......................................................... 4-20
Lifecycle Visualization ......................................................................... 4-21
Service Lifecycle Management ............................................................... 4-24
Manufacturing Process Planner ............................................................. 4-26
Mechatronics Process Management ....................................................... 4-30
Multi-Site ............................................................................................. 4-32
My Teamcenter .................................................................................... 4-32
NX Integration ....................................................................................... 4-34
Online help ........................................................................................... 4-35
PLM XML .............................................................................................. 4-35
Project .................................................................................................. 4-36
Query Builder ....................................................................................... 4-37
Repeatable Digital Validation ............................................................... 4-38
Report Builder ..................................................................................... 4-38
Reporting and Analytics ....................................................................... 4-38
Requirements Manager ........................................................................ 4-41
Schedule Manager .................................................. 4-43
Simulation Process Management .................................. 4-45
Specification Manager ................................................. 4-46
Structure Manager ..................................................... 4-46
Systems Engineering and Requirements Management .......... 4-55
Vendor management ................................................. 4-72
Teamcenter Integration Framework .................................. 4-73
Visualization Illustration ............................................. 4-75
Workflow ........................................................................ 4-75

Administration release notes ........................................ 5-1
General administration .................................................. 5-1
Dispatcher administration release notes ............................. 5-4
Integrated Product Definition .......................................... 5-6
Organization .................................................................. 5-6
Security Services ......................................................... 5-7
Server Manager ........................................................... 5-8
Site Consolidation .......................................................... 5-10
Subscription Administration ........................................... 5-10
Utilities ........................................................................ 5-10

Teamcenter interfaces release notes ................................. 6-1
Rich client ...................................................................... 6-1

Internationalization release notes ................................. 7-1

Third-party release notes .............................................. 8-1
Third-party release notes ................................................. 8-1

Platform-specific release notes ..................................... 9-1
Microsoft Windows ....................................................... 9-1
Linux platforms .......................................................... 9-1
UNIX platforms ........................................................... 9-2
Apple Macintosh MacOS ................................................. 9-4
Chapter 1: Overview of product release notes
Chapter 1: Overview of product release notes

Product release notes describe known problems in Teamcenter software and provide workarounds if available.

Note
For release notes pertaining to Product Master Management, see the Product Master Management Release Bulletin.
Chapter 2: Teamcenter Rapid Start release notes
Chapter 2: Teamcenter Rapid Start release notes

The following notes pertain to Teamcenter Rapid Start.

- **TC_MFK_DEFAULT_DOMAIN** preference value required for Teamcenter Rapid Start NX
  (First published Teamcenter 10.1)

  Your NX integration does not work if the **TC_MFK_DEFAULT_DOMAIN** preference is missing.

  *How to work around or avoid*

  1. Close the rich client and TAO.

  2. Open the Teamcenter Rapid Start command prompt.

  3. Run the following command:

     ```bash
     preferences_manager -u=infodba -p=password -g=dba
     -mode=import -scope=SITE -preference=TC_MFK_DEFAULT_DOMAIN
     -values="Item" -action=OVERRIDE
     ```

  4. Close the command prompt.

  5. Verify your NX integration is working.
Chapter 3: Installation and upgrade release notes

Installation ................................................................. 3-1
  General installation ................................................. 3-1
  Audit Manager installation ......................................... 3-8
  Lifecycle Visualization installation ............................... 3-9

Upgrade ................................................................. 3-9
  General upgrade .................................................... 3-9
  Access Manager upgrade ........................................... 3-13
  Classification upgrade ............................................. 3-13
Chapter 3: Installation and upgrade release notes

Installation

General installation

The following general release notes pertain to the installation of Teamcenter.

• Key Manager Satellite and Corporate Server must be on same host in Deployment Center distributed environment

(First published Teamcenter 12)

Ensure the Key Manager Satellite and Corporate Server/Business Logic Server are configured and installed on the same box when installing in a distributed environment using Deployment Center.

In a distributed installation of Teamcenter Foundation, Key Manager functionality will not be enabled on Corporate Server if Key Manager Satellite is not configured and installed on the same machine of Corporate Server/Business Logic Server.

How to work around or avoid

When Key Manager and Teamcenter Foundation Applications are selected in Deployment Center using distributed environment option, you must configure Key Manager Satellite and Corporate Server/Business Logic Server components on the same machine to enable Teamcenter running with Key Manager. Other components such as Database Server, FSC, Licensing Server, and Key Manager Server components, can be installed on a separate machine.

• Prerequisite for LDF features must be selected during Business Modeler IDE installation

(First published Teamcenter 12)

During the installation of Business Modeler IDE client, in the Business Modeler IDE client panel, if you choose to install either the LDF Server Support feature (osl0lisoslic template) or the LDF Change Management Integration feature (lcm0liscm template), then you must ensure that the LDS Foundation feature (lis0lisfmrwk template) is also selected. Failure to do so will result in a java.io.FileNotFoundException error in TEM.

How to work around or avoid

There is no workaround for this issue.

• Patching secondary server fails unzipping TC_DATA artifacts

(First published Teamcenter 12)

The following problem applies to these criteria:

o You are using the Deployment Center to apply a Teamcenter Foundation 11.x to 11.4+ patch.

o The environment is a distributed environment.
o The environment contains a “Business Logic Server” component.

If this scenario exists, and you generate the deploy scripts, the deploy script for the “Business Logic Server” component will fail with the following message:

Failed to change file modification time
Unable to expand to file

How to work around or avoid
If you have not yet generated the deploy scripts for this environment, perform the following:

o Download DeploymentCenter_2.1_configurations.zip from GTAC.

o Unzip and locate the fn0_bldatamodel_artifact.xml file.

o Copy/replace this file into the following directory in the Deployment Center directory structure:
  
  \software-repository-directory\dc_contributions\Teamcenter\Foundation\all-11.4.x-or-11.5-directories\dc_contributions\packages

o Generate the deploy scripts using the Deploy task for the environment and proceed with executing the deploy scripts on the target machines.

If you have already tried to execute the deploy scripts, and the deployment failed on the target machine, then follow the instructions given below:

o Download DeploymentCenter_2.1_configurations.zip from GTAC

o Unzip and locate the fn0_bldatamodel_artifact.xml file.

o On the target machine, replace this file in the following location:
  
  \deploy-script-directory\dc_contributions\Teamcenter\Foundation\all-11.4.x-or-11.5-directories\dc_contributions\packages

o Re-execute the deploy script.

• Error message when patching Teamcenter Integration Framework
(First published Teamcenter 12)

The following error message pops up during patch of Teamcenter Integration Framework using TEM:

Unable to map ICZJ209H33KMX8UF377QETAQ9QD0GU68 to
com.teamcenter.install.tceng.integrationframwork.dc.IFDataComponent
java.lang.ClassNotFoundException:
com.teamcenter.install.tceng.integrationframwork.dc.IFDataComponent

How to work around or avoid
Cancel the error message and proceed. The error message is benign.

• Multiple occurrences of Runtime Exception stack traces in a log file for successful deployment
(First published Teamcenter 12)
While deploying Teamcenter Foundation and Active Workspace together, if a deployment also contains any of the following optional components:

- Business Modeler IDE Standalone
- Business Modeler IDE 2-tier
- Business Modeler IDE 4-tier

Then, deployer log may have stack traces with some runtime exceptions as follows:

```java
RuntimeException: The type "Awb0Element" is not present in the database.
```

If there is an exception stack trace with the message in **bold** above in the deployer log, then follow the steps as given in the workaround as needed.

**How to work around or avoid**

These errors can be safely ignored.

- **While creating a new custom software, the required dependent templates could not be found in BMIDE’s dependent template selection wizard**

  (First published Teamcenter 12)

  If an installation contains Teamcenter Foundation and/or any asynchronous or custom software deployed to the database, and also has Business Modeler IDE installed, a required dependency may not be available in the dependent template selection panel in the BMIDE.

  For example, if you launch the Business Modeler IDE from the installed environment and try to create a custom “External BMIDE template project”, some dependent templates may be missing from the list. In such cases, follow the steps in the following workaround.

  **How to work around or avoid**

  Add the template to be used within BMIDE through TEM. For more information, see *Add a template to a Business Modeler IDE project* in *Configure your business data model in BMIDE* in the Teamcenter help collection.

- **TEM does not allow corrections to entered patch locations**

  (First published Teamcenter 12)

  TEM does not allow corrections to entered patch locations.

  **How to work around or avoid**

  To correct mistakes in a path that has been entered in the **Update Locations** list, use the following steps:

  1. Select the field containing the incorrect path.
  2. Click **Remove**.
  3. Click **Browse**.
4. Navigate to the correct path in the directory browser.

5. Click **Open** in the directory browser to accept the location entered.

- **TEM breaks old configuration.xml during upgrade**
  (First published Teamcenter 12)

TEM breaks the old configuration.xml file during upgrade.

**How to work around or avoid**

This is only a problem in environments where multiple configurations exist. To correct this problem in a multi-configuration environment, once you have upgraded a configuration:

1. Open `OLD_TC_ROOT/install/configuration.xml` in a text editor.
2. Remove the `<sourceLocations>` element.
3. Save the file.
4. Repeat steps 1-3 for each configuration until all configurations have been upgraded.

This will eliminate the problem on the next upgrade.

- **Teamcenter help content installer hangs on Linux**
  (First published Teamcenter 12)

When installing Teamcenter help into the Siemens PLM Documentation Server on a Linux host, the **tchelp.bin** program hangs. The program displays no error messages. This problem occurs whether you run **tchelp.bin** as root or as a nonroot user.

**How to work around or avoid**

1. Set global execute permissions (777) for the following directories:
   - `PLM-Doc-Server-root/collections`
   - `PLM-Doc-Server-root/solr_updates`

   If these directories do not already exist, create them.

2. Run **tchelp.bin** again.

- **Teamcenter Extensions for MS Office installation fails on Office 2013**
  (First published Teamcenter 12)

When user installing Teamcenter Extension for MS Office, the installer prompts you to "enable Excel .NET Programmability Support feature," then the installer exits. Even when the Excel .NET Programmability Support feature is enabled in the Office 2013 setup, this message still appears and installation ends. This whether you install using the standalone installation wizard or TEM.

**How to work around or avoid**

The standalone installer is fixed in 11.2.1 release. Follow these steps to install Teamcenter Extensions for MS Office:
o Using the standalone installation wizard:
  1. Unzip "office_ext.zip" file from "tc" directory in the 11.2 RTM kit to a temporary location.
  2. Unzip "office_ext.zip" file from "tc" directory in the 11.2.1 Patch kit to the above location to overwrite files there. This will make a complete runtime file set for 11.2.1.
  3. Zip up the above files to make a new zip file called "office_ext.zip" and use this file to overwrite the same file in the 11.2.1 Patch kit. (the file mentioned in step 2).
  4. Run tc_ext4mso.exe from "additional_applications\tc_ext4mso" directory in the 11.2.1 Patch kit to install Teamcenter Extension for MS Office.

o Using TEM:
  1. Copy tc_ext4mso.exe from the additional_applications\tc_ext4mso directory in the 11.2.1 software kit to the same location in the Teamcenter 11.2 software kit to overwrite the old tc_ext4mso.exe.
  2. Run TEM from the 11.2.1 patch kit to install the Teamcenter Extensions for MS Office feature.
  3. TEM uses the updated standalone installer to install the 11.2 version of Teamcenter Extension for MS Office. You need to manually update the binary files from 11.2.1 kit as the next step.
  4. Unzip tcoffice_ext.zip from 11.2.1 kit to overwrite the files in the installation location.

• **Standalone Data Share Manager (DSM) installer does not install on SUSE Linux 12**
  
  (First published Teamcenter 12)
  
The standalone Data Share Manager (DSM) installer does not install on SUSE Linux 12.

  How to work around or avoid
  
  Specify the JRE on the command line, for example:

  `install.bin LAX_VM path-to-JRE-executable`

• **Set FMS_HOME environment variable in start_nx_graphicsbuilder script or system environment**
  
  (First published Teamcenter 12)
  
The `TC_ROOT\bin\nx_graph\start_nxgraphicsbuilder.bat` (or `.sh` script on UNIX/Linux platforms) does not work if `FMS_HOME` is not set in the environment or in the script.

  How to work around or avoid
  
  On Windows platforms, edit `TC_ROOT\bin\nx_graph\start_nxgraphicsbuilder.bat` and add `SET FMS_HOME=TC_ROOT\tccs`

  On UNIX platforms, edit `TC_ROOT/bin/nx_graph/start_nxgraphicsbuilder.sh` and add `export FMS_HOME=TC_ROOT\tccs`

  In the above changes, replace `TC_ROOT` with the full path to the Teamcenter root directory.
**Linux not able to install new Data Share Manager (DSM) after removing earlier version of DSM**

(First published Teamcenter 12)

When trying to install Data Share Manager (DSM) on a Linux client, if you run `/install.bin`, the installer asks you to remove the existing DSM. If you do that and then try to re-install DSM again, the installation fails with this error:

```
Error while checking for instances. An error occurred while trying to manage the selected instance.
```

**How to work around or avoid**

The error occurs when the uninstaller folder is tampered with for the previous instance and hence the Instance management of InstallAnywhere is not able to manage it. Following are the steps for cleaning the corrupted instance.

1. Perform the appropriate step for your platform type:
   - **Windows systems:**
     - Open the `C:\Program Files\Zero G Registry` folder and find the `.com.zerog.registry.xml` file. If necessary, turn on hidden file display to see the file.
   - **Linux systems:**
     - If you are logged in as root, find the `.com.zerog.registry.xml` file in the `/var` directory.
     - If you cannot see the file in `/var`, use the `ls -A` command to list the files and you will be able to see that file.
     - If you are logged in as a nonroot user, the file will be present in your user directory.
     - Once you can open the file, you can clean up the instance information as described in the following steps.

2. Save a copy of this file, in case you have any other InstallAnywhere installations like TCCS.

3. In the `.com.zerog.registry.xml` file, there should be entries for product and component for DSM:

```xml
<component id="54cad522-1f16-11b2-bbef-974fa857b767" version="1.0.0.0"
  location="C:\Users\katep\Siemens\dsmgr\Data_Share_Manager_installation\Change_Data_Share_Manager_Installation.exe"/>
<component id="54cad522-1f16-11b2-bbef-974fa857b767" version="1.0.0.0"
  location="C:\Users\katep\Siemens\dsmgr\dm\com\teamcenter\fms\dlmgr\ui\controls\dialogs.css"/>
<component id="54cad522-1f16-11b2-bbef-974fa857b767" version="1.0.0.0"
  location="C:\Users\katep\Siemens\dsmgr\dm\com\teamcenter\fms\dlmgr\ui\controls\dialogs.css"/>
```

4. Change the following permissions:

```bash
sudo chown -R katep:katep /path/to/DSM/folder
```

5. Restart the Linux client.

6. Install DSM again.

**Notes**

- If you need access to the previous DSM version, you can restore the corrupted instance using the `reinstall.bat` script.
- If you do not need access to the previous DSM version, you can remove the corrupted instance using the `uninstall.bat` script.

**Windows installations:**

- Open the `C:\Program Files\Zero G Registry` folder and find the `.com.zerog.registry.xml` file. If necessary, turn on hidden file display to see the file.
- If you cannot see the file in `/var`, use the `ls -A` command to list the files and you will be able to see that file.
- If you are logged in as a nonroot user, the file will be present in your user directory.
- Once you can open the file, you can clean up the instance information as described in the following steps.

**Linux installations:**

- If you are logged in as root, find the `.com.zerog.registry.xml` file in the `/var` directory.
- If you cannot see the file in `/var`, use the `ls -A` command to list the files and you will be able to see that file.
- If you are logged in as a nonroot user, the file will be present in your user directory.
- Once you can open the file, you can clean up the instance information as described in the following steps.
Remove these entries and then save the file.

4. Restart the DSM installer, then try to install and uninstall again.

- **Application perspectives not appearing in rich client**
  (First published Teamcenter 12)

  When installing plugins like 4GD, MRO, and so on using TEM, if you select the **Rich Client (2-tier and 4-tier)** or **Teamcenter Rich Client (2 tier and 4 tier)** features, the corresponding plugin jar files are not copied to the plugins directory (portallplugins). As a result, the corresponding application perspective fails to appear after the installation is complete and you launch the rich client.

  **How to work around or avoid**

  Copy the jar files (portallplugins) and execute the %ROOT%\%PLAT%\eclipse\rcp\registry\genregxml.bat command.

- **Unable to upload or download files through FMS using Data Share Manager**
  (First published Teamcenter 12)

  If the Data Share Manager (DSM) client is not installed and DSM is enabled at the server, using the preference, users will not be able to upload or download files, through FMS. User may see the error manifesting itself by downloading a file with a .plmd extension which does not perform any function.

  **How to work around or avoid**

  Before enabling DSM through the preference, on Teamcenter server, administrators must ensure that DSM client is installed on their users’ machines and the security key is appropriately distributed. Users must contact their administrators if they face issues mentioned in the problem description to get DSM client and the security key installed in their machines.

- **TEM in recovery mode doesn't fix a template deployment failure.**
  (First published Teamcenter 12)

  Normally, when an install or update of a custom data model fails, a correction to the file(s) and a restart of TEM will resolve the issue. This is because TEM will re-unzip those files. If, however, the failure occurs in the post-processing of the templates, past the BMIDE stage, where TEM is regenerating caches, etc. then this process will not work. This is because no specific issue was identified as failing and so no files get re-unzipped.

  **How to work around or avoid**

  The workaround in this case is to manually unzip the files, then restart TEM.

- **Use the correct Web Application Manager for your Teamcenter version**
  (First published Teamcenter 11.2)
The Web Application Manager (launched by the `insweb` command) contains changes in Teamcenter 9.1.3.4, Teamcenter 10.1.4 and Teamcenter 11.2. You must use the Web Application Manager provided with your Teamcenter version. Using the Web Application Manager from a different Teamcenter release may cause errors during generation of the deployable file (`tc.war`) such as the following example:

```
ERROR: | Error during generation of
br:webroot\staging1\earapp_root\insweb142589795607\jetiAdapterCfg.properties file...
```

**How to work around or avoid**

When patching the web tier to Teamcenter 9.1.3.4, 10.1.4 or Tc11.2, use the correct corresponding Web Application Manager for your Teamcenter version.

**Audit Manager installation**

The following release notes pertain to installation and upgrade of Audit Manager.

- **Pre-upgrade workflow audit records display issue**
  
  (First published Teamcenter 12)

  Workflow task Target object summary page does not show workflow audit records for events generated in Audit Manager version 3 if that workflow has been started prior to upgrade and using AM2/AM1 prior to the upgrade.

  Reason: Target object based Audit query depends on `__Add_Attachment` event record data which is in AM2/AM1. If the Data from AM2 has not been migrated, system will not find the corresponding record in AM3 Table and hence unable to fetch the corresponding workflow audit records based on Target object.

  **How to work around or avoid**

  - If AM2 is used in pre-upgrade environment: Migrate Audit records from AM2 to AM3 Or view the workflow audit records in workflow viewer.
  - If AM1 is used in pre-upgrade environment: Send target object to Workflow Viewer and view audit records.

- **AuditManager: Additional indexes on audit tables**
  
  (First published Teamcenter 12)

  It takes significant time opening objects in Teamcenter having audit records. Most of the time is consumed fetching and displaying audit records for a selected target object in the rich client, Summary page → Audit Log tab.

  **How to work around or avoid**

  Prior to upgrading Teamcenter or after installing Teamcenter, configure indexes on AuditManager Solution III audit tables by executing following commands:

  ```
  install -add_func_index -u=<user> -p=<password>|-pf=<pwfile> -g=<group> -w=2 audit_object_inx 0 substr Fnd0WorkflowAudit fnd0Object
  install -add_func_index -u=<user> -p=<password>|-pf=<pwfile> -g=<group> -w=2 wfaudit_job_inx 0 substr Fnd0WorkflowAudit fnd0Job
  install -add_func_index -u=<user> -p=<password>|-pf=<pwfile> -g=<group> -w=2 generalAudit_Object_inx 0 substr Fnd0GeneralAudit fnd0Object
  install -add_func_index -u=<user> -p=<password>|-pf=<pwfile> -g=<group> -w=2 fileaccessAudit_secobject_inx 0 Fnd0FileAccesssAudit fnd0SecondaryObject
  ```
Lifecycle Visualization installation

The following release notes pertain to installation and upgrade of Lifecycle Visualization.

- **Embedded Lifecycle Visualization must be run in like environment**

  (First published Teamcenter 9.0)

  32-bit Lifecycle Visualization applications can be run only within 32-bit Web browser versions on 32-bit operating systems. Similarly, 64-bit Lifecycle Visualization applications must be run only within 64-bit Web browsers on 64-bit operating systems. Running 32-bit Lifecycle Visualization applications in a 64-bit environment is not supported, nor is running 64-bit Lifecycle Visualization applications in a 32-bit environment.

  This applies to the embedded Lifecycle Visualization viewer in all Lifecycle Visualization applications.

  **How to work around or avoid**

  Ensure that you use only supported configurations for Lifecycle Visualization, that is, 32-bit Lifecycle Visualization with 32-bit Web browsers and operating systems, and 64-bit Lifecycle Visualization with 64-bit Web browsers and operating systems.

Upgrade

General upgrade

Following are general release notes pertaining to upgrading from a previous version of Teamcenter.

- **Upgrade from Tc11.4/AW3.4 to Tc12/AW4.0 fails; database user requires CREATE TRIGGER privilege**

  (First published Teamcenter 12)

  Upgrading from Teamcenter 11.4/Active Workspace 3.4 to Teamcenter 12/Active Workspace 4.0 fails with this message:

  Failed with error code 1

  **How to work around or avoid**

  Grant the DB user the CREATE TRIGGER privilege.

- **Error when upgrading to Teamcenter 12 with Teamcenter Mechatronics Engineering**

  (First published Teamcenter 12)

  When upgrading to Teamcenter 12, an error is displayed if your previous Teamcenter deployment contains Behavior Modeling and MATLAB Integration templates. This is because Teamcenter Mechatronics Engineering does not support Teamcenter 12.

  **How to work around or avoid**

  If your current deployment contains Teamcenter Mechatronics Engineering templates such as Behavior Modeling and MATLAB Integration, you can take one of the following approaches:

  - Remove the Teamcenter Mechatronics Engineering templates and attempt the upgrade again.
o Leave Teamcenter Mechatronics Engineering templates installed and avoid upgrading to Teamcenter 12.

Support for the Teamcenter 12 platform will be available in a future version of Teamcenter Mechatronics Engineering.

- **SQL Server Recovery mode for upgrade**
  (First published Teamcenter 12)
  When an upgrade from a previous version of Teamcenter to Teamcenter 11.2.3 is performed, the Transaction Log grows significantly and unless significant disk space is provided and disk space monitored, you may risk running out of disk space provided for Transaction Log.
  **How to work around or avoid**
  Before running an upgrade, take a backup of all data so it can be re-instated. Then change the Recovery model of the SQL Server database to 'SIMPLE' model. Perform the full upgrade and then revert back to the original or the desired recovery model for the site.

- **business_model_updater command fails during upgrade**
  (First published Teamcenter 11.2)
  While upgrading from an earlier release to Teamcenter 11.2, the `business_model_updater` comamnd fails while running in the `-update=non_schema_ignore_lov_attach -process=delete` mode. This error is seen whenever a deployed custom template contains a subtype of the Form business object that uses properties defined on its storage class as properties on operation descriptors and overridden in the property constant values.
  **How to work around or avoid**
  Before starting the upgrade, open the custom template in the Business Modeler IDE, delete the property constant attachments on such operation input properties, package and use the custom template for upgrade.

- **Values of attributeType, arrayLength, isArray, and isTransient attributes cannot be changed**
  (First published Teamcenter 9.1)
  Beginning in Teamcenter 9.1, changes to the values of the attributes `attributeType`, `arrayLength`, `isArray` and `isTransient` cause the upgrade to fail. In earlier versions, these changes were ignored.
  **How to work around or avoid**
  If a test upgrade fails because of this change, the values of the attributes in the custom template must be modified with the ones in the database. After the custom template is corrected, there should be no issues during the production upgrade.
  If the test upgrade was not performed and this issue is noticed during the production upgrade, the values of these attributes in the custom template, `TC_DATA/model.xml`, and `TC_DATA/delta.xml` files must be modified to match the values in the database. After these changes are completed, the `manage_model_files` utility must be run to upload these changes to the datasets.

- **Outdated files in TC_USER_MSG_DIR directory cause upgrade problems**
  (First published Teamcenter 9.1)
Outdated files in the directory specified in the `TC_USER_MSG_DIR` environment variable can cause serious issues including problems during Teamcenter upgrade.

_How to work around or avoid_

Local copies of Teamcenter text server are kept in a directory referenced by the `TC_USER_MSG_DIR` environment variable.

Before you begin Teamcenter upgrade, you must refresh (merge) local copies of the files in the directory specified in `TC_USER_MSG_DIR` to reflect the changes in the latest version of Teamcenter.

For more information, see the *Localization Guide*.

• **Import of certain objects to previous Teamcenter version may cause data corruption**
  (First published Teamcenter 9.1)

The length of the following fields of following objects is increased from 32 to 128.

<table>
<thead>
<tr>
<th>Object</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADSPart</td>
<td>Source Document Id</td>
</tr>
<tr>
<td>ADSDrawing</td>
<td>Source Document Id</td>
</tr>
<tr>
<td>ADSDesign</td>
<td>Source Document Id</td>
</tr>
<tr>
<td>Data Requirement Item</td>
<td>Contract Reference</td>
</tr>
</tbody>
</table>

If you try to import these objects that have the fields shown above to a release prior to Teamcenter 9.1, and these fields have lengths greater than 32, your data may become corrupt.

_How to work around or avoid_

If you intend to import these objects to a release prior to Teamcenter 9.1, keep the lengths of these fields less than or equal to 32 because these fields represent item IDs of certain referred objects. Also, keep the lengths of the item IDs of these objects less than or equal to 32.

• **Upgrade failure logs**
  (First published Teamcenter 8.3i)

In case of upgrade failures, customers may not be familiar with the need to collect upgrade and installation logs to assist in resolving the upgrade problems.

_How to work around or avoid_

Use the `collect_install_upgrade_logs` utility to collect installation and upgrade error logs in case of failure. This in turn helps rapid resolution of upgrade issues.

In case of an upgrade failure, run the `collect_install_upgrade_logs` utility before you contact GTAC or file an IR (incident report). This utility collects installation and upgrade logs into a single ZIP archive.

Run the utility as follows based on your platform:

- Windows systems
  
  ```
  Teamcenter-software-distribution-image\additional_applications\upgradeutilities\collect_install_upgrade_logs.bat
  ```
o UNIX systems

Teamcenter-software-distribution-image/additional_applications/
upgradeutilities/collection_install_upgrade_logs.sh

When you run the `collect_install_upgrade_logs` utility, the utility prompts you for the following information:

o Path to the new Teamcenter root directory (`TC_ROOT`)

o Path to the new Teamcenter data directory (`TC_DATA`)

o Path to the output directory for the utility (where to store the collected log files)

The utility collects the required installation and upgrade logs into an archive named `install_upgrade_logs_number.zip`, where `number` is a random unique number, and places this archive in the output directory you specify. Upload the generated ZIP file to an IR (incident report).

**cae_geometry_fix utility fails during upgrade**

(First published Teamcenter 8 MP1)

The `cae_geometry_fix` utility is run automatically during upgrade to retype all existing CAEGeometry datasets to CAEGeom and then install the CAEGeometry item class and type. The installation of the CAEGeometry item type fails if any business rules reference the CAEGeometry dataset type prior to the upgrade attempt.

*How to work around or avoid*

Prior to initiating an upgrade to Teamcenter 12 from any version of Engineering Process Management, follow these steps:

1. Capture the existing business rule definitions:
   
   ```
   import_export_business_rules -u=infodba -p=password 
   -g=dba -action=export -rule=HideTypeRule -file=output-xml-file
   ```
   
2. Make a copy of the output XML file from the previous step. Modify the file by removing all tags in the file that contain the CAEGeometry string and save the modified XML file. Be careful when performing this step. After the modifications are complete, compare the modified file to the original to ensure that only the expected differences exist. There is no need to continue with this workaround if there were no instances of CAEGeometry in the output XML file from the previous step.

3. Remove the rules from the database:
   
   ```
   import_export_business_rules -u=infodba -p=password 
   -g=dba -action=delete -rule=HideTypeRule
   ```
   
4. Reload the rules except for those referring to CAEGeometry:
   
   ```
   import_export_business_rules -u=infodba -p=password 
   -g=dba -action=import -merge_add -rule=HideTypeRule 
   -file=modified-xml-file
   ```
   
5. Regenerate the schema file using:
   
   ```
   install -regen_schema_file infodba password dba
   ```
After the upgrade to Teamcenter 12, the rules can be re-created using standard Business Modeler IDE functionality to create business rules.

- **Database upgrade may fail at txml_import step when importing scope rules**
  (TC_DATA/defaultTransfermodes.xml)
  (First published Teamcenter 9.1)

  When upgrading to Teamcenter 9.1, if the `GMS_txml_string_separator` preference is set to something other than a comma (default value), the scope rules import and upgrade may fail. This preference is used to specify a separator for strings in TC XML import. For default scope rules .xml files, the separator should be a comma.

  *How to work around or avoid*

  Before starting the upgrade to Teamcenter 9.1, check to see if the `GMS_txml_string_separator` preference exists in the database. If it does, delete it temporarily. After the upgrade completes, you can reset the preference.

**Access Manager upgrade**

The following release notes pertain to Access Manager upgrades.

- **New rule must be added manually when upgrading existing databases**
  (First published Teamcenter 2007.1)

  If you are upgrading an existing database, you must manually add a required rule to support the new sequences feature and object content restoration if you cancel a checkout. If you are installing a new database, this rule is automatically created. If you already added the rule to Teamcenter 2007, you do not have to add it again.

  In Access Manager, add the following rule to the tree:

  1. Select the `Has Class (POM_object)` root node.
  2. Create a new `Has Class (WorkspaceObject)` condition.
  3. Move the new condition under `Has Class (POM_object)→System Objects`.
  4. Select the new condition.
  5. Create an `InactiveSequence (true)` condition in an `Inactive Sequence` access control list (ACL). In the ACL, remove all access privileges except Read and Copy for World. The Read and Copy privileges must remain blank.

**Classification upgrade**

The following release note pertains to the upgrade of the Classification application.

- **Hierarchy root class names retained after upgrade**
  (First published Teamcenter 8.1)

  After upgrading a database from Engineering Process Management, Classification retains the customized or legacy root class names in the hierarchy tree. If required, you can change these
names manually. For example, you can change legacy root node names to their new form as follows:

iMAN Classification Root—>SAM Classification Root
in-CLASS Classification Root—>Classification Root

**Note**

This action is optional. Classification continues to work correctly if you do not rename these nodes.
Chapter 4: Usage release notes

4th Generation Design ................................................................. 4-1
Business Modeler IDE .................................................................. 4-3
Change Manager ......................................................................... 4-4
Classification .............................................................................. 4-7
Client for Office ........................................................................... 4-10
Content Management ................................................................... 4-14
Data Exchange .............................................................................. 4-15
Document Management ................................................................. 4-16
Extensions for Office .................................................................... 4-17
Global Services ............................................................................. 4-18
GM Overlay ................................................................................ 4-20
Lifecycle Interoperability Services ............................................... 4-20
Lifecycle Visualization ................................................................ 4-21
Service Lifecycle Management ...................................................... 4-24
Manufacturing Process Planner .................................................... 4-26
Mechatronics Process Management .............................................. 4-30
Multi-Site ...................................................................................... 4-32
My Teamcenter ............................................................................ 4-32
NX Integration .............................................................................. 4-34
Online help ................................................................................... 4-35
PLM XML ..................................................................................... 4-35
Project .......................................................................................... 4-36
Query Builder ............................................................................... 4-37
Repeatable Digital Validation ...................................................... 4-38
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Builder</td>
<td>4-38</td>
</tr>
<tr>
<td>Reporting and Analytics</td>
<td>4-38</td>
</tr>
<tr>
<td>Requirements Manager</td>
<td>4-41</td>
</tr>
<tr>
<td>Schedule Manager</td>
<td>4-43</td>
</tr>
<tr>
<td>Simulation Process Management</td>
<td>4-45</td>
</tr>
<tr>
<td>Specification Manager</td>
<td>4-46</td>
</tr>
<tr>
<td>Structure Manager</td>
<td>4-46</td>
</tr>
<tr>
<td>Systems Engineering and Requirements Management</td>
<td>4-55</td>
</tr>
<tr>
<td>Vendor management</td>
<td>4-72</td>
</tr>
<tr>
<td>Teamcenter Integration Framework</td>
<td>4-73</td>
</tr>
<tr>
<td>Visualization Illustration</td>
<td>4-75</td>
</tr>
<tr>
<td>Workflow</td>
<td>4-75</td>
</tr>
</tbody>
</table>
Chapter 4: Usage release notes

4th Generation Design

The following release notes pertain to 4th Generation Design.

- **Deletion of intermediate DE causes children to renumber**
  
  (First published Teamcenter 12)
  
  In Teamcenter 11.3 and later versions, scenarios where multiple occurrences of an assembly were re-parented, the IDs of the corresponding DEs were found to be incorrect.
  
  This issue is resolved in Teamcenter 11.4.0.7, 11.5.0.1, and later versions to ensure IDs of DEs are consistent.

  *How to work around or avoid*
  
  A utility is being provided to detect DEs that have incorrect DE IDs.

- **Preference CM_change_space_enabled value should not be changed in production before Teamcenter 11.2.3 or Teamcenter 10.1.7**
  
  (First published Teamcenter 12)
  
  Preference **CM_change_space_enabled** is **FALSE** OOTB and should not be set to **TRUE** in any production environment, though it is visible in the preferences manager from rich client.
  
  Use this preference only while exploring new context functionality feature with 4th Generation Design. Do not use this in a production Change environment.

  *How to work around or avoid*
  
  Do not alter the preference setting OOTB for this preference.

- **Unpack All lines in Design Explorer in 4G Product Master application before performing alignment or visualization**
  
  (First published Teamcenter 12)
  
  It is always recommended to unpack All lines in Design Explorer in the 4G Product Master application before using it to perform alignment or visualization.
  
  When you use Design Explorer to do alignment, alignment cannot be performed using a packed line. Also there are visualization issues where selecting a packed sibling in the viewer does not highlight the packed line in Design Explorer or Aligned Design Explorer.

  *How to work around or avoid*
  
  You cannot use a packed line for alignment. The **PSEAutoPackPref** can be set to **0** to always open structures in Design Explorer as unpacked. However, this would also impact Structure Manager where by default structures open as packed. Hence, it is always recommended to unpack all lines in Design Explorer in the 4G Product Master Application.
• **4GBOM Part saved query is obsolete, replaced by 4G Part saved query in Teamcenter 11.3**

  (First published Teamcenter 12)

  The 4GBOM Part saved query is obsolete, and the 4G Part saved query is newly added in Teamcenter 11.3.

  **How to work around or avoid**

  In case of patch update or release upgrade scenarios, Siemens PLM Software recommends manually deleting the old saved query 4GBOM Part.

• **Deprecation of 4gd_populate_cd and 4g_easy utilities for data population in 4GD only**

  (First published Teamcenter 12)

  **How to work around or avoid**

  Functionality to populate data only in 4GD is deprecated from the following utilities:

  ```plaintext
  4gd_populate_cd
  4g_easy
  ```

  Instead, use the 4g_populate utility.

• **Remove the CPD_ItemRlzItemRevPropsToCarryOver site preference**

  (First published Teamcenter 12)

  4G Populate may give incorrect results if Project and License data is being carried over to 4GD objects.

  **How to work around or avoid**

  Remove the CPD_ItemRlzItemRevPropsToCarryOver site preference from the system. If present, this preference may give incorrect results when using 4G Populate utility.

• **Issue with applying effectivity on 4GD objects in "Current ECN Only" Mode.**

  (First published Teamcenter 12)

  Users can apply unit or date effectivities on the 4GD objects such as Design Elements and Partitions in the Engineering Change Notice (ECN) context under Current ECN Only mode only if the objects existed in the context of those ECNs.

  If the objects are created in Public context, the system displays the following error:

  ```plaintext
  The POM operation is not supported. The object "" could not be loaded or refreshed. Please refer to the preceding errors in this error stack for more information. The POM operation is not supported.
  ```

  **How to work around or avoid**

  Apply unit or date effectivities on the 4GD objects in the Engineering Change Notice (ECN) context.
Business Modeler IDE

The following release notes pertain to the Business Modeler IDE.

- **Localizations not deployed correctly from Live Update project**
  
  (First published Teamcenter 12)

  1. In the Business Modeler IDE, open a Live Update project.
  2. Pick any existing element that supports Live Updates, for example, Status or ID Context.
  3. Open the element in the editor in the Business Modeler IDE.
  4. Modify its display name.
  5. Save the data model.
  6. Deploy (via TEM or hot/live deploy).
  7. The new localization fails to show up in rich client.

*How to work around or avoid*

After step 5 above (Save the data model), notice the following:

The localization that you modified is saved at:

```
[project_live_update]/extensions/lang/en_US/project_template_en_US.xml
```

Notice that there is a duplicate entry (with old localization value) in:

```
[project_live_update]/extensions/lang/project_template_en_US.xml
```

If you delete the duplicate (old localization value) entry from the above file, then this problem will go away and you will be able to deploy and see the correct localization in rich client.

- **Duplicate instances appear in the Operation Descriptor tab for a required property**

  (First published Teamcenter 11.2)

In the Business Modeler IDE, when you add a new property and clear the Nulls Allowed check box to make the property mandatory, if you then open the **Operation Descriptor** tab, two instances of the property are displayed. When you reload the template, an **Operation Descriptor.Model** error is displayed.

*How to work around or avoid*

After all the properties are added to the template project, reload the project. After reloading, the Business Modeler IDE displays errors in the **Problems** view corresponding to all the duplicate operation input properties added due to this issue. Click on each error in the **Problems** view one at a time. The cursor is moved to the definition of a duplicate element in an extension XML file. Remove this definition. After all such duplicate definitions are removed, reload the Business Modeler IDE template project. If the reload is successful without any errors, the template is ready to deploy.
Change Manager

The following notes pertain to usage of Change Manager.

- **Archive assembly with Incremental Change fail to archive Change Object**
  (First published Teamcenter 12)

  When you use the "near line archive" feature and are applying a patch from Teamcenter 11.x to Tc11.5, the archive action fails.

  **How to work around or avoid**

  In the Teamcenter environment, execute the following command at production and archive sites to resolve this problem:

  ```
  $TC_BIN/tccxml_import -u=infodba -p=${TC_USER_PASSWD}
  -g=dba -scope_rules -scope_rules_mode=overwrite
  -file=${TC_DATA}/siteConsolidationTransferModes.xml
  ```

- **Write access required when assigning participants to change objects with workflows**
  (First published Teamcenter 12)

  In releases prior to Teamcenter 10.1.6 and Teamcenter 11.2.2, any workflow used to reassign a dynamic participant for a change object (for example, a Problem Report, Enterprise Change Request, Enterprise Deviation Request, or Enterprise Change Notice) did not require the user to have write access to the target change object. In releases Teamcenter 10.1.6 and Teamcenter 11.2.2 and later, any such workflows require the user to have write access to the target change object. If users have any custom workflows that are used to reassign dynamic participants for change objects, those workflows may fail after upgrading if the current user does not have write access to the target change object.

  **How to work around or avoid**

  After patching or upgrading to tc10.1.6 or tc11.2.2, inspect any custom workflows which are used to reassign dynamic participants. Assess whether users who will be executing those workflows are expected to also have write access to the change objects to which they will be applied. If they are not expected to have write access, the EPM-set-rule-based-protection handler must be added to each affected workflow to grant write access to the target change object. This should be applied just before any existing call to EPM-assign-responsible-party-dynamic-participant or EPM-assign-signoff-dynamic-participant.

- **Applying condition rules for custom change objects after patch or upgrade**
  (First published Teamcenter 12)

  After upgrading or patching to Teamcenter 10.1.6 or Teamcenter 11.2.2, existing custom condition rules that govern the creation of custom subclasses of change items are not applied unless additional adjustments are made to the custom condition rules.

  Change item classes delivered in Teamcenter with Change Manager include Problem Report (PR), Enterprise Change Request (ECR), Enterprise Deviation Request (EDR), and Enterprise Change Notice (ECN). Using the Business Modeler IDE (BMIDE), users may create custom subclasses of these classes. Each custom subclass may have a BMIDE condition rule associated with it that determines whether an object of that class can be created. If such custom subclass condition rules already exist prior to upgrading or patching to Teamcenter 10.1.6 or Teamcenter
11.2.2, changes to the custom BMIDE template will be necessary after the installation. Otherwise, the default condition rule behavior for the parent classes will apply. If no custom condition rules for custom change classes exist prior to installation, then no action is required.

The changes introduced in Teamcenter 10.1.6 and Teamcenter 11.2.2 to the application of custom change class condition rules allow for greater flexibility and ease of use when specifying condition rules. Prior to Teamcenter 10.1.6 and Teamcenter 11.2.2, condition rules for custom change classes had to be named specifically according to the custom class with which they were associated or they would not work. For example, the condition rule to control the creation of A5_ChangeNotice (a subclass of ECN), specifically had to be named A5_isA5_ChangeNoticeCreatable in order to function. Also, prior to Teamcenter 10.1.6 and Teamcenter 11.2.2, the condition rule signature was required to accept only a User Session as a parameter. As of Teamcenter 10.1.6 and Teamcenter 11.2.2, the condition rule now takes a Workspace Object and a User Session as parameters, with the Workspace Object representing a target object selected on the user interface. This additional parameter permits the condition rule to constrain the list of change types displayed for a create change in context operation on the basis of the type of object currently selected.

Because the number of condition rule parameters has changed in Teamcenter 10.1.6 and Teamcenter 11.2.2, it is necessary to create an intermediate condition rule accepting two parameters that can call the existing custom condition rule with only a User Session parameter so that the existing custom condition rule will still be applied. Users may also wish to take advantage of the additional Workspace Object parameter by replacing their existing custom condition rule with a new rule that accepts Workspace Object and User Session parameters.

**How to work around or avoid**

In Teamcenter 10.1.6 and Teamcenter 11.2.2, four new business object constants are available in the Change Management BMIDE template. Each of these string constants contains the name of the default condition rule for the corresponding change item class as follows.

The business object constant Cm0ChangeltemCreCondition attached to ProblemReport points to the condition rule named Cm0isProblemReportCreatable which calls condition rule isProblemReportCreatable.

The business object constant Cm0ChangeltemCreCondition attached to ChangeRequest points to the condition rule named Cm0isChangeRequestCreatable which calls condition rule isChangeRequestCreatable.

The business object constant Cm0ChangeltemCreCondition attached to ChangeNotice points to the condition rule named Cm0isChangeNoticeCreatable which calls condition rule isChangeNoticeCreatable.

The business object constant Cm0ChangeltemCreCondition attached to Cm0DevRqst points to the condition rule named Cm0isCm0DevRqstCreatable which calls condition rule isCm0DevRqstCreatable.

After upgrading or patching to Teamcenter 10.1.6 or Teamcenter 11.2.2, the following actions are necessary to allow existing custom condition rules to function properly for the creation of custom change subclasses.

For each existing custom condition rule of the form `{prefix}is{custom class}Creatable`, use BMIDE to:
1. Create a new condition rule which takes a Workspace Object and a User Session as parameters and set the condition expression to call the original condition rule. The new condition rule may use any name which conforms to the general BMIDE rules for condition rule names.

2. Override the value of the corresponding business object constant \texttt{Cm0ChangeItemCreCondition} by setting it to the name of the new condition rule.

For example, if a custom subclass \texttt{A5\_ChangeNotice} exists with ChangeNotice as its parent, and there is an existing custom subclass condition rule named \texttt{A5\_isA5\_ChangeNoticeCreatable}:

1. Create a new condition rule \texttt{A5\_Tc1122ChangeNoticeIsCreatable} with Workspace Object(o) and User Session(u) as parameters and set the condition expression to "Condition::A5\_isA5\_ChangeNoticeCreatable(u)."

2. Set the value of the business object constant \texttt{Cm0ChangeItemCreCondition} to \texttt{A5\_Tc1122ChangeNoticeIsCreatable}.

Users may choose to instead to exploit the new Workspace Object condition rule parameter to control the list of change types presented for a create change operation in the context of a selected object. In the above example, instead of simply calling the existing custom condition rule in step 1, the old condition rule can be discarded and the new rule written to exploit the Workspace Object parameter. The following condition rule expression is an example of how the condition can be designed to only allow changes of the associated custom subclass to be created when:

a) the selected object type starts with "Design" and the user's role starts with "Design" and

b) the selected object type starts with "Requirement" and the user's role is Simulation Administrator.

\begin{verbatim}
((o != NULL AND o.object_type = "Design*" AND u.role_name = "Design*") OR (o != NULL AND o.object_type = "Requirement*" AND u.role_name = "Simulation Administrator*")) OR o = NULL
\end{verbatim}

- **Condition overridden incorrectly on upgrade/updated dbs**

  (First published Teamcenter 12)

  The Change Manager condition \texttt{isCMHasWorkBreakdownCreatableForPrimary} was once overridden in Service Scheduling. This is no longer required due to the creation of Service Scheduling specific conditions and was changed in 11.2.1. However, environments that are upgraded or updated from before 11.2.1 can retain the incorrect overriding during the upgrade/update. If this happens, Schedules can be attached to ECNs by non-analysts.

  \textit{How to work around or avoid}

  If the issue occurs, manually change the condition using the following steps:

  1. Run Business Modeler IDE.

  2. Import ServiceScheduling.

  3. Search for \texttt{isCMHasWorkBreakdownCreatableForPrimary}. 
4. Change it to the following.

```plaintext
Condition::isAnalyst(o, u) AND ((o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating") OR (o.CMClosure = "Open" AND o.CMDisposition = "Investigate" AND o.CMMaturity = "Reviewing"))
```

5. Deploy change.

- **Unable to create change in context with custom change item objects**
  (First published Teamcenter 12)

Unable to create change in context with custom Change Item objects. The user created a custom condition, for example:

```plaintext
Signature: "CustomPrefix"_ChangeNoticeCreatable (WorkspaceObject o, UserSession u )
Expression: (o!=NULL and (o.object_type="CustomType1" OR o.object_type="CustomType2" ) )
```

The server throws error message stating the object can't be created.

**How to work around or avoid**

To fix it, add the expression "o=NULL" to the end of custom condition, for example:

```plaintext
Expression: (o!=NULL and (o.object_type="CustomType1" OR o.object_type="CustomType2" ) ) OR o=NULL
```

- **Error message is seen when a Design Element is added to a Change Notice**
  (First published Teamcenter 12)

After a Design Element is pasted to the Solution Items pseudo folder of a Change Notice Revision, an error may appear on subsequent actions. The error is:

```plaintext
ITEM ask item of rev called for <id>, of class Cpd0DesignElement, which is not an Item revision
```

The error is benign and should be ignored.

**How to work around or avoid**

Ignore the error message.

## Classification

The following notes pertain to usage of Classification.

- **System reports "server encountered error," but the error details are not displayed**
  (First published Teamcenter 12)

In Active Workspace 3.4 and Teamcenter 11.2.3, when an Item is classified, and you select its Item Revision, and try to add classification, the system reports "server encountered error," but the error details are not displayed.

The actual error is blocked in background, and an unclear message is displayed. The actual error is:

```plaintext
The revision cannot be classified as the Item of the selected Item Revision is already classified.
```
How to work around or avoid
No workaround available.

• Workaround for General Graphics Builder error on Red Hat 6, 7 and SUSE Linux 12
(First published Teamcenter 12)
When using NX10.0.3.5 for running the Graphics Builder on SUSE Linux 12 or Red Hat Linux 6.5, you may receive the following error message:

A general graphics builder error occurred:Library not found
NX error number: 3600004.
The NX Graphics Builder syslog file contains the information to an
undefined symbol: _xcb_lock_io:
... Cannot load image /usr/lugs100/ugii/jtfacet.so
/usr/lugs100/ugii/libxcb-xlib.so.0: undefined symbol: _xcb_lock_io
Unloading /usr/lugs100/ugii/jtfacet.so
...

How to work around or avoid
Backup the original NX library:
`mv /usr/lugs100/ugii/libxcb-xlib.so.0 /usr/lugs100/ugii/libxcb-xlib.so.0-old`
Add a link to the system library:
`ln -s /usr/lib64/libxcb.so.1.1.0 /usr/lugs100/ugii/libxcb-xlib.so.0`

• Set FMS_HOME environment variable in start_nx_graphicsbuilder script or system environment
(First published Teamcenter 12)
The `TC_ROOT\bin\nx_graph\start_nxgraphicsbuilder.bat/sh` script will not work if the
FMS_HOME environment variable is not set in the environment or in the script.

How to work around or avoid
1. Make sure that TCCS is installed or install it. Refer to TDOC for more information on how
to install TCCS.
2. Set FMS_HOME in the `start_nxgraphicsbuilder` start script accordingly:
   o Windows systems:
     Edit the `TC_ROOT\bin\nx_graph\start_nxgraphicsbuilder.bat` file and add SET
FMS_HOME=TC_ROOT\tccs
   o UNIX/Linux systems:
     Edit `TC_ROOT/bin/nx_graph/start_nxgraphicsbuilder.sh` and add export
FMS_HOME=TC_ROOT/tccs

In the above changes, replace TC_ROOT with the full path to the Teamcenter root directory.

• ICSXML export of a classification object with export item option is not supported
(First published Teamcenter 11.2)
In the Classification application, ICSXML export of a classification object (ICO) with the export item option is no longer supported as of Teamcenter 9.1.

**How to work around or avoid**

There is no workaround for this issue. Support for ICSXML export of an ICO with the export item option is removed from Teamcenter.

• **Dataset display of classified items with restricted item revision access**

(First published Teamcenter 9.1)

A No Read Access error is shown in the following scenario. An item with multiple item revisions is classified, and the first item revision is released and the second one is in a Working state. If a dataset is attached to both of the item revisions and the logged-on user has no read access on the Working item revision, if the user tries to access the classified object (the item) in the Classification application, a No Read Access error appears.

**How to work around or avoid**

Revision rules are used to decide which item revision to use while selecting the dataset to be displayed. Use the ICS_instance_image_revision_rule preference to specify the revision rule. The default value of this preference is set to the Latest Working state.

• **PLM XML between two sites with different site master locale set**

(First published Teamcenter 8.2)

Due to a Classification PLM XML schema limitation, the Classification PLM XML importer does not import data in the same language format as exported (like Teamcenter PLM XML export/import) if the site master language from the exporting site (which is mentioned in the XML file) is different from the site master language of the importing site.

**How to work around or avoid**

The PLM XML import is allowed despite the site master language from the exporting site. However, this may result in importing the exported master value as the importing site master language translations.

- **Export/import with no locale selection**

  When no locales are selected during export, the exporter exports the database scalar/master values for the localized properties. During import, if no localizations are present in the PLM XML file, the importer imports the values as importing site master language translations.

- **Export/import with locale selection**

  When locales are selected during export, the exporter exports the database scalar/master values and the translations for the localized properties.

  During import, if localizations are present in the PLM XML file, the importer imports the master values as importing site master language translations, and the importer verifies if the languages represented in the PLM XML file are supported by the importing site. If all of the languages represented in the PLM XML file are not supported in the importing site, the import may fail.
If some of the languages represented in the PLM XML file are supported in the importing site, the importer ignores nonsupported languages and imports the supported ones. The ignored languages are logged in the importer log.

- **Granting or revoking translation privilege for Classification users**
  
  (First published Teamcenter 8.2)

  Not all Classification business objects have the **Owning User** attribute. Due to this limitation, the translation ACL revokes the translation privilege from the Classification user.

  **How to work around or avoid**

  Classification administrator rights are required to configure translation ACL privileges using Access Manager:

  o Grant the translation privilege to a Classification administration user.

    Classification users do not have the translation privilege. Add the Classification user into the translation ACL and grant the translation privilege using Access Manager.

  o Revoke the translation privilege from a Classification user.

    Because users in the **DBA** group have the translation privilege, any Classification administration user who belongs to the **DBA** group automatically has the translation privilege granted. To revoke the translation privilege from a specific Classification administration user, the administrator must remove the **DBA** group from the translation ACL, add a specific Classification administration user, and grant the translation privilege using Access Manager.

- **Unable to remove the image of a classified instance in the Classification application**
  
  (First published Teamcenter 8.2 MP1)

  If you try to remove an image of a classified instance in the Classification application, the image is not removed. It is still displayed.

  **How to work around or avoid**

  Remove the image from the classified object in the My Teamcenter application.

**Client for Office**

The following release notes pertain to the use of Teamcenter Client for Microsoft Office.

- **Resize window for Active Workspace hosted in Client for Office**
  
  (First published Teamcenter 12)

  When Active Workspace is hosted in Teamcenter Client for Microsoft Office and displayed in narrow task panes, certain Active Workspace commands (buttons) are not available in the user interface as displayed by default in the task pane.

  **How to work around or avoid**

  Resize the task pane to be wider than the default width. This will expose additional user interface elements, including commands (buttons) that are missing in the narrow task pane view.
- **Inserting objects into table fails for Word 2016**
  
  (First published Teamcenter 12)
  
  When selecting Teamcenter objects from the Navigation task panes of the Teamcenter Client for Microsoft Office and executing the Insert context menu command, when the option is configured to insert the object properties as a table, the insertion fails in Word 2016 with the following error:

  ```
  System.Runtime.InteropServices.COMException (0x80004005):
  Reference to undeclared namespace prefix: 'i'.
  ```

  **How to work around or avoid**

  No workaround has been found yet for this problem. This issue is specific to the Microsoft Word 2016 API and appears due to a bug in the Microsoft code. Note that the Excel 2016 API and PowerPoint 2016 API do not exhibit this problem. Also, Office 2010 and Office 2013 (all APIs) also work successfully.

- **Route task does not perform properly when the Acknowledge subtask has a profile**
  
  (First published Teamcenter 11.2)
  
  When the Acknowledge subtask of a Route task has a profile defined, the Route task may not perform properly.

  **How to work around or avoid**

  Do not define sign off profiles for the Acknowledge task if it is a subtask within the Route task template. The Route task does not function properly if signoff profiles are defined for the subtasks. The Route task template is designed to be used as an electronic routing sheet, and the workflow process initiator assigns specific signoff members.

- **Unable to edit the property of a checked-out object in Microsoft Excel**
  
  (First published Teamcenter 11.2)
  
  While using the Teamcenter Client for Office properties dialog box within the Microsoft Excel application, you cannot modify or edit the text of the desired properties. The text being typed appears in a cell of the Excel spreadsheet rather than within the text field of the properties dialog box.

  **How to work around or avoid**

  From the Properties Display dialog box, click the More Properties link to display a modal dialog, and edit the desired properties from this dialog box.

- **Client for Office does not support customized Microsoft Office datasets**
  
  (First published Teamcenter 9.0)
  
  Teamcenter Client for Microsoft Office does not work with customized Microsoft Office datasets.

  **How to work around or avoid**

  Using Client for Office with customized Microsoft Office datasets requires a manual update to the schema XML file and then a redeployment. This is required to enable the OfficeOpen operation when you open the customized Microsoft Office dataset in the rich client. This cannot be done through the Business Modeler IDE because the OfficeOpen operation is a legacy operation type.
If the system has customized datasets for Microsoft Office file extensions (for example, .doc, .xls, .ppt, or .msg), you must manually add the following entry to the XML schema file, and then deploy the file:

```xml
<ADD>
  ...
  <TcExtensionAttach extensionName="OfficeOpenExt"
    operationName="OfficeOpen"
    isActive="true"
    extendableElementName="custom-dataset-name"
    extendableElementType="Type"
    extensionPointType="BaseAction"
    conditionName="isTrue"/>
  ...
</ADD>
```

For example, if the system has a customized dataset for Microsoft Word file types named **CustomMSWord**, add the following XML entry:

```xml
<ADD>
  ...
  <TcExtensionAttach extensionName="OfficeOpenExt"
    operationName="OfficeOpen"
    isActive="true"
    extendableElementName="CustomMSWord"
    extendableElementType="Type"
    extensionPointType="BaseAction"
    conditionName="isTrue"/>
  ...
</ADD>
```

- **Buttons in the Configurations – Attribute Exchange dialog box do not respond after duplicate mappings message**

  (First published Teamcenter 9.0)

  When users create or modify attribute exchange mappings, they may select the Teamcenter attributes or Microsoft Office properties that have already been mapped. Teamcenter displays a message about the duplication.

  If you attempt to create or modify another mapping from the **Configurations** dialog box, you may find that the **Create** or **Modify** buttons do not respond immediately. You must click several times before the **Create/Modify** dialog box is displayed.

  **How to work around or avoid**

  After you dismiss the duplicate mapping message, before you click any buttons, click anywhere in the **Configurations** dialog box to set focus on the dialog box for the buttons to function as expected.

- **Users are not returned to the correct Word window after create or modify attribute exchange mappings**

  (First published Teamcenter 9.0)

  After creating or modifying an attribute exchange mapping, when you close all the attribute exchange configuration dialog boxes, Teamcenter does not return to the Microsoft Word window in which you started the configuration.
How to work around or avoid

Currently, there is no workaround for this problem. Make sure the active Microsoft Word window is the one you want to work in after the attribute exchange configuration.

- **Read-only Microsoft PowerPoint file remains read-only after Open and Check-Out**
  (First published Teamcenter 9.0)

  If you open a Microsoft PowerPoint dataset in read-only mode, and then check out the dataset, the file remains read-only. Without closing the opened document, you perform an **Open and Check-Out** action, but the file is still opened in read-only mode and you are unable to save any changes to Teamcenter.

  **How to work around or avoid**

  After a PowerPoint dataset is opened in read-only mode, it cannot be made writeable until the document is closed. Close the document completely and then perform an **Open and Check-out** action.

- **Client for Office Minimize Ribbon setting triggers error**
  (First published Teamcenter 8.2)

  The **Teamcenter Search** dialog box in Client for Office may not paint properly or may trigger an error message dialog box from Office. This is only seen when the **Minimize Ribbon** option is selected. The error message text indicates an **Invalid Handle** error.

  **How to work around or avoid**

  You can temporarily toggle the **Minimize Ribbon** setting in the Office application while initially displaying the **Search** dialog box. After the window is displayed, the **Minimize Ribbon** option can be reset. When dealing with the Teamcenter ribbon, the preferred mode is to have the ribbon content displayed.

- **Some features are disabled when Word opens all documents in the same window**
  (First published Teamcenter 8.1)

  In the **Word Options** dialog box, clearing the **Show all windows in the Taskbar** check box sets Word to open all documents in the same window, with the Windows taskbar showing only the active document name. This setting disables some Client for Office features.

  **How to work around or avoid**

  1. Before opening a document, click the **Office** button and select **Word Options**.
  2. In the Word Options dialog box, select **Advanced** in the left pane, and then scroll to the **Display** section in the right pane.
  3. Under **Display**, select the **Show all windows in the Taskbar** check box.
     
     With this setting:
     
     - Each document opens in a separate Word window and the taskbar shows the individual document names.
     - All Client for Office features for Word are enabled.
Content Management

The following release notes pertain to usage of Content Management.

- **Editing a DITA 1.3 composite document in XMetaL 10 displays an error**
  
  (First published Teamcenter 12)

  Editing a DITA 1.3 Composite topic from Content Management to XMetaL 10 causes XMetaL to display this error:

  Document does not conform to DTD or XML Schema. The document contains an attribute \'domains\' for element <dita> that is not permitted. Do you want to edit document in plain text ...

  *How to work around or avoid*

  XMetaL 10 does not have the latest DITA 1.3 schemas in the XMetaL install. Workaround is to update database.dtd in the Author\DITA\DITA_1.3_DTD\technicalContent.dtd folder area of the XMetaL 10 installation. The latest database.dtd can be found on the Oasis website:

  http://docs.oasis-open.org/dita/dita/v1.3/csprd01/part2-tech-content/tech-content-grammars/dtd/technicalContent.dtd\dtd/database.dtd

  This is expected to be resolved in XMetaL 11.

- **Publish dialog disappears when selecting dropdown, reappears after selection is made**
  
  (First published Teamcenter 12)

  The publish dialog disappears when selecting the drop down menu for Tool or Style Type and only shows the drop down menu. After selecting an option it will return.

  *How to work around or avoid*

  This problem does not affect Content Management functionality, as the dialog reappears after the user makes a selection. The Content Management user interface will be updated in a future release to correct this behavior.

- **New publish stylesheets are not related to topic types after upgrading from 8.3**
  
  (First published Teamcenter 12)

  After upgrading from 8.3 and importing DITA admin data, the new stylesheets for DITA OT publish tools are not related to the topic types.

  *How to work around or avoid*

  The workaround is to rename the old stylesheets, then reimport the OOTB DITA admin data.

- **DITA OT 2.0 Upgrade**
  
  (First published Teamcenter 12)

  DITA OT 2.0 has a different directory structure than previous versions which may impact any customizations made to the older versions.

  *How to work around or avoid*

  Any customizations made to DITA OT 1.5.4 may need to be updated to work with DITA OT 2.0. Evaluate your customizations and update where necessary.
• **Errors during Content Management PLM XML administration data import**

(First published Teamcenter 11.2)

If administration data already exists in your database and you import updated administration data into the database, you may receive the following errors:

<table>
<thead>
<tr>
<th>Severity</th>
<th>Code</th>
<th>Detailed message</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERROR</td>
<td>89009</td>
<td>No additional objects of type &quot;Full Text&quot; can be attached with a relation &quot;IMAN_Specifications&quot; under the object &quot;019679/A;1--//OASIS//ELEMENTS DITA User Interface Domain//EN&quot; of type &quot;External Entity Revision&quot;, because this would exceed the set limit for the secondary objects. Please refer to the rule for &quot;External Entity Revision, Full Text, IMAN Specifications&quot;.</td>
</tr>
<tr>
<td>ERROR</td>
<td>239105</td>
<td>The name &quot;DitaOT_RTF&quot; already exists. It must be unique.</td>
</tr>
</tbody>
</table>

*How to work around or avoid*

Errors like **89009** can be ignored. The full text data set is updated in an earlier step.

To workaround error **239105**, delete the current object in the database and re-import the administration data to re-create the object. (For the example shown in the error message, delete the **DitaOT_RTF** style sheet object.)

• **Cancel checkout command fails in Content Management**

(First published Teamcenter 11.2)

In Teamcenter 8.3, the **TcCheckoutReserverOnly** preference was recommended for Content Management classes due to performance reasons during the checkout of topics. Beginning in Teamcenter 9.1, if this preference is set, users cannot call the **Cancel Checkout** command on Content Management objects that are checked out. This does not affect checking in or checking out of these objects.

*How to work around or avoid*

Remove all Content Management classes from the **TcCheckoutReserverOnly** preference. Removing this preference may still have a performance impact on checking out large publication structures, although much smaller compared to its impact in Teamcenter 8.3.

**Data Exchange**

The following release notes pertain to Data Exchange.

• **Mapping Designer is not compatible with Java 8.**

(First published Teamcenter 12)

Mapping Designer is not compatible with Java 8.

*How to work around or avoid*
Use Transformer. Documentation for Transformer can be found on Siemens PLM Software Doc Center:

https://www.plm.automation.siemens.com/locale/docs/

Open Teamcenter help for your version of Teamcenter, then browse to Sharing Data→PLM XML/TcXML Export Import Administration→Customizing PLM XML import/export extensions→Creating custom transformation rules.

• Cannot transfer a dataset shared by multiple item revisions
  (First published Teamcenter 2007 MP4)
  If you revise an item revision without revising its dataset, both the new and old item revisions share the same dataset. You cannot transfer that dataset using Data Exchange.

  How to work around or avoid
  Currently, there is no workaround for this problem. This problem will be resolved in a future maintenance release. Contact GTAC for further information about availability.

• Customization may alter behavior of monitoring interface
  (First published Teamcenter 2007 MP2)
  If the behavior of the monitoring interface changes, it may be because of your customizations. If it does fail, compare your mapping to the Teamcenter out-of-the-box (OOTB) mapping.

  How to work around or avoid
  Currently, there is no workaround for this problem. This problem will be resolved in a future patch. Contact GTAC for further information about availability.

• Remote import that transfers ownership in Global Services fails to update ownership in ODS
  (First published Teamcenter 2007 MP2)
  If you perform a remote import that transfers ownership using Global Services, it fails to update the ownership in ODS.

  How to work around or avoid
  Currently, there is no workaround for this problem. This problem will be resolved in a future patch. Contact GTAC for further information about availability.

Document Management

The following release notes pertain to Document Management.

• Checkout On Create of document under IRDC control may create an unexpected dataset
  (First published Teamcenter 12)
  After upgrade to Teamcenter 11.2.2, the Checkout On Create of documents under IRDC control may create unexpected datasets.

  How to work around or avoid
Delete the extra dataset that is not needed.

- **Signing a PDF file in Client for Office is not supported in Windows 8.1**
  (First published Teamcenter 11.2)

  Adobe Reader 11.0.10 may appear to hang when you attempt to sign a PDF from Microsoft Outlook. This can happen when a user is using Teamcenter Client for Microsoft Office Outlook application on a Windows 8.1 host.

  *How to work around or avoid*

  Signing a PDF file from the Teamcenter Client for Microsoft Office Outlook application is currently not supported for Windows 8.1.

- **The delete key on the keyboard fails to delete e-mail in Outlook**
  (First published Teamcenter 9.1)

  After a user clicks any object in Teamcenter task pane in Microsoft Outlook, the delete key on the keyboard does not delete the selected e-mail.

  *How to work around or avoid*

  The delete option on the context menu still works. Also, Microsoft technical support provides the following work-around: Right-click any e-mail to display the context menu, or switch tabs on the ribbon (in Outlook 2010). After this, the delete key works.

- **No feedback given when no tool exists for viewing and markup of PDFs on a Macintosh system**
  (First published Teamcenter 9.1)

  No feedback is given when no tool exists for viewing and markup of PDF documents on a Macintosh thin client system.

  *How to work around or avoid*

  Because the tool has not been set up, look in the Java console to see the error that occurs.

**Extensions for Office**

The following release notes pertain to the use of Extensions for Office.

- **Requirements task pane fails to display (Microsoft Word 2010)**
  (First published Teamcenter 9.0)

  When attempting to open a requirements specification document when no other Microsoft Word document has previously been opened, the Requirements Management task pane is not shown. This happens only with Microsoft Word 2010. Microsoft Word 2007 does not display this behavior.

  *How to work around or avoid*

  Open a different Microsoft Word document *before* you open the requirements specification document.

  It is not necessary to leave the other document open after you successfully open the requirements specification document.
- **Patch upgrade for Extensions for Office add-in files**

  (First published Teamcenter 8.3)

  There are no specific instructions when the add-in is updated in patch for Extensions for Office add-in files.

  **How to work around or avoid**

  Perform the following steps whenever the patch contains changes to the Extensions for Office (live Excel) add-in:

  1. Verify that the patch contains the `\wnt\itc\officeliveaddins` folder. If it does not, the patch does not contain any changes to the add-in.

  2. Depending on which Office version is installed, copy files from either the `\office2007` or `\office2003` folder to the folder where add-ins are installed (most likely the `\C:\Program Files\Siemens\Teamcenter\8\tc_ext4mso\office200X\` folder).

  3. Register the DLLs using the `regasm.bat` file in the installation folder. If this file is not present or is deleted, re-install the add-ins using the standard installer using the released kit in Teamcenter.


  5. Locate the `TcO2K7Preprocessor.dotm` file in the `\wnt\itc\officeliveaddins\office200X` folder.

     Copy the file to the `%APPDATA%\Microsoft\Word\STARTUP` folder. (Type the path in the **Start**→**Run** dialog box to navigate to the folder.) Overwrite the file if it is already present.

  6. Make sure the file is read-only by inspecting the properties of the file. Following these steps ensures that the add-in was updated successfully in the patch.

**Global Services**

The following release notes pertain to Global Services software.

- **Library updates in Global Services EAR files may result in deployment and or run-time problems**

  (First published Teamcenter 9.1)

  The Xalan library has been updated to the `\xalan-2.7.1.jar` file from the original Teamcenter 8.3 version of the `\xalan-2.7.0-2.jar` file. If you use the Web Application Manager (`\insweb`) to install over a later version, both versions of the Xalan JAR file may end up in the `\tcgs.ear` file. Instances have been observed where serialization issues occur after updating to a current patch level.

  Additionally, the `\gs-ode.ear` manifest makes reference to the old Xalan JAR file.

  Depending on the install method, application server, and application server configurations, the installer may or may not see this issue.

  **How to work around or avoid**
To avoid multiple JAR file versions, install with a fresh Web Application Manager solution, or remove the old staging directories before creating the EAR file.

Alternatively, the installation may also remove the older JAR file from the EAR file from the tcgs.ear/lib/xalan-2.7.0-2.jar location.

If issues are observed with the tcgs-ode.ear file, update the manifest file located at tcgs-ode.ear/tcgs-ode.war/META-INF/MANIFEST.MF to reference the new xalan-2.7.1.jar file.

- **Asynchronous problem in WebSphere 8**
  (First published Teamcenter 9.1)
  Some GMS use case actions may not run asynchronously. As a result, some process executions may be blocked, thus causing degraded performance or producing errors and execution failures.

  **How to work around or avoid**
  Use another supported application server.

- **ODS service does not start automatically on reboot on Linux**
  (First published Teamcenter 9.0)
  This issue affects SUSE Linux 11 and Red Hat Enterprise Linux 6.
  After you run the Teamcenter Environment Manager (TEM) root script, the rc.ugs.ods script does not start the ODS service automatically during a system reboot.
  You must add commands to terminate and restart the rpcbind service to the TEM root script to enable these commands to run during a reboot.
  The rpcbind process must be started once per boot session on SUSE Linux 11. This should be handled similar to the kill -1 command on the inetd process ID.

  **How to work around or avoid**
  Perform the following steps:

  1. Modify the /etc/init.d/rpcbind startup script by adding the following line immediately after the RPCBIND_BIN=/sbin/rpcbind line:
     
     OPTIONS="-i -w"

  2. Restart the rpcbind process by issuing the following command as root:

     `/etc/init.d/rpcbind restart`

     **Note**
     
     This is required only once after the rpcbind startup script is modified.

After you apply this workaround to the rpcbind script, on a subsequent system boot, the rpcbind process launches in insecure mode. This allows the ODS service to start and function normally.

Be aware that by making this change, the rpcbind service thereafter always runs in insecure mode.

- **CATIA site checkout support**
Site checkout of CATIA table cell data does not work with Briefcase. In addition, site checkout of CATIA data through a tier of suppliers does not work with Briefcase.

**How to work around or avoid**
Currently, there is no workaround for this problem.

- **CATDrawing name should be changed manually on new revisions**
  (First published Teamcenter 8.1)
  Drawing data set is missing after re-exporting the component.

  **How to work around or avoid**
  If the CATDrawing name is different from that of associated assembly or component part number, its name should be manually changed to be different on all future revisions so that it will be associated with correct item on Teamcenter.

- **Autopopulated nonmandatory fields should not be populated by user in the Insert form**
  (First published Teamcenter 2007)
  Several of the nonmandatory boxes (for example, Part Name) of the Teamcenter assembly BOD are autopopulated by Teamcenter.

  **How to work around or avoid**
  Currently, Global Services does not have a capability to suppress such autopopulated fields from the Insert form. Therefore, do not enter information in these boxes when using the Insert form.

## GM Overlay
The following release notes pertain to Teamcenter Automotive Edition–GM Overlay.

## Lifecycle Interoperability Services
The following release notes pertain to usage of Lifecycle Interoperability Services.

- **Nonsecure content not displayed in web browser**
  (First published Teamcenter 11.2)
  If you have nonsecure content in the lifecycle tool that uses Lifecycle Interoperability Services, some web browsers such as Mozilla Firefox, Google Chrome, and Apple Safari browser do not display the content.

  **How to work around or avoid**
  Disable security for the site or page. For more information on how to disable security, see your web browser’s documentation.
Lifecycle Visualization

The following release notes pertain to usage of Lifecycle Visualization.

- **Toolbar buttons become unresponsive or erratic when switching perspectives**
  (First published Teamcenter 11.2)

  When you open a viewer in the Lifecycle Viewer and another perspective, switching from the Lifecycle Viewer to the other perspective does not give focus to the new viewer. The toolbar buttons may become unresponsive or display incorrect behavior.

  **How to work around or avoid**

  Click inside the viewer to set focus on the viewer before you use the toolbar buttons in the viewer.

- **Teamcenter rich client Group/Role switch and stand-alone Lifecycle Visualization**
  (First published Teamcenter 9.1)

  Stand-alone Teamcenter Lifecycle Visualization does not support group and role change.

  When launching data from the rich client to stand-alone Lifecycle Visualization, the new Teamcenter session (separate Teamcenter server) is created by Lifecycle Visualization. If the group/role changed during the rich client session, Lifecycle Visualization is still working with the old Teamcenter server that is separate from the rich client and is not aware about group/role switch.

  There are two implications:

  1. You may see the additional authentication prompt because of the changed group/role portion of the credentials. After authentication, the viewer joins the previously established Teamcenter server and the server side session that is not aware of group/role switch.

  2. The data access permission is the same as for first logon. You may not see data as expected for new group/role because the group and role on the Teamcenter server did not change.

  **How to work around or avoid**

  For stand-alone Lifecycle Visualization, the stand-alone viewer must be closed when group and role are switched by launching the application (rich client).

  You must save the unsaved data and close the viewer.

  The data may then be launched into a new Lifecycle Visualization viewer and be processed and displayed correctly according to the new group/role permissions.

- **Session files created by two-tier Lifecycle Visualization 8.1 have bad IOR references**
  (First published Teamcenter 9.0)

  Teamcenter lifecycle visualization 8.1 in two-tier mode created sessions with interoperable object references (IORs) that are temporary random numbers that identify current sessions. These session files could only be reopened in the viewer if current two-tier session was still valid. Once the Teamcenter server process was closed, these sessions could not be reopened.

  In Lifecycle Visualization 8.3 and Teamcenter 8.3, there were modifications to prevent incorrect creation of sessions in two-tier mode, so this problem does not exist for sessions created in versions 8.3 or later.
How to work around or avoid

You can open Teamcenter 8.1 two-tier sessions that contain IORs in Lifecycle Visualization 9.0 using File Locator. Note that modifications were made in Teamcenter clients to support File Locator search, so setting File Locator in Lifecycle Visualization 8.3.2 does not result in sessions loading correctly.

To configure the Lifecycle Visualization 9.0 viewer to use File Locator, perform the following steps:

1. Select File→Preferences→File Locate, and then click the Document Search Order tab.
2. Move the User-Defined Directory Set directory set to the top of the list.
3. Make sure the User-Defined Directory Set directory set is set to Enabled and the Auto Confirm setting is set to Yes.
4. Click Edit. In the lower pane, click Add for the unatt extension.
5. In the Browse dialog box, click the Servers tab in lower left corner.
6. In the list of servers, select the two-tier server entry, and then click OK.
7. Authenticate if necessary, and then close the open dialog boxes.

Note

You may need to load an item from the server first to seed the Browse dialog box with the two-tier server location or you may need to add that entry manually.

- Using motion in a managed environment

(First published Teamcenter 8.3i)

DirectModelMotion datasets without a JPART reference, such as those created through Lifecycle Visualization, need a JPART reference added to them.

How to work around or avoid

Locate the dataset in My Teamcenter, bring up the named references, and upload the JPART reference.

The preferred method of persisting motion in Teamcenter lifecycle visualization 8.3 with a Teamcenter 8 or later server is through the use of sessions. After creating a new motion using the Teamcenter Visualization Actions→Motion→New Motion menu command, allow the session save process to guide you through persisting the motion document. The motion file is saved into the session dataset as a session dependant document. The motion file is not visible in the My Teamcenter navigation but can be retrieved by getting the named references of the session file.

Following is an example of creating a DirectModelMotion dataset using My Teamcenter:

1. Navigate to the location where you want to create the motion dataset.
2. Choose File→New→Dataset to display the New Dataset dialog box.
3. Select the **DirectModelMotion** dataset on the left side of the dialog box.

4. Provide a name and use the ... button to import the *.vfm* motion file.

5. Click **OK**.

6. Right-click the new dataset and choose **Named References**.

7. The *.vfm* file is listed, but it requires a base document.

8. Click **Upload** to display the upload file dialog box.

9. Ensure the reference is set to **JTPART** and navigate to the JT file that the motion was created against.

- **FCC size for rich client embedded viewer**
  
  (First published Teamcenter 8.3)
  
  The FCC must be configured to be large enough to load all the JT files required for visualization during a rich client session. If the FCC cache is too small, not all the JT files are available during a viewing session, yielding unpredictable results. For example, the geometry for a part may not be visible, or a **LoadPartException** error may be thrown.

  **How to work around or avoid**

  Make sure the size of the FCC is large enough to hold the entire set of JT files to be viewed during a rich client session.

- **Lifecycle Viewer status bar does not show loading status**
  
  (First published Teamcenter 8.1)
  
  After sending an assembly to the Lifecycle Viewer, loading the data shows no status in the Teamcenter status bar. For a large assembly that takes 5 minutes or more to load, you receive no feedback where in the loading process Teamcenter is and when it is going to finish. In stand-alone Lifecycle Visualization, the status bar shows the progress of the loading and provides good feedback.

  **How to work around or avoid**

  Log onto Teamcenter, choose **Windows→Show View→Other...**, expand the **General** folder, and select **Progress**. The **Progress** view is displayed. The status bar has limited space when too many items are displayed on it, but you can see the progress in the **Progress** view.

- **Cannot launch Lifecycle Visualization with autologin enabled**
  
  (First published Teamcenter 2007)
  
  If **enableAutologin=true** and you attempt to launch JT data to Lifecycle Visualization, the launch fails with the following error message:

  > The current user credentials are not valid.

  **How to work around or avoid**

  You cannot launch Lifecycle Visualization when **enableAutologin=true**.
• **Rich client hangs on UNIX systems**  
  (First published Teamcenter 8 MP1)  
  On UNIX systems, the Lifecycle Viewer modal dialog boxes can hide behind the Teamcenter rich client application, causing the application to appear that it has hung. If you are working with the Lifecycle Viewer and an action has caused the rich client to no longer draw correctly (refresh), or you can no longer interact with it, it may be due to a modal viewer dialog box that needs to be dismissed.

  **How to work around or avoid**  
  Move the Teamcenter rich client application to see if a viewer dialog box can be found behind it. Once the dialog box is dismissed, the Teamcenter client should resume normal operations.

• **Navigator window appears blank on UNIX**  
  (First published Teamcenter 8.1)  
  On UNIX systems, the Navigator window in the Lifecycle Viewer appears blank or gray.

  **How to work around or avoid**  
  If you are working in the Lifecycle Viewer and see a blank or grey Navigator window, close the Navigator window. To re-open the window, open the Window menu. Choose **Show View→Other**, and under the **Visualization** folder, select **Navigator** and click **OK**.

• **Refresh issue when switching from the Lifecycle Viewer to the My Teamcenter Viewer tab**  
  (First published Teamcenter 8.2)  
  On Solaris systems only, 2D images do not display when switching from the Lifecycle Viewer to the My Teamcenter **Viewer** tab. To duplicate the problem:

  1. View 2D data in the **Viewer** tab of My Teamcenter.
  2. Send the 2D data to the Lifecycle Viewer.
  3. Switch back to the My Teamcenter Viewer tab.

    Sometimes this results in a gray Viewer tab although the 2D image is selected in tree.

  **How to work around or avoid**  
  If you see a **Viewer** tab that is gray, use one of the window grips surrounding the viewer area and resize the viewer. Upon resizing, you should see the viewer area being drawn correctly.

## Service Lifecycle Management

The following notes pertain to usage of Service Lifecycle Management.

• **The isCMHasWorkBreakdownCreatableForPrimary condition is changed**  
  (First published Teamcenter 11.2)  
  The installation of SLM Service Scheduler changes the **isCMHasWorkBreakdownCreatableForPrimary** condition provided by the Change Manager application. This replacement condition rule does not include the check to see if the user who
is creating the relation between the change and the plan is the assigned analyst for the change. The result is that it is not required to be the assigned analyst on a change to relate a plan to the change.

**How to work around or avoid**

Perform the following steps in the Business Modeler IDE:

1. Create a new condition similar to the `isCMHasWorkBreakdownCreateableForPrimary` condition but for the `SSS0SvcWorkOrderRevision` business object. Enter the following in the **New Condition** dialog box:
   a. In the **Name** box, type a unique name for the new condition.
   b. In the **Description** box, type something like the following:
   
   ```
   This condition determines if CMHasWorkBreakdown relation is creatable for the SSS0SvcWorkOrderRevision primary object
   ```
   c. For the **Input parameters**, select **Business Object and User Session**.
   d. In the **Signature** box, type the following:
   
   ```
   condition-name1 ( SSS0SvcWorkOrderRevision o , UserSession u)
   ```
   e. In the **Expression** box, type the following:
   
   ```
   o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating"
   ```

2. Create a new condition similar to the `Cm0isCMHasWorkBreakdownCreateable` for the `SSS0SvcWorkOrder Revision` business object except replace the reference to the `isCMHasWorkBreakdownCreateableForPrimary` condition in the clause `Condition::isCMHasWorkBreakdownCreateableForPrimary(p, u)` with the new condition name created in the previous step. Enter the following in the **New Condition** dialog box:
   a. In the **Name** box, type a unique name for the new condition.
   b. In the **Description** box, type something like the following:
   
   ```
   This condition determines if relations of type CMHasWorkBreakdown are creatable for SSS0SvcWorkOrderRevision.
   ```
   c. For the **Input parameters** select **Custom**.
   d. In the **Signature** box, type the following:
   
   ```
   condition-name2 ( SSS0SvcWorkOrderRevision p , Schedule s , UserSession u)
   ```
   e. In the **Expression** box, type the following:
   
   ```
   Condition::isActiveSequence(p) AND Condition::condition-name1
   (p, u) AND Condition::Cm0isCMHasWorkBreakdownCreateableForSecondary(s, u) AND Condition::isAuthor(u)
   ```

3. Override the `CMHasWorkBreakdownCreCondition` business object constant on the `SSS0SvcWorkOrderRevision` business object in the Service Scheduler schema to the name of the new condition created in the second step.

4. Change back the `isCMHasWorkBreakdownCreateableForPrimary` condition expression by returning it to the original state. This can be done by manually adding back the check for analyst. Here is the original expression:
All options are not stored in the stored option set

(First published Teamcenter 8.1)

When a physical structure is generated from a neutral structure that was configured with Classic Variants, any options that were identified as Derived when the structure was configured are not captured in the stored option set. When physical parts are later installed into the physical structure, the correct configuration cannot always be properly determined at every level of the structure, so the correct open usages are not always correct.

How to work around or avoid

When configuring the options, validate that all options are identified as Set by user and not Derived prior to generating the physical structure. If the options does specify Derived, manually set that option to another value, then change it back to the correct value. This changes it to Set by user, and the value is properly stored in the stored option set.

Physical part generated prior to Teamcenter 8.1 is missing configuration information

(First published Teamcenter 8.1)

Physical parts generated prior to Teamcenter 8.1 do not contain a reference to the configuration context and BOMView type. This information is used to correctly determine the open usages during part installs when occurrence effectivity, incremental change, or options and variants were used to configure the structure. When a part is being installed, the incorrect open usages are displayed, and parts may not be able to be installed.

How to work around or avoid

The parent physical part must be rebased to establish the configuration information so that the correct open usages can be determined during installation.

Manufacturing Process Planner

The following release notes pertain to usage of Manufacturing Process Planner.

Tool tip for Configuration Information displays incorrectly in Manufacturing Process Planner

(First published Teamcenter 12)

Incorrect tool tip text is displayed in Manufacturing Process Planner. To reproduce the problem:

1. Create two structures, Generic BOP and Product BOP, in Manufacturing Process Planner.

2. Go to Show information (Configuration information).
The expected result is the tool tip should display **Configuration information**. Instead, it displays **Show information**.

**How to work around or avoid**
The tool tip should read as **Configuration information**. This will be fixed in a future release of Teamcenter.

- **Manufacturing Product Characteristics template must be manually selected during patch**
  (First published Teamcenter 12)
  When you select the patch for main template, **Manufacturing Product Characteristics**, the main solution should be selected automatically.

  **How to work around or avoid**
  After you select the client patch in the installer, manually select the main template.

- **BCT Inspector Support for Teamcenter 11.2**
  (First published Teamcenter 12)
  BCT Inspector is not supported with Teamcenter 11.2 when using Manufacturing Characteristics Information (MCI) functionality in Teamcenter.

  **How to work around or avoid**
  BCT Inspector Version 16.1.3, which will support Teamcenter 11.2, will be asynchronously released at a later point in time.

- **Not showing Resources in Gantt View**
  (First published Teamcenter 12)
  Resources are not shown in Activity Gantt View.

  **How to work around or avoid**
  The use case mentioned in Teamcenter documentation is incorrect. The resources are not to be shown in Activity Gantt view.

- **Replace Assembly in Context shows ready when still running**
  (First published Teamcenter 12)
  When the **Replace Assembly in Context** command is used, the status message may say **Ready** instead of **Working** before the command is complete. For large assemblies, this can give the impression that rich client is hung.

  **How to work around or avoid**
  Wait for the command to complete. Prior to completion, the status message changes to **Working** for a short time. The command is done when it changes back to **Ready**.

- **Welds lose connected properties**
  (First published Teamcenter 12)
  After recursive recipe resolution, welds lose their connected properties.
How to work around or avoid

Set an environment variable or a preference called `ME_update_welds_on_assign`, with a value of 1.

- **Accountability check with Primary revision configured partial match hangs rich client**
  (First published Teamcenter 12)

  In Manufacturing Process Planner, when an accountability check is performed with a partial match specified for the Primary Revision Configured property while the property is displayed in the BOM tree table, the rich client can hang.

  How to work around or avoid

  Open the accountability settings user interface and remove the Primary revision configured property and run the Accountability check again. Close the Accountability check user interface. Remove the Primary revision configured property from the Primary view.

- **MATLAB_ROOT environment variable not updated when TcME2.0 patched on top of Teamcenter 10.1.5 or later**
  (First published Teamcenter 12)

  Affected TcME 2.0 when patched on an existing environment of Teamcenter 10.1.5 or later with an older version of TcME.

  The `MATLAB_ROOT` and other environment variables are not updated to correct values when TcME2.0 is patched on top of an existing Teamcenter 10.1.5 (or later) version of Teamcenter Foundation.

  How to work around or avoid

  Update all these values manually.

- **Command Suppression ESM preference not working for upgraded database**
  (First published Teamcenter 12)

  Upgrading any Teamcenter 11.2 database, with ESM installed, to Teamcenter 11.2.2 will result in an invalid preference location. This causes command suppression to not work in some cases.

  How to work around or avoid

  Running the ESM installation utility with a fix location flag will fix the problem:

  `install_esm_preferences -u=infodba -p=infodba -g=dba -fixlocation`

- **Update of the Teamcenter Mechatronics Engineering 32-bit client from version 2.3 to 2.3.1 fails**
  (First published Teamcenter 12)

  Update of the Teamcenter Mechatronics Engineering 32-bit client from version 2.3 to 2.3.1 fails on the Teamcenter 11.3 platform.

  How to work around or avoid

  Before updating using Teamcenter Environment Manager (TEM)

  1. Browse to Teamcenter Mechatronics Engineering 32-bit client installation folder.
2. Open the `media_teamcenter_foundation.xml` file and search for the following element:
   ```xml
   <platform>wntx64</platform>
   ```
3. Replace this element with the following:
   ```xml
   <platform>wntx32</platform>
   ```

   After this, you can update Teamcenter Mechatronics Engineering. After you finish the update, go back to the Teamcenter Mechatronics Engineering 32-bit client installation folder, open the `media_teamcenter_foundation.xml` file and change the value from
   ```xml
   <platform>wnti32</platform>
   ```
   to
   ```xml
   <platform>wntx64</platform>
   ```

   • **Set the TCVIS_Unpack_All.From Viewer preference**
     (First published Teamcenter 11.2)
     The **Confirm unpack operation** dialog box is confusing to end users.
     **How to work around or avoid**
     Set the **TCVIS_Unpack_All.From Viewer** preference to `true`. If you select an item from the viewer, all selected packed lines are unpacked without prompting users to confirm whether they would like to unpack or not.

   • **Change display name when creating multiple manufacturing features**
     (First published Teamcenter 11.2)
     When you create multiple manufacturing features by assigning a number greater than 1 in the create manufacturing dialog wizard, it provides an assigned name to a single weld point and the rest have a default name as **WeldPoint**.
     **How to work around or avoid**
     To have the same name for all weld points, change the value of the **MEMFGDisplayName** preference to:
     ```
     bl_item_item_id
     bl_item_object_name
     ```
     If the preference value is set as shown, the name displays as `id;04222;wp1`

   • **Configure a variant rule for a service plan**
     (First published Teamcenter 11.2)
     When using variants and options with service plans, only classic options work with the **Generate Maintenance Schedule** dialog box.
     **How to work around or avoid**
     The modular options at lower levels are supported only if they are presented at the top line. Select the top line in the **Configure Service Plan** dialog box to configure the service plan.

   • **Set Change Notice command is supported on plant BOP and standard BOP only**
     (First published Teamcenter 11.2)
Manufacturing Process Planner has the ability to capture revisions automatically in a change notice using the **Set Change Notice** command. This command is supported on regular BOP structures and on plant BOPs. It should not be used on generic BOP, product BOP, or BOM structures.

*How to work around or avoid*

Use the **Set Change Notice** command on standard BOPs and plant BOPs only.

- **Changing the use of the typeAndRuleForProcessConfiguration preference**

  (First published Teamcenter 9.1)

  The process tree is not filtered correctly according to children.

*How to work around or avoid*

Use the **controllingOccsForProcessConfiguration** preference to filter the process tree according to consumed status as well as child relations. The preference should contain definitions for both child and occurrence type relations.

Examples for values for the preference:

- MEOP : One: OCCType : MEConsumed
- MEOP : All: OCCType : MEConsumed
- MEOP : OneLoaded: OCCType : MEConsumed
- MEOP : AllLoaded: OCCType : MEConsumed
- MEOP : One: OCCType : MEConsumed
- MEOP : All: OCCType : MEAssign
- MEOP : One: OCCType : MEConsumed, MEAssign
- MEPProcess : All : CHILD : MEOP
- MEOP : One: OCCType: MEConsumed
- MEPProcess: One: CHILD : MEOP
- MEPRESSS : ALL : TYPE: MEConsumed
- MEOP : ONE: TYPE : MEConsumed

---

**Mechatronics Process Management**

The following release notes pertain to Mechatronics Process Management implementation.

- **The Embeds column does not show any content when expanding a parent BOM line**

  (First published Teamcenter 8.2)
In the Structure Manager thin client, when expanding a BOM line whose children should have content in the **Embeds** column, the column content is not displayed.

**How to work around or avoid**

The **Embeds** column content can be displayed by opening any BOM line higher in the structure and choosing **View→Expand Below**. When the structure is expanded in this way the **Embeds** column displays the correct content.

- **Invalid relations**
  
  (First published Teamcenter 8.2)

  Invalid relations resulting as part of Mechatronics Process Management BOM restructuring are not consistent in PLM XML export/import.

  In Structure Manager, BOM restructuring operations can be performed on structure. Existing relations in the structure can become invalid after these operations. If a user performs PLM XML export with these invalid associations, all relations, including the invalid association, are exported. But during import with this XML, all invalid associations may not get imported as it is.

  **How to work around or avoid**

  After a structure is finalized, perform the **Fix In-Structure Associations** operation to fix any invalid association existing in the structure after restructure operations, and then perform the PLM XML export operation. During import with the same XML, all associations can be imported and both the sites are in sync. Choose **Tools→Fix In-Structure Associations** and select the **Current Level** option or the **All Levels** option. The **Current Level** option validates the selected BOM line and its immediate children for all Mechatronics Process Management relations. The **All Levels** option validates selected BOM lines and its entire subtree for all Mechatronics Process Management relations. Therefore, it may take a long time to perform this operation.

- **Implemented By and Realized By relationships are not displayed when copied in another structure**
  
  (First published Teamcenter 2007 MP4)

  If you copy a product structure containing **Implemented By** or **Realized By** relationships and paste it in another product structure, the relationships are not displayed in the new structure.

  **How to work around or avoid**

  Re-create the **Implemented By** and **Realized By** relationships in the new structure.

- **Editing a GDE element fails at a replica site**
  
  (First published Teamcenter 2007 MP2)

  If you have a Multi-Site environment and you perform any editing operation on a GDE element under a checked out structure at a replica site, it fails.

  **How to work around or avoid**

  Currently, there is no workaround for this problem.

- **Hierarchical GDE structure at remote site cannot be remotely checked out**
  
  (First published Teamcenter 2007)
When a hierarchical GDE structure is replicated at a remote site using multisite functionality, it cannot be remotely checked out and modified at the replica site.

*How to work around or avoid*

Transfer the ownership of the structure to the remote site before modifying it.

**Multi-Site**

The following release notes pertain to Multi-Site implementation.

- **Unable to delete Items associated with alternate IDs after upgrade**
  
  (First published Teamcenter 11.2)

  This issue applies only if you use the Multi-Site Item ID Registry feature with alternate ID values. The schema for Item ID registry was modified in Teamcenter 9.1 to accommodate the MFK (multi field key) feature in Multi-Site. However, during upgrade from Teamcenter 8.x to Teamcenter 9.x or later, the `key` and `domain` values were incorrectly set for items that use alternate IDs. This caused an error when deleting Items created prior to Teamcenter 9.0 that were associated with alternate IDs.

  *How to work around or avoid*

  Perform a standard Teamcenter upgrade according to the Teamcenter Upgrade Guide. After you complete upgrade and configure Teamcenter on all sites, configure Multi-Site Collaboration and ensure data can be exchanged within the federation.

  After you complete all post-configuration steps for Multi-Site, open a Teamcenter command prompt and type the following command:

  ```
  migrate_altid_registry
  ```

  This utility searches the Item ID registry for incorrect alternate ID `key` and `domain` values, and updates them with correct values. This allows you to delete Items associated with the incorrect alternate IDs afterward.

**My Teamcenter**

The following release notes pertain to My Teamcenter.

- **Copying and pasting multiple objects does not work with pseudo folders**
  
  (First published Teamcenter 11.2)

  Copying and pasting multiple objects does not work with pseudo folders when pasting multiple objects with multiple relations to a pseudo folder where one or more relations have mandatory properties to be filled in at the time of relation creation.

  *How to work around or avoid*

  Perform one of the following:

  o Paste groups of objects that share the same relation. To group them, you must know the paste relation for each object to be pasted.
Paste each object separately.

- **Cannot select multiple value mode using the keyboard**
  (First published Teamcenter 10)
  When defining a preference, if you want to enter multiple values, you cannot switch to multiple mode using the keyboard.
  For example, when you create a preference (Edit→Options→Filters→Definition→Create a new preference definition), select Category, and then use the tab key or press M to select Multiple mode. The interface remains in Single mode.

  *How to work around or avoid*
  Select Multiple mode using the mouse or the arrow keys on the keyboard.

- **Set preference to set default Autonomy keyword search logic**
  (First published Teamcenter 9.1)
  When using keyword search, the default logic operator is OR. For example, searching for cat dog returns search results that contain cat or dog.
  If you want to change the default operator to be AND so the search string cat dog returns search results that contain both cat and dog, you must set a preference.

  *How to work around or avoid*
  Set the TC_fts_default_AND_operator preference to true. This sets the default logic operator to AND. The default value of this preference is false.

- **Calendar dialog box remains open**
  (First published Teamcenter 9.1)
  In the Properties dialog box, click the date button to display the calendar dialog box. When you click on any other box, such as the Description box, the calendar dialog box does not close.

  *How to work around or avoid*
  Close the Properties dialog box. The calendar dialog box is closed.

- **Checkout fails for business objects with unique attributes**
  (First published Teamcenter 8.3)
  When an object is checked out, a copy is made so it can be restored to its original values if you cancel checkout. The addition of unique attributes to the business object prevents the copy from being saved to the database and checkout fails.

  *How to work around or avoid*
  Prevent the copy action during checkout by adding the business object to the TcCheckoutReserveOnly preference. This also disables the cancel checkout function for that business object.

- **Display of multivalued properties containing a comma followed by a space**
  (First published Teamcenter 8.2)
If a value in a multivalued property contains a comma followed by a space, that value is shown as two separate values. For example, consider the following values for a multivalued property:

```
Cypress, CA
Milford, OH
```

The values are displayed as follows:

```
Cypress
CA
Milford
OH
```

*How to work around or avoid*

Do not use a comma followed by a space for values that appear in a multivalued property. It is safe to use a comma without a space, for example:

```
Cypress,CA
Milford,OH
```

- **Cancel checkout of an ItemRevision instance**
  (First published Teamcenter 8.2)

  When a user cancels a checkout of an `ItemRevision` instance, changes made by other users to related data may be discarded if the latest sequence has an independent copy of this data. This applies to the master form and datasets referenced by the `Specification` relation.

  *How to work around or avoid*

  Check out related forms and datasets to prevent other users from making changes while the `ItemRevision` instance is checked out.

- **Properties dialog box checkout operation changes contents displayed during refresh**
  (First published Teamcenter 8.1)

  When you perform a check out in the `Properties` dialog box, the dialog box defaults to the first tab after the dialog box is refreshed.

  *How to work around or avoid*

  After checkout, click the desired tab in `Properties` dialog box again.

**NX Integration**

The following release notes pertain to use of NX Integration and Teamcenter Integration for NX.

- **Download hyperlink is not available for the first subassembly if a second subassembly is exported too soon**
  (First published Teamcenter 2007 MP3)

  If you export a second NX subassembly before the first subassembly export has completed in the same Structure Manager window, the `Export Status` window is not updated with the `Download` hyperlink for the first subassembly.

  *How to work around or avoid*
Either wait for the first subassembly export to finish before attempting to export the second subassembly or export the assembly that contains both subassemblies.

**Online help**

The following release notes pertain to installation and use of Teamcenter online help.

- **Teamcenter 12 help installer displays incorrect URLs after successful installation**
  
  (First published Teamcenter 12)
  
  The last step of the Teamcenter 12 product help installer displays a list of one or more links to newly installed help. The links are incorrect.

  **How to work around or avoid**
  
  Correct the links by replacing the `12.0` portion of the URLs with `12`.
  
  For example, replace:
  
  ```
  .../tdoc/tc/12.0/...
  ```
  
  With:
  
  ```
  .../tdoc/tc/12/...
  ```

**PLM XML**

The following release notes pertain to PLM XML import and export.

- **Avoiding checking the expired or locked status at TIE import**
  
  (First published Teamcenter 9.1)
  
  When transferring Global Multi-Site data from Teamcenter Enterprise to Teamcenter, the license cannot be attached because the license is locked or expired.

  **How to work around or avoid**
  
  Add the `GMS_expired_or_locked_ada_licenses_bypass` site preference to bypass checking the license locked or expired status when performing Global Multi-Site (TIE) import. If the preference value is set to `true`, the license locked or expired status is not checked and the license is attached to the object.

- **Database upgrade may fail at txml_import step when importing scope rules**
  
  (TC_DATA/defaultTransfermodes.xml)
  
  (First published Teamcenter 9.1)
  
  When upgrading to Teamcenter 9.1, if the `GMS_txml_string_separator` preference is set to something other than a comma (default value), the scope rules import and upgrade may fail. This preference is used to specify a separator for strings in TC XML import. For default scope rules .xml files, the separator should be a comma.

  **How to work around or avoid**
Before starting the upgrade to Teamcenter 9.1, check to see if the `GMS_tcxml_string_separator` preference exists in the database. If it does, delete it temporarily. After the upgrade completes, you can reset the preference.

**Project**

The following release notes pertain to Project.

- **Filter criteria in smart folder is not applied properly**
  
  (First published Teamcenter 12)
  
  An issue has been identified in the smart folder filter condition evaluation, where the applied filters are evaluated with OR criteria on abstract folders. The correct behavior is to apply AND criteria for the filters on abstract folders.

  *How to work around or avoid*
  
  This issue is fixed in the releases listed above. In addition to this fix, a new system preference, `TC_UI_SmartFolder_JoinOperator`, is introduced to support AND or OR criteria on the filters on data driven folders.

- **perform_propagation utility not included in Teamcenter 11.2**
  
  (First published Teamcenter 12)
  
  The `perform_propagation` utility is not included in the Teamcenter 11.2 release.

  *How to work around or avoid*
  
  Use the `update_project_data` utility for propagation.

- **Propagation in dispatcher mode does not work**
  
  (First published Teamcenter 12)
  
  Propagation does not work for some use cases when the propagation rules are configured with background as true. With background set to true, if Dispatcher is configured, propagation should happen in separate process. With background set to true, and Dispatcher not configured, propagation should happen in in-process. This is not working correctly.

  *How to work around or avoid*
  
  Propagation works in In Process mode even though the propagation rules are defined with background as true.

- **Project administrators cannot save added project security**
  
  (First published Teamcenter 11.2)
  
  Project administrators cannot edit the AM Rule tab in the Project application. Only members of the DBA group can modify project ACLs in the Access Manager application.

  *How to work around or avoid*
  
  Set the `TC_allow_project_admins_modify_rules` preference to true.

- **Cannot remove an object from a project**
You cannot remove an object from a project (for example, the owning project) if the project is autoassigned during object creation.

**How to work around or avoid**

Set the `TC_allow_remove_owning_project` site preference to **true**. This preference allows users to remove the owning project attribute.

---

## Query Builder

The following release notes pertain to the use of Query Builder.

- **Customizing quick search query names**

  (First published Teamcenter 8.3i)

  The list of available quick searches is missing the **General...** query.

  **How to work around or avoid**

  You can add any query names to the quick search list by updating site preferences.

  1. Log on to Teamcenter as a **dba** user.

  2. Choose **Edit→Options→Search**.

  3. Edit the following preference

     - In the **Quick_Access_Queries** preference, add the custom query name (for example, add **General...**).

     - In the **Quick_Access_Queries_Attribute** preference, add the custom query search attribute using the following format:

       `query-name_SearchAttribute=search-attribute`

       For example, to add, use the following format:

       `General..._SearchAttribute=search-attribute`

- **Indented search returns incorrect results**

  (First published Teamcenter 8.3)

  Indented searches return incorrect results when the query has complex clauses. For example, if a dataset is attached to several item revisions, searching from the item revision to the dataset works, but the reverse traversal does not return the correct result.

  **How to work around or avoid**

  Avoid adding more than one query parameter during a reverse traversal search (that is, while defining a query, do not add more than one query criteria).
Repeatable Digital Validation

The following release notes pertain to Repeatable Digital Validation (RDV).

- **Automatic population of Part Data does not work in the Add Part To Product dialog box when localization template is applied**
  
  (First published Teamcenter 9.1)
  
  The option to autopopulate fields in the **Part Data** pane in the **Add Part To Product** dialog box does not work when a localization template is applied.

  **How to work around or avoid**
  
  Add the value manually. You can then proceed to the **Architecture Breakdown** dialog box.

Report Builder

The following release notes pertain to the use of Report Builder.

- **Upgrading standard Report Builder reports**
  
  (First published Teamcenter 8.3i)
  
  Because of possible customization loss, the upgrade process does not automatically upgrade standard Report Builder reports.

  **How to work around or avoid**
  
  1. Back up report definitions using the **import_export_reports** utility with the **-export** argument. This exports one report definition at a time:

     ```
     import_export_reports -export
     -u=user-name -p=password -g=group
     -stageDir=${TC_DATA}/crf -reportId=REPORTID
     ```

     If you have style sheet customizations, you can save them with using Report Builder by opening the style sheet and saving to a local hard drive.

     2. Update all standard reports using following command:

        ```
        import_export_reports -import -overwrite
        -u=user-name -p=password -g=group
        -stageDir=${TC_DATA}/crf -reportFile=${TC_DATA}/crf/CrfReports.xml
        ```

Reporting and Analytics

The following release notes pertain to Reporting and Analytics:

- **IBM DB2 option not available when creating Reporting and Analytics WAR file using TEM**
  
  (First published Teamcenter 11.2)
  
  When you create a Teamcenter reporting and analytics WAR file on Microsoft Windows using Teamcenter Environment Manager (TEM), IBM DB2 is not included as an available database type. TEM offers only Oracle and Microsoft SQL Server.
This step occurs when you install Teamcenter reporting and analytics using TEM and select the Create WAR file option.

How to work around or avoid

If you use an IBM DB2 database on Windows and want to install Teamcenter reporting and analytics, use the standalone Reporting and Analytics installer.

The standalone Reporting and Analytics installer is available on the download page on GTAC. Under the download list for Teamcenter and Teamcenter Rapid Start, find RptAnalytics, then find the list of files for your version of Teamcenter. Download the TcRAversion.zip file for your Teamcenter version.

Launch the Reporting and Analytics standalone installer:

1. Expand the TcRAversion.zip file to your local host.

2. In the expanded directory, locate the Installable\TcRA.zip file. Expand this file to a local directory.

3. Launch the Installer\install.bat batch program.

For more information about the Reporting and Analytics standalone installer, see the Teamcenter Reporting and Analytics Deployment Guide in the TcRAversion.zip file.

• Password confirmation on change profile page

(First published Teamcenter 9.1)

If you save the Reporting and Analytics logon password when asked by the browser (if the save password feature of the browser enabled), a problem may occur on the change profile page. The browser asks you whether you want to change the password stored in the browser memory even if you do not change the password.

How to work around or avoid

Do not change the password when asked by the browser on the change profile page unless you have really changed the password. If you save the password, the browser stores the wrong password in its memory. In this case, your next logon to Reporting and Analytics fails if you rely on a saved password.

• Inconsistent list of databases when creating WAR file

(First published Teamcenter 9.1)

While creating a WAR file from Teamcenter Environment Manager (TEM) on Teamcenter 9 (drop 2011061500) on Windows, the Reporting and Analytics databases are displayed as Oracle and SQL Server on the menu. On SUSE Linux, they are displayed as IBM DB2 and Oracle.

To reproduce the problem:

1. Log on to Windows or SUSE Linux machine and run TEM.

2. In the Features panel, select Reporting and Analytics→Teamcenter for Reporting and Analytics.

3. Select the Create WAR File option and continue with the installation.
4. In the **TcRA Database Selection** panel, the following options are displayed in the **Database Engine** box:
   - Windows systems
     - **Oracle** and **MS SQL Server**
   - SUSE Linux systems
     - **DB2** and **Oracle**

*How to work around or avoid*

Use eQube's stand-alone installer to install Reporting and Analytics for DB2. For instructions about using this installer, see the eQube deployment guide, which can be found in the download area for Reporting and Analytics on GTAC.

Following is an overview of the instructions for using the eQube installer:

1. Download the **TCRA.zip** file and the deployment documentation from GTAC.
2. Unzip the **TCRA.zip** file.
3. Launch the eQube installer using the **../Installer/install.bat** file.
4. For further instructions, see the eQube deployment guide.

- **Cannot open a report from the rich client using Firefox**
  (First published Teamcenter 8.3)

  If multiple reports are launched from the rich client in the same browser, they do not appear when using Firefox.

  *How to work around or avoid*

  When a report is launched from Teamcenter with Firefox as the default browser, log out from Reporting and Analytics before launching the next report.

- **Attribute search problem**
  (First published Teamcenter 8.2)

  In Semantic Mapper, when an attribute is searched in the cube creation wizard, if you clear the attribute in the search and attempt to search again, you cannot select a new attribute using the mouse.

  *How to work around or avoid*

  Select an attribute using the keyboard or go back to the previous page and start over.

- **Scheduled tasks do not appear in BuildNPlay**
  (First published Teamcenter 8.1)

  After viewing the results of any report in the BuildNPlay application, add new tasks to the schedule in the Teamcenter Schedule Manager application. When you refetch the report from the BuildNPlay application, the new tasks are not shown.

  *How to work around or avoid*
Close the session and launch a new BuildNPlay session to view the updates.

- **Filter conditions are not working properly**
  (First published Teamcenter 8.1)
  If the Saved Query option is selected as a source object for a report, and the ISNULL or IS NOT NULL filter values are applied, the report does not return any values.

  *How to work around or avoid*
  Save the report definition, and while saving do not select these operators. When users of the report run the definition, they do not see nonfunctioning operators.

- **!= and IS NULL operators do not work when running saved queries for a Teamcenter 2007 connection**
  (First published Teamcenter 2007)
  The != and IS NULL operators do not work when running saved queries for a Teamcenter 2007 connection. They do not work in ad-hoc flow from BuildNPlay because saved queries work only for the = operator.

  *How to work around or avoid*
  The administrator should select only the = operator when saving the report definition build on saved queries.

- **All operators appear in the interface for both saved and database queries**
  (First published Teamcenter 2007)
  All operators appear in the interface for both saved queries and database queries, even though only the = operator works for saved queries.

  *How to work around or avoid*
  The administrator should select only the = operator when saving the report definition build on saved queries.

### Requirements Manager

The following release notes pertain to usage of Requirements Manager.

- **Cannot view rich text in Microsoft Word 2013 - 2016**
  (First published Teamcenter 12)
  After you edit the content of a Requirement in the embedded Word viewer in the rich client, the Requirement seems to get corrupted and cannot be exported to Word Live.

  This problem is specific to Microsoft Word 2013 and 2016.

  *How to work around or avoid*
  The standard Teamcenter templates need to be updated. These templates are not updated during the upgrade process. Below are the steps to update out of the box templates:

  1. In rich client, search for **REQ_default_spec_template** and delete this item.
2. In rich client, search for `REQ_default_spec_template_for_view` and delete this item.

3. In rich client, search for `REQ_default_object_template` and delete this item.

4. Open the server command prompt and run following command line utility:
   ```bash
   add_req_templates -u=infodba -p=infodba -g=dba
   ```

- **Spec/Object template import from PLMXML import**
  
  (First published Teamcenter 12)
  
  When you import Spec/Object template from PLMXML, the header and footer information may be missing.

  **How to work around or avoid**
  
  This issue has been fixed but it is not recommended to use PLMXML Import for importing Spec/Object template. Use the standard import template functionality.
  
  Also, it is not recommended to have header footer in the object template when you import the object template from PLMXML Import.

- **Warning box displayed for Word Live edit**
  
  (First published Teamcenter 12)
  
  A Modified Object Warning is displayed when saving exported word document when a structure is created through Import Spec.

  **How to work around or avoid**
  
  This issue occurs only when the document is imported and then exported in one session. To work around this issue:

  1. Refresh the window before export.
  2. Export the object in a separate session.

- **TraceLink class, a subclassed from ManagedRelation class, has been deprecated**
  
  (First published Teamcenter 12)
  
  The TraceLink class, as extended from the ManagedRelation class, has been deprecated since Teamcenter 8.0.

  **How to work around or avoid**
  
  The feature has been migrated to new Trace Link class, `FND_TraceLink` under `TCRelation`. Also, a migration utility has been provided, and all TraceLink instances are migrated to new TraceLinks during database upgrade.

- **Compare contents feature fails using Office 2013 32 bit on Windows 10.**
  
  (First published Teamcenter 12)
  
  Compare contents feature is not supported on Office 2013/2016 32-bit on Windows 10 systems.

  **How to work around or avoid**
  
  ...
1. Use any office 64 on windows 10 machine.

2. Use any Office version with 32/64 bit on a Windows 7 machine.

- **Adding more than 5MB TEXT to a Requirement Fulltext fails**

  (First published Teamcenter 12)

  Create a Requirement in rich client and open the FullText of the RequirementRevision attached to it using double-click. This opens a Microsoft Word document.

  Copy and paste the contents of a file more than 5 MB of size and save the changes.

  The changes are not saved to database and the following error is displayed:

  The given string is invalid.

  Currently this is a limitation with the **POMLong String** which cannot save large amount of data.

  **How to work around or avoid**

  For Requirements containing large amount of data (if you are copy pasting data from files larger than 5 MB size), break the Requirement contents into multiple Requirements. Each Requirement should have rich text data preferably less than 5 MB bytes of data. Such data can be easily saved and retrieved into the **body_text** attribute of FullText.

- **Comma is treated as separator for array property in German locales**

  (First published Teamcenter 12)

  For an array property, a comma is treated as a separator. This causes a problem for double/float type of array columns in German locales, where a comma acts as decimal separator.

  **How to work around or avoid**

  In German locales, enter multiple values separated with **Alt+Enter** (new line). You will have to enter multiple values as shown below:

  \[
  2, 2 \\
  3, 3 
  \]

  For **string/int** data types, you may continue using a comma as a separator for Array columns.

---

**Schedule Manager**

The following release notes pertain to usage of Schedule Manager.

- **Enhanced schmgt_async_r11 utility with input file**

  (First published Teamcenter 12)

  You may experience one of the following problems in Schedule Manager:

  o Unable to delete item in Schedule Manager due to Nullpointer exception.

  o The **schmgt_async_r11.exe** delivered with CSP crashes while migrating 72K Schedules.

  o Migration utility needs to skip inconsistent schedules during the data migration.
How to work around or avoid

This utility has been enhanced to take as an input a CSV file containing comma separated Schedule UIDs of all schedules whose data needs to be migrated. In this mode, it performs the actual consolidation of attributes of only those Schedules whose Schedule UIDs are present in the input file. The utility will not touch any other schedule data other than the ones mentioned in the input file. If there are any inconsistent schedules encountered during data migration, the utility will skip those schedules and continue processing the next schedule in the file. All the relevant information of schedules that are not migrated and schedules that are migrated successfully will be added to a log file with name "schmgt_async_name_timestamp.log. The log file will be created in the TC_TEMP directory.

Inconsistent Schedule Definition

Inconsistent schedules are Schedules in pre-Teamcenter-11.2 releases that do not have the complete set of scheduling objects related such as Forms, Revisions, Data files and any other type of data integrity problems that prevents such schedules from being opened in Schedule Manager application and being worked upon by Schedule members.

Parallel or Concurrent runs of Asynchronous Data migration Utility:

Multiple instances of the utility can be run in parallel with each process instance having a distinct and different CSV file as input. When running multiple instances of the utility in parallel, the user has to ensure:

1. The schedule UIDs listed in each input CSV file are unique.

2. Schedule UIDs of all related schedules (this is, schedules that are related to each other or have some dependencies to each other like the master schedule and sub schedules) are listed together in a single CSV file so that all those schedules are migrated together in one batch. If not, there may be cases where some schedules are migrated successfully while dependent schedules are not. For example, a master may not have completed migration while the sub schedule would have.

Command to run the utility with input file is as follows:

```
schmgt_async_r11 -u=user {-p=password|-pf=password-file} -g=group-name
 input_file=CSV-file-path-containing-Schedule-UIDs
```

Running the Schedule Manager asynchronous utility in data pre-check scan mode:

Running the utility in this mode scans the entire upgraded customer database and reports customer data inconsistencies or errors in an error log file. It's important to note no modifications to customer data is made during this scan run. The customer is expected to review the error log and make the necessary corrections to the reported schedule data in customer database manually to eliminate those errors. This utility has been designed to find out inconsistencies or corruptions known from prior experience. It does not guarantee finding all possible inconsistencies or corruptions.

1. Open a Teamcenter command prompt and run the following utility in the data pre-check scan mode:

   ```
schmgt_async_r11 -u=infodba -p=infodba -g=dba -m=dryrun
```

2. When the utility runs in the scan mode, the command console displays an output similar to the ones listed below.
3. In the pre-check scan mode the utility will scan the database for any existing inconsistencies in Schedule Manager data and report the inconsistencies to a log file. The log file is created in the TC_TEMP directory. The name of the log file will be similar to schmgt_async_dryrun_name_timestamp.log.

4. Open the above log file in a text editor such as Textpad and search for the string "Error". Each of these matches will point to an inconsistency or corruption already present in the Schedule Manager data in the database.

5. The log file will also contain statistics on the total number of schedules in the database and the total number of schedules scanned by the utility.

6. If there are any inconsistencies reported in the log file, the customer needs to correct the inconsistency in the data.

7. Repeat steps 1 through 6 until all the inconsistencies are corrected and the scan mode is successful.

- Use ISO8601 standard for week numbering in Schedule Manager Gantt

(First published Teamcenter 12)

The week number is not shown correctly when the SM_GANTT_USE_ISO_8601_FOR_DATE preference is set to true.

How to work around or avoid

For Teamcenter 10.1.7: When the SM_GANTT_USE_ISO_8601_FOR_DATE preference is set to false, the first day of week will be Sunday and week number will be as per locale in which Teamcenter is running. When the SM_GANTT_USE_ISO_8601_FOR_DATE preference is set to true, the first day of week will be Monday and week number will be as per ISO 8601 standard.

For Teamcenter 11.2.3: The Gantt will display the first day of the week as specified by the Start Of Week preference. When the SM_GANTT_USE_ISO_8601_FOR_DATE preference is set to false, the week numbering will be as per locale in which Teamcenter is running. When the SM_GANTT_USE_ISO_8601_FOR_DATE preference is set to true, the week numbering will be as per ISO 8601 standard. Also, the 'Start Of Week' preference should be set to Monday.

Simulation Process Management

The following release notes pertain to Simulation Process Management.

- Use "Favorite Tools" menu to access tools instead of the tools bar in CAE Manager
(First published Teamcenter 12)

Simulation tool icons do not appear in the Simulation Tools bar in CAE Manager. However, the same can be accessed from the drop-down "Favorite Tools" menu.

How to work around or avoid

Currently, there is no workaround. The tools marked as "Favorite" can be accessed from the drop-down "Favorite Tools" menu.

**Specification Manager**

The following notes pertain to usage of Specification Manager.

- **Specification transfer from Interspec to Teamcenter fails if the PS_Find_Number_VValidation preference is set to true**

  (First published Teamcenter 8.1)

  The **PS_Find_Number_VValidation** preference determines whether Teamcenter validates find numbers.

  Specifications transferred from Interspec to Teamcenter do not have find numbers. If this preference is set to true, you get an error when the find number is zero or not unique within the parent structure.

  How to work around or avoid

  You can perform either of the following steps:

  - Set the **PS_Find_Number_VValidation** preference to **FALSE**.
  - If you want the **PS_Find_Number_VValidation** preference value set to **TRUE**, create a new preference as follows:
    - Preference name: **PS_Allow_Null_Find_Number**
    - Preference type: **Logical**
    - Preference value: **TRUE**

- **Base Name type not supported**

  (First published Teamcenter 8.1)

  The Interspec integration with Teamcenter does not support transfer of specification sections of the **Base Name** type.

**Structure Manager**

The following release notes pertain to Structure Manager.

- **Closing Properties View in Structure Manager pops up Structure Manager Close Dialog**

  (First published Teamcenter 12)
If you modify a bomline property in Structure Manager and then select **Windows→Show View→Properties** to display the bomline properties, closing this Properties view prompts you to save the structure changes.

**How to work around or avoid**

This behavior is changed in Teamcenter 12.0 and later versions, which use Eclipse SDK Neon.

- **Install/Enablement of Structure Manager Application - Product Configurator feature affects usability of Variants in MRO Applications**

  (First published Teamcenter 12)

  In As-Built Manager/Service Manager:

  With a Neutral Parts structure displayed in Structure Manager, the ability to define Variants using the Variants tab on the Data/Panel is not available.

  If you click on the Show/Hide Data Panel the Variants tab is not displayed. If you want to set the applicable Variant on the root part, the **Set options values for selected module** button in the toolbar no longer displays the Configure dialog. It instead opens the new Product Configuration pane.

  With a Neutral Structure that has variant options and variant conditions defined displayed in the As-Built Manager or Service Manager-Service Editor views, if the user sets a variant rule for the window and then disables the **Show Unconfigured Variants** using the View toolbar, it does not hide the unconfigured variants in the Neutral Part structure.

  In Service Planner:

  With a Service Plan structure that has variant options and variant conditions defined displayed in Service Planner view, if the user sets a variant rule for the window and then disables the Show Unconfigured Variants via the view toolbar, it does not hide the unconfigured variants in the Service Plan structure.

  In Service Scheduler:

  With a Service Plan structure that has variant options and variant conditions defined displayed in Generate Automated Service Schedule dialog, If the user sets a variant rule for the structure via the Configure Service Plan button the unconfigured variants are still displayed in the Service Plan structure.

  **How to work around or avoid**

  Setting the **PSM_enable_product_configurator** preference to **false** disables the Product Configurator and removes the effects to the usability of Variants for the MRO Applications. The preference can either be set for the site by a **dba** user or for an individual by a non-**dba** user.

- **Paste user interface and error handling change in Structure Manager**

  (First published Teamcenter 12)

  When Java Runtime Environment (JRE) 1.8 or higher is used, pasting in Structure Manager may not display the progress dialog. When error happens, the error message cannot be retrieved from the dialog.

  **How to work around or avoid**

  Check the console or rich client log for the error message.
Adding a child query takes extra time during expand

(First published Teamcenter 12)

While executing Add Child and Edit Properties use cases in a DITL environment, we found that the following SQL query takes more time (about 3.5 seconds) in Teamcenter12.2.2.1 and Teamcenter 9.1.3.6.

```
SELECT /* DYNAMIC_SAMPLING(PRef1TT 4) */ t_01.puid, t_01.pchange_type,
t_01.raffected_objectut, t_01.raffected_objectct,
t_01.rincr_change_revut, t_01.rincr_change_revct,
t_02.ritems_tagut, t_02.ritems_tagct
FROM PINCREMENTALCHANGEELEMENT t_01,
PITEMREVISION t_02,PRef1TT
WHERE ((t_01.rincr_change_revut = t_02.puid) AND
 t_01.raffected_objectut = PRef1TT.puid ) AND (t_01.rparent_objectut = :1 )
ORDER BY t_01.raffected_objectut ASC
```

How to work around or avoid

When performing above query, drop the index IncrementalChangeElement affected_object parent_object and create a new IncrementalChangeElement affected_object incr_change_rev.

This is because incr_change_rev is being used in query while joining the tables. It doesn't use parent_object.

Perform the following steps:

1. Drop the following two existing indexes:
   ```
   %TC_BIN%\install -drop_index -u=tcadmin -p=tcadmin 
   -g=dba IncrementalChangeElement incremental_change_index
   
   %TC_BIN%\install -drop_index -u=tcadmin -p=tcadmin 
   -g=dba IncrementalChangeElement ice_parent_index
   ```
2. Create the following new index:
   ```
   %TC_BIN%\install -add_index -u=tcadmin -p=tcadmin 
   -g=dba incremental_change_index 0 IncrementalChangeElement 
   affected_object incr_change_rev
   ```

Non-editable properties may appear editable before submission in Structure Manager

(First published Teamcenter 11.2)

If a property is not editable due to an access rule or some business rule, the Structure Manager interface may allow you to edit the property in the user interface before you submit the change.

How to work around or avoid

After submitting the change, if the property should not be modifiable, the change is rejected. So, there should not be any data corruption.

Run in Background duplicate operation creates incorrect link in e-mail

(First published Teamcenter 10.1)

When Subscription Manager is turned ON and the Run In Background duplicate feature in Systems Engineering is selected, the asynchronous system sends a notification processed by the Subscription Manager with a link to the DispatcherRequest object. Because the DispatcherRequest object is deleted quickly, clicking the URL in the notification displays an error.

How to work around or avoid
Check for the newly created item in the Teamcenter mail folder and do not click the DispatcherRequest URL.

**Incremental change icon not displayed after form checkout and edit**

(First published Teamcenter 10.1)

The incremental change icon is not shown on item revision master forms after you edit them using shortcut menu commands. To reproduce the problem, perform the following steps:

1. Create an item in Structure Manager.
2. Create an incremental change context.
3. Open the data pane with the Attachments tab available.
4. Right-click the item revision master form and choose Check Out.
5. Right-click the item revision master form and choose Properties.
6. Edit some property, save the item, and check in.

The incremental change icon is not shown next to the item revision master form as expected.

*How to work around or avoid*

Double-click the item revision master form and check it out. Edit it, save it, and then check it in. The incremental change icon is shown next to the item revision master form as expected.

**Note**

This procedure assumes the Incremental_Change_Management preference is set to true.

**Missing information in baseline or duplicate error messages**

(First published Teamcenter 10)

There is a limitation in the baseline and duplicate error handling code. Sometimes, certain error messages miss some dynamic information. For example, if the baseline or duplicate operation fails with an occurrence condition validation, the condition name is missing in the error message.

*How to work around or avoid*

Currently, there is no workaround for this problem. This issue does not cause any data corruption or loss of functionality.

**Saving structures with multiple open windows**

(First published Teamcenter 9.1)

When multiple BOM windows with different structures are pending for save, clicking the Save button saves only the modifications in the active BOM window. The Save button remains active until all BOM windows having modifications are individually saved.

*How to work around or avoid*
This behavior is working as designed. When all windows with modifications are saved, the Save button is disabled.

- **Date properties in Structure Manager**
  
  (First published Teamcenter 9.1)

  Date properties in Structure Manager show the server time instead of the client time when using a rich client in a different time zone than the server. By default, there are no date properties on BOM lines, so this behavior is seen only on custom date properties.

  **How to work around or avoid**

  Right-click and choose View Properties to see the correct client time and date on date properties in Structure Manager when using a rich client that is in a different time zone than the server.

- **Modifications to BOM reports**
  
  (First published Teamcenter 9.1)

  The BOM report is blank when the BOM is made up of design objects.

  **How to work around or avoid**

  Perform one of the following:

  o Perform the following steps to generate reports if your environment has been upgraded from Teamcenter 2007 or 8.x to Teamcenter 9.1:

    1. Create a file named ModReports.xml with the following content and store it in the TC_DATA directory:

    ```xml
    <?xml version="1.0" encoding="iso-8859-1"?>
    <OOTBReports>
    <reportdefinition id="crf_itm_rpt_id3" domain="bom"
    specification="TC_2007_00_ITM_RPT_0003.xml" />
    </OOTBReports>
    ```

    2. Execute the utility import_export_reports utility as follows:

    ```bash
    import_export_reports -u=infodba -p=> -g=dba -stageDir=%TC_DATA%\crf
    -reportFile=%TC_DATA%\crf\ModReports.xml" -overwrite
    ```

  o Perform the following steps to generate reports for any custom item types. (The Item, Part, and Design types are already supported.)

    1. Update the TC_2007_00_CrfPSBOMReports property set with required clauses for new item types.

    2. Make changes to the following style sheets and update the corresponding datasets with the updated XSL files. Existing style sheets have changes for Part and Design and the same objects can be extended for the new item type. In My Teamcenter, use the General... search to find the following datasets and update the style sheets:

    | XSL file                     | Style sheet dataset name    |
    |------------------------------|-----------------------------|
    | ps_bom_report_html.xsl       | CrfHtmlStyleSheet           |
    | ps_bom_report_excel.xsl      | CrfExcelStyleSheet          |
    | l10n_ps_bom_report_html.xsl  | CrfHtmlStyleSheet           |
    | l10n_ps_bom_report_excel.xsl | CrfExcelStyleSheet          |
• **Clear Repositioning check box removed from the Product View Gallery dialog box**
  
  (First published Teamcenter 9.1)
  
  The **Clear Repositioning** check box in the **Product View Gallery** dialog box is no longer available when applying product views. The positions are always applied relative to the positions stored in the Teamcenter structure, which was the previous default behavior.

  **How to work around or avoid**
  
  The option that controls whether or not to clear repositioning when product views are applied is removed. The default behavior to clear repositioning before applying a product view is now the only behavior supported. The product view positioning always applied relative to the positions stored in the Teamcenter structure, and any temporary repositioning set within the current viewer session (that have not been saved to Teamcenter) is ignored when the product view is applied. This has been the default behavior for many releases, and is now the only behavior supported.

• **Manufacturing Process Planner application refresh problem with in-context overrides**
  
  (First published Teamcenter 9.1)
  
  If you are in the Manufacturing Process Planner application and create a new product structure, apply in-context overrides to the structure, and then revise the in-context line of the structure, you encounter a refresh issue with the overrides on the revised structure. This problem only occurs when doing all the steps within the same Manufacturing Process Planner session. Already established data does not encounter this refresh problem.

  **How to work around or avoid**
  
  If the in-context data is missing after a revise, choose **View→Refresh Window** and the in-context information is loaded.

• **Copying data during variant item creation is controlled by preferences**
  
  (First published Teamcenter 9.0)
  
  During variant item creation, absolute occurrence data, appearance path nodes (APNs), and arrangements are copied by default. This causes performance problems.

  **How to work around or avoid**
  
  Absolute occurrence data, appearance path nodes (APNs), and arrangements are not always required during variant item creation. Copying them to the variant item is now controlled through preferences.

  To change the default behavior during data item creation, create the following preferences as site-level preferences and set them as described.
### Preference |
<table>
<thead>
<tr>
<th>PSECreateVISameType</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>If you want to allow NX arrangement data to carry forward during variant item creation, set this preference to <strong>False</strong>.</td>
</tr>
</tbody>
</table>

**Note**

Setting this preference to **False** only *enables* copying of arrangements data. Copying of NX arrangement data depends on the following two preferences being set to **True**.

If this preference is set to **True**, absolute occurrence data and arrangements are carried forward regardless of the values of the following two preferences.

<p>| Preference |</p>
<table>
<thead>
<tr>
<th>PSECopyAbsOccDuringVICreation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>To carry forward absolute occurrence data and APNs, create this site-level preference and set it to <strong>True</strong>.</td>
</tr>
</tbody>
</table>

This preference does *not* carry forward arrangements data.

<p>| Preference |</p>
<table>
<thead>
<tr>
<th>PSECopyArrangementsDuringVICreation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>To carry forward arrangements data, set this preference <em>and</em> <strong>PSECopyAbsOccDuringVICreation</strong> to <strong>True</strong>.</td>
</tr>
</tbody>
</table>

For more information about these preferences, see the *Environment Variables Reference*.

- **Refresh problem when switching NX arrangements in Structure Manager**

(First published Teamcenter 9.0)

After you import an NX structure into Structure Manager using the **Import Assembly into Teamcenter** menu command, you may encounter problems configuring the NX structure.

Perform the following steps to import a native NX structure into Teamcenter using the **Import Assembly into Teamcenter** menu command:

1. Start Teamcenter.

2. Start the NX application from Teamcenter.
3. In NX, import a structure with arrangement data into Teamcenter (File→Import Assembly into Teamcenter).

   **Note**
   Assemblies imported into Teamcenter have no arrangement data.

4. In NX, open the Teamcenter structure you imported.

5. In NX, choose File→Force Save All.

   **Note**
   This step imports the arrangement data into Teamcenter from the NX part files.

*How to work around or avoid*

Perform one of the following workarounds.

- Close and reopen the structure in Structure Manager.

- Perform a Teamcenter refresh from NX immediately after you choose the File→Force Save All command:
  1. Perform the recommended steps for importing a native NX structure into Teamcenter using the Import Assembly into Teamcenter option in NX.
  2. In NX, choose File→Close→Close and Reopen Selected Parts.
  3. In the Reopen Part dialog box in NX, click the Refresh Teamcenter Information button.

*• Design Context problem (First published Teamcenter 8.3i)*

Design Context does not return background part appearances with proximity and valid overlays only (VOO). The root cause is missing stored procedures.

*How to work around or avoid*

After upgrade, install the missing stored procedure using the install -enq_support command.

*• Enhancement of the item_to_part_design utility (First published Teamcenter 8.3)*

The item_to_part_design utility was not working due to the core data model changes from Teamcenter 8 onward.

*How to work around or avoid*

The item_to_part_design utility was modified in Teamcenter 8.3 according to the new data model changes from Teamcenter 8 onward.

For a full description of this utility, see the Utilities Reference.
• **Form edits in incremental change context**  
  (First published Teamcenter 8.2)  
  Editing forms for incremental change and reservations features (such as checkout, checkin, cancel checkout) does not work as expected when you use the context menu.  
  **How to work around or avoid**  
  While working in incremental change context and form edits, use the **Check-Out, Check-In** and **Cancel Check-Out** buttons available through the form dialog box.  

• **Teamcenter Duplicate limitations with Creo data**  
  (First published Teamcenter 8.2)  
  The Teamcenter Duplicate feature has limitations when used on structures containing certain types of Creo data. Until these limitations are removed in a future version of the Teamcenter Integration for Creo, and in Teamcenter itself, Teamcenter Duplicate must not be used on Creo structures that contain external references. Examples of external references are:  
  Creo part and assembly family table instances  
  Part to part reference or merge relations  
  Interchange groups  
  There are many other examples. Only assemblies whose references are self-contained within the Engineering Bill of Materials may be safely duplicated in Teamcenter.  

• **Insert Level dialog box does not support special types**  
  (First published Teamcenter 8.2)  
  The **Insert Level** dialog box only displays certain types of classes. Any classes that require special dialog boxes do not appear in the list.  
  **How to work around or avoid**  
  Create the object of the special class, copy the object into the clipboard, choose **Paste Special**, and paste the object as a new level above the selected lines. It performs the insert level.  

• **Incremental change (IC) context override not seen when change is made under new IC revision**  
  (First published Teamcenter 8.1)  
  An incremental change context override does not appear when the change is made under a new incremental change revision.  
  **How to work around or avoid**  
  While it is possible to revise incremental changes, this makes their analysis and usability more complex, and Siemens PLM Software does not recommend this approach.  

• **Structure Manager behavior after four-tier server session time-out**  
  (First published Teamcenter 2007)  
  Structure Manager edits are lost if a four-tier server session time-out occurs.
There are four-tier configuration settings that cause a server to time-out if clients are inactive. If a server times out and is killed, Structure Manager client-pending changes are lost.

**How to work around or avoid**

Four-tier administrators should set the time-out in a way that a time-out does not occur for a server in edit mode. For Structure Manager, this corresponds to an active **SAVE** button in at least one BOM dialog box, which represents at least one Structure Manager session with unsaved changes. The default is 8 hours for a server in edit mode. If sessions are up overnight, a 24-hour time-out (or longer to allow for weekends) addresses most issues.

- **Toolbar buttons revert to previous positions**
  (First published Teamcenter 9.1)

If you rearrange toolbar buttons in Structure Manager, those buttons do not retain their new positions the next time you log on to Teamcenter. The buttons you rearrange revert to their previous positions.

To reproduce the problem, perform the following steps:

1. Log on to Teamcenter.
2. Start Structure Manager.
3. Move the following buttons in the toolbar:
   - Navigation Pane
   - Add Signals from Library
   - Add Classified Component using Guided Component Search

   These buttons are near the **Delete** button in the toolbar.
4. Log off Teamcenter and log on again.
5. Start Structure Manager.
6. The buttons you moved return to their previous positions.

**How to work around or avoid**

Use the toolbar customization dialog accessible from the shortcut menu to rearrange toolbar buttons.

---

**Systems Engineering and Requirements Management**

The following release notes pertain to use of Systems Engineering and Requirements Management.

- **Save As operation fails on Mdc0ConditionalElementGroup objects**
  (First published Teamcenter 11.2)

The **Save As** operation on the **Mdc0ConditionalElementGroup** object fails with the following error:
The instance cannot be saved because it contains at least one attribute that violates a unique attribute rule.

**How to work around or avoid**

Add the `mdc0CegId` property on the `Save As` descriptor for the `Mdc0ConditionalElementGroup` object.

- **Save As failed for MDC objects**
  (First published Teamcenter 11.2)
  The unique ID is copied from the original object on the `Save As` operation, causing the unique ID conflict for MDC objects.
  
  **How to work around or avoid**
  Setting the `CopyFromOriginal` property constant to `false` solves the issue.

- **Ports are not getting copied on newly created logical elements by the `Save As` operation**
  (First published Teamcenter 11.2)
  Ports are not getting copied on newly created logical elements by the `Save As` operation.
  
  **How to work around or avoid**
  The following deep copy rule can be added to copy the ports on the `Save As` operation for logical elements:

  ```xml
  <TcDeepCopyRule
typeName="Rlz0RealizedItem"
relRefPropName="rlz0element"
propertyType="ReferenceProperty"
objectTypeName="Rlz0GDEArtifact"
conditionName="isTrue"
operationName="ITEM_create_from_rev"
copyType="CopyAsObject"
isTargetPrimary="false"
secured="false"
copyRelationAttributes="true"
isRequired="false"
description=""/>
  ```

- **Object IDs and link IDs are not recognized by flat file import**
  (First published Teamcenter 11.2)
  Object and link IDs are not recognized by a flat file import.
  
  **How to work around or avoid**
  This is as designed. The flat file processes only those IDs that Word is capable of finding using the find function (Ctrl+F).

- **Import specification does not work with some object types**
  (First published Teamcenter 11.2)
  The import specification is not supported if an object type has a required property with null values allowed and the initial value is not set (or set to null).
  
  **How to work around or avoid**
  Define the initial values for required properties using the Business Modeler IDE.

- **Addin toolbar for flat file import does not load**
  (First published Teamcenter 11.2)
  When a user opens Word with a new document, the addin toolbar for flat file import does not load.
How to work around or avoid

Save the new document first and then open the document to load the addin toolbar. When you create a new document, you do not see the Teamcenter flat file import toolbar. You must save the document and open it to see and work with the toolbar. This behavior is by design.

- **Placement of transfer mode rules in an object template**

  (First published Teamcenter 10.1)

  To place a single secondary property between two primary properties, use transfer modes with properties.

  The following example shows an invalid object template:

  ```{object_name}
  {Rule:Selection.Export.TM.Transfermode}
  {body_text}
  ```

  The following example shows a valid object template:

  ```{object_name}
  {body_text}
  {Rule:Selection.Export.TM.Transfermode}
  ```

  The transfer mode section is always placed after the end of the property section in the object template.

- **Some subclasses are not displayed in the MATLAB integration Open/Insert dialog box when Classification tree nodes are expanded**

  (First published Teamcenter 9.0)

  In the MATLAB integration, in the Classification pane, when you select the Open/Insert menu command, the Behavior Model libraries tree is displayed. When you expand the nodes in this tree, some subclasses displayed in Teamcenter are not displayed in the Open/Insert dialog box. The tree displays only classes and groups if the library type for the selected class or its immediate parent is set to Behavior Model. For classes whose library type attribute is not set, the models in these classes are still displayed in the Open/Insert dialog box when the parent classes are selected. However, its classification properties are not displayed.

  How to work around or avoid

  To display all the subclasses in a Behavior Model library in the Open/Insert dialog box, the Classification administrator must set the library type attribute for each class that needs to be displayed in MATLAB integration dialog boxes to the Behavior Model library value. This is done by selecting Behavior Model in the library type LOV.

- **Live Excel causes crash after session change and export**

  (First published Teamcenter 10)

  If you change the session parameters like user role, group, and so on, and then export to live Excel and edit the session-based LOVs, the server is disconnected.

  How to work around or avoid
Log on to Teamcenter once more and export the same objects again to live Excel. The behavior works correctly.

• **Microsoft Office add-ins for flat file import**  
  (First published Teamcenter 10)  
The Microsoft Office add-ins are not available to all users on the host where they are installed.  
*How to work around or avoid*  
An administrator must install the add-ins.  

Users without administrative privileges cannot install these add-ins. There is no option available to users to allow them to install the add-ins individually. Add-ins always must be installed with the **All Users** option.

• **Applying styles to bullets and numbering in an empty content control**  
  (First published Teamcenter 9.1)  
When you apply bullets or numbering to an empty content control, the bullet or numbering style is outside content control. This is the default behavior of Microsoft Word.  
*How to work around or avoid*  
1. Apply bullets or numbering to an empty content control.  
2. Enter text in the content control and press Enter.  
3. Microsoft Word automatically adds the next bullet or numbering style.  
The previous style comes within content control.

• **No error message when generating a report with the Office Live option if live Excel is not installed**  
  (First published Teamcenter 9.1)  
When you attempt to generate an live Excel sheet or an live Excel report, the report is not displayed and no error message describes why the report did not appear. An error message should appear stating that live Excel is not installed.  
*How to work around or avoid*  
The following are prerequisites for live Excel or live Excel (Bulk mode):  
o Excel 2007 or 2010.  
o Teamcenter extensions for Microsoft Office should be installed on the client machine.  
The following are prerequisites for live Word:  
o Word 2007 or 2010.  
o Client for Office should be installed on the client machine.  
If you are performing any live Excel or live Word operation without these prerequisites, then no error appears.
• **Markups are not supported when exporting intermediate BOM lines to Word**  
  (First published Teamcenter 9.1)  
  Selecting a top specification and exporting it for markup works correctly. But if you select an intermediate BOM line that has markup and attempt export it, the markup is not displayed.  
  **How to work around or avoid**  
  Export the top BOM line.  

• **Client-side validations for live Word**  
  (First published Teamcenter 9.1)  
  There is no validation on the client if you have any problem with user input in a live Word document (for example, you enter text in a numeric property box).  
  In addition, the default placeholder text is displayed when you export an empty property. This text is set on the server and is in English only. This poses a problem for non-English clients, such as Japanese.  
  **How to work around or avoid**  
  The client now validates the basic input with Word itself and shows a message similar to the following if you enter invalid text: Value 'XYZ' is not an Integer. If you enter invalid data, the client validates basic data entered and reverts to the old value or placeholder text as applicable.  
  Examples of invalid data are a string entered in an integer property content control or plain text entered in a date property content control.  
  For empty properties, an asterisk (*) is set as the placeholder text in the content control irrespective of locale setting. This indicates that the content control does not have any value. While setting properties, this value is ignored on the server. While creating new objects from Word, the same placeholder is used. To indicate which property must be entered, temporary static text is displayed against the content control indicating the localized display name of the property. This static text (property name) is not saved in Teamcenter.  

• **Precedence followed for templates in document generation**  
  (First published Teamcenter 9.1)  
  In the document generation process, there are three sources from which you can provide templates (specification templates and object templates).  
  o **Export To Word** dialog box  
    This method is called as a template override during run time.  
  o Item revision definition configuration (IRDC)  
    Teamcenter provides IRDC for paragraph revision and requirement revision business objects.  
  o Site preferences, specifically the following preferences:  
    - REQ_default_spec_template_for_export  
    - REQ_default_spec_template_for_view  
    - REQ_default_object_template
The order in which these sources are checked is not obvious and can cause confusion.

How to work around or avoid

Systems Engineering checks sources during document generation in the following order:

1. Check for run-time template overrides, for example, from the Export to Word dialog box.

2. If there are no run-time template override, check whether IRDC is available for the selected business types.

3. If no IRDC configuration is found, get the templates names configured using the following preferences:
   - REQ_default_spec_template_for_export
   - REQ_default_spec_template_for_view
   - REQ_default_object_template

   The system uses these templates during document generation.

Systems Engineering uses this precedence for finding templates during the document generation process.

- Macro changes for Office 2010 users in Excel template

(First published Teamcenter 9.1)

If you have Office 2010 with user-defined macros in the Excel template and you export to Excel using the template, you see the following error:

You don't have Office 2007 or 2003 which is required to support the interface.
It cannot connect to Tc2007 for live-editing or accumulate changes.

How to work around or avoid

Use one of the following options to edit the macros:

- Option 1:
  1. Copy the user-defined macro code.
  2. Copy the Teamcenter macro code from any standard templates to the user-defined template VBA macro section.
  3. Merge the contents of the user-defined macro code and the Teamcenter macro code so that there is no loss of Teamcenter macro code.
  4. Save the macro and template.

- Option 2:
  1. Create an item of an **ExcelTemplate** type.
     This creates and attaches a standard template to the newly-created Excel template.
  2. Edit this template macro code to add the user-defined macro code so there is no loss of Teamcenter macro code.
  3. Save the macro and template.
• **Support for localized column names in Excel**

   (First published Teamcenter 9.1)

   The localized versions of property names are obtained from the
   `TC_ROOT\lang\textserver\en_US\system_property_names_locale.xml` file.

   If you want to use the Business Modeler IDE to define display names of properties instead of the `textserver` files, Excel should also show the display names from the Business Modeler IDE.

   **How to work around or avoid**

   Use the Business Modeler IDE to localize the display name for the properties. As a prerequisite, ensure that the display name for the property is specified in the Business Modeler IDE and that localization changes are deployed in the database.

   Export to Excel now supports localized column names in the header. When you export a group of objects to Excel, the generated sheet has localized column names in the header part of the generated sheet. This feature is supported for both Export all visible columns and Export using a template export options. In the case of the Export all visible columns option, the column header now contains localized names for the properties. In the case of the Export using an Excel template option, you should add a particular format to the template. In an Excel template, contents above the `<start>` tag are considered header information. You should specify the following format in the Excel template:

   
   ```
   {%TYPE.PROPERTY_NAME}
   ```

   **TYPE** is the real type name of the business object, and **PROPERTY_NAME** is the real name of the property.

   If the property is inherited and the display name is defined on the parent, you must define the following `TC_ENABLE_PROPERTY_FROM_L10N` environment variable at the server in the `tc_profile_vars` file:

   ```
   set TC_ENABLE_PROPERTY_FROM_L10N=0
   ```

   If this environment variable is defined, the display names are fetched from the parent. If you specify the new `{%TYPE.PROPERTY_NAME}` format, the display name is queried from the Business Modeler IDE. You should ensure that the property has the proper display name in the Business Modeler IDE.

   Therefore, the generated Excel sheet now supports localized column names in the header.

   The old `{%PROPERTY_NAME}` format in the header is not yet deprecated from the Excel template. This format obtains the display name from the `textserver` localization files at the server installation. This approach is no longer recommended because the `textserver` mechanism will be deprecated in the future.

   Siemens PLM Software recommends that you use the Business Modeler IDE to localize the display name for the properties.

• **Display name incorrect in Structure Pane in Microsoft Word**
(First published Teamcenter 9.1)

When you export a requirement structure to Microsoft Word for structure editing, Word displays the structure tree (called the **Structure Pane**). The display of nodes is not consistent with the display name of the object. While this may not affect any functionality, you can overlook some information such as the revision name and other values.

**How to work around or avoid**

To make the node display name in the Microsoft Word **Structure Pane** consistent with the Systems Engineering window in the rich client, set the **Word_Show_Display_Name** preference to **true**. This uses the **DisplayName** constant from the Business Modeler IDE to get the name and display it.

The default value of the **Word_Show_Display_Name** preference is **false**.

- **Embedded Word window is not usable in the 64-bit rich client**
  
  (First published Teamcenter 9.1)

  When working with the 64-bit version of the rich client and the 32-bit version of Microsoft Office Word, the embedded Word window does not work.

  **How to work around or avoid**

  Use the 64-bit version of Microsoft Office Word to enable the embedded Word window for the 64-bit rich client.

- **Teamcenter to Excel integration on 64-bit machines requires 64-bit .NET framework**
  
  (First published Teamcenter 9.1)

  Live Excel fails to open objects in Excel in the 64-bit rich client.

  **How to work around or avoid**

  Install the 64-bit .NET framework to work with the 64-bit rich client to Excel integration.

  For the Teamcenter to Excel integration, previously the Java2COM (neva-based utility) was used to generate a wrapper over the COM applauncher component (used to launch Excel and communicate data over a socket service). It is replaced by a SWT-based wrapper which has a platform-independent (32-bit and 64-bit) COM DLL file. A separate applauncher for the 64-bit platform is registered using the 64-bit .NET framework tool.

  For supported versions of the .NET framework, see the [hardware and software certifications](#) page on GTAC.

- **Import using keyword matches only the whole word**
  
  (First published Teamcenter 9.1)

  When keyword parsing is used during import, some instances of the keyword are not found.

  **How to work around or avoid**

  Beginning in Teamcenter 9.0, importing using a keyword matches the whole word. Variations of the keyword are not processed.

  For example, if you type the keyword **item**, then **item’s** is not recognized as a keyword.
• **REQ_create_object_template is not available**
  (First published Teamcenter 9.1)

  The **REQ_create_object_template** was available in Teamcenter 9.0, but it is not available beginning in Teamcenter 9.1.

  **How to work around or avoid**

  Create the template using the **add_dm_template** utility.

• **Update of flat file dataset during Revise operation**
  (First published Teamcenter 10)

  Import a flat file with a few objects, open the dataset from Teamcenter, update the document by adding a few more objects, and then import again with the **Revise** command. After the import is complete, check the dataset attached to **Rev/A** from Teamcenter. The expected result is that the data set should not be updated with newly added objects.

  **How to work around or avoid**

  By framework design, when the dataset is opened by double-clicking and the file is closed after modification, rich client always updates files in the volume. To work with flat file import, you should never directly open the dataset and update the flat file. Save the flat file locally before making any changes to prevent overwriting the previous file version in the volume after the revision.

• **Assigning an ID does not work when a cell in Excel is in edit mode**
  (First published Teamcenter 9.1)

  When you attempt to assign an ID in a Microsoft Office Excel 2003/2007 workbook using the Teamcenter Flat File Import Addin for Excel, the assign ID dialog box appears, but the ID is not assigned to the cell when you click **OK**. This occurs only when you click the **Assign ID** button and the cell is in edit mode, for example, when you press F2 to edit the cell, or double-click the cell to type the contents.

  This applies to:
  
  o Microsoft Office Excel 2003
  
  o Microsoft Office Excel 2007
  
  o Teamcenter Flat File Import Addin for Excel

  **How to work around or avoid**

  Exit the edit mode by using the escape key and then click the **Assign ID** button. To see if you are in edit mode in Excel, see the toolbar button for **New/Open/Undo/Redo**. If the button is disabled, then you are in edit mode.

  This behavior is by design. Microsoft Excel 2003/2007 disables all other actions while the cell is in edit mode, such as setting the cell value programmatically. The Excel data model also does not raise any event or provide an API to query if the cell is in edit mode. Certain functions are available only when cell is not in edit mode, such as go-to, macro editing, and search. The same principle applies to setting the cell value programmatically.

• **Excel sheet cannot be connected using direct server connectivity mode**
(First published Teamcenter 9.1)

When an Excel sheet is generated through the Work offline and Import option on the Export To Excel dialog box, it cannot be connected using the direct server connectivity mode in Teamcenter Extensions for Office or in the rich client by choosing the Tools—Open Live Excel command.

How to work around or avoid

To connect a sheet generated through the Work offline and Import option, install Client for Office and use the Excel import feature.

An Excel sheet generated using either the Live Integration with Excel (Interactive) or Live Integration with Excel (Bulk Mode) option on the Export To Excel dialog box are connected using direct server connectivity mode of Teamcenter Extensions for Office or in the rich client by choosing the Tools—Open Live Excel option.

• Client for Office does not show updated values

(First published Teamcenter 9.1)

When you perform the following steps, Microsoft Office Word displays old values:

1. Export a Word document from the rich client to Client for Office.
2. Modify the Word document in Client for Office and save it to Teamcenter.
3. Export the Word document from the rich client again without doing a refresh.
   The Word document shows the old values prior to the modification.

How to work around or avoid

Configure the SharedSession feature in Client for Office. This feature enables Client for Office to share the same Teamcenter server that the rich client uses. To set it up, open the Client for Office TcWordAddin.dll.config configuration file and set the SharedSession option to true.

After configuration, follow these steps to verify proper operation:

1. Log on to the rich client.
2. Log on to Client for Office using the same user ID, group, and role as specified in rich client logon dialog box. Teamcenter automatically connects Client for Office to the rich client server session.

Note

Even though the rich client and Client for Office share the same server, the rich client does not automatically show the changed value from Client for Office. But, when you perform another operation on the object, the values are picked from the server.

• Embedded Word window with the 64-bit rich client

(First published Teamcenter 9.1)

The embedded Word window on a 64-bit rich client is supported only with the 64-bit version of Microsoft Word.
How to work around or avoid
Install the 64-bit version of Microsoft Word with a 64-bit rich client.

- Visio creates a duplicate interface
  (First published Teamcenter 9.1)
  In an existing Visio diagram, if you create a connection between two interfaces such that the connection starts and ends from the point at which the interface is attached to the function, a duplicate interface may get created.
  How to work around or avoid
  Always attach the connection to the interface points on the interface boundaries. The connection to the interface point and the interface to the function point should not be the same.

- Exporting markup on remote site
  (First published Teamcenter 9.0)
  Markups associated with specification items do not get exported on a remote site.
  How to work around or avoid
  Perform the following steps to include markups when exporting a specification:
  1. Click the Display/Set remote export options button at the bottom of the Remote Export dialog box.
  2. In the Remote Export Options dialog box, click the Advanced tab.
  3. Double-click Markup(s) in the Exclude Reference list.
  4. Ensure Markup(s) is included in the Include Reference list.
  5. Click OK.

- Secondary objects of trace links must be transferred manually
  (First published Teamcenter 9.0)
  If you transfer a structure to another site using Change Viewer and if that structure has trace links to occurrences, the secondary object of the trace link is always transferred as a stub if the other end of the trace link is also an occurrence. Even if you include the Tracelink option in the included list and the Export Entire BOM option is also set to true, the secondary object of the trace link is transferred as a stub only.
  How to work around or avoid
  You must transfer the structure at other end of trace link manually.

- Blank column in Traceability report
  (First published Teamcenter 9.0)
  In the traceability report, if the same child occurs more than once under the same root, only one of them is visible.
  This is due to an issue with the Eclipse JTree, which does not show duplicate elements in a tree.
How to work around or avoid

1. If there are duplicate elements, a blank value is shown in first column, but all commands in the traceability report continue to work on the selected line or row.

2. If you want to see the element in the blank cell, click the Show Tracelink button in the report.

- LOVs are not supported by Microsoft Excel Import

  (First published Teamcenter 9.0)

Microsoft Excel Import supports only single value (basic data type) LOVs. Only string and numeric LOVs are supported.

The following LOVs are not supported by Excel Import:

  o Interdependent or cascading LOVs
  o Multichoice LOVs
  o LOVs mapping to references types
  o Any LOV that has run-time or calculated data

How to work around or avoid

Currently, there is no workaround for this problem. Excel Import, by design, does not support LOVs. Single choice LOVs work because they do not require anything other than simple property setting.

- Export to Microsoft Excel exports the trace links for the topline only

  (First published Teamcenter 9.0)

If you select the topline and export it to Microsoft Excel, only the trace links created in the context of topline are exported to Excel.

For example, in the following structure, if you create a trace link between Bolt and Wheel in the context of Car, and then you select Car and export it to Excel, the trace link between Bolt and Wheel is exported to Excel. However, if you create a trace link between Bolt and Wheel in the context of Axle, that trace link is not exported to Excel if Axle is not the topline of the BOMWindow object.

Car
  Axle
    Bolt
    Wheel

How to work around or avoid

You must open the Axle assembly where Axle is the topline. You can then export the trace link between Bolt and Wheel.

- List of dataset types supported for the copy reference feature

  (First published Teamcenter 9.0)
The **Copy Reference** action is enabled on all business objects.

*How to work around or avoid*

The copy reference feature is supported for **BMP**, **Image**, **Jpeg**, **GIF**, **TIF** types of image datasets. From the Teamcenter user interface, the **Copy Reference** action is enabled for **BMP**, **Image**, **Jpeg**, **GIF**, **TIF** types of datasets.

- ** Newly created budget Excel template does not show up in New Budget Definition dialog box**

  (First published Teamcenter 9.0)

  A newly created budget Excel template is not displayed in the **New Budget Definition** dialog box. Once LOV values are loaded, the values are cached in the rich client session. You must restart the rich client session to see newly created budget templates in the LOV.

  *How to work around or avoid*

  Restart the rich client session to see newly created budget templates in the LOV on **New Budget Definition** dialog box.

- ** Trace link symbol removed on workspace objects to reduce client-server traffic**

  (First published Teamcenter 9.0)

  The trace link icon is not available on workspace objects in Teamcenter 12. Previously, the trace link symbol on workspace objects indicated a trace link was present on the object. This symbol has been removed to reduce traffic between Teamcenter clients and servers.

  *How to work around or avoid*

  To find whether a trace link exists on a workspace object, add the **Has Tracelink** column in the details panel for each workspace object in the details pane. This column displays a value of **Y** or **N** to indicate whether a trace link exists on the object.

- ** Systems Engineering and Requirements Management disables autosave for Word documents**

  (First published Teamcenter 9.0)

  The autorecovery feature in Microsoft Word opens the **Save** dialog box unexpectedly for requirement documents.

  *How to work around or avoid*

  The autosave feature is disabled for Word documents when you open a requirement document. The Systems Engineering and Requirements Management add-in disables the autosave feature of Microsoft Word when you open a requirement document and it re-enables the autosave feature (if it was enabled previously) when you close the requirement document.

- ** New icon in Requirements Management integration in Microsoft Word**

  (First published Teamcenter 9.0)

  An icon has been added for duplicate objects exported from Systems Engineering to Microsoft Word. This icon is not documented in Teamcenter online help.
In addition, a visual indication has been added for dirty nodes in the task pane in Microsoft Word. This indicator is also not documented in Teamcenter online help.

**How to work around or avoid**

The icon for duplicate objects exported from Systems Engineering to Microsoft Word is shown in the task pane that shows requirement structure. Also, if you modify any structure or property in Microsoft Word, a red asterisk (*) is displayed next to the object in the task pane to indicate a dirty node.

- **Refresh window action does not work for multiple views**
  
  (First published Teamcenter 8.3i)
  
  If two users work concurrently on a single object, and the first user updates the object, when the second user has two views open (for example, the *Systems Engineering* view and the *Details* view) and refreshes the *Systems Engineering* view, the contents are not refreshed in the *Details* view.

  **How to work around or avoid**

  The user must explicitly refresh both views by pressing the F5 key.

- **Removal of Teamcenter macro code from the standard templates**
  
  (First published Teamcenter 8.3i)
  
  If you have Microsoft Office 2010 installed and you export to Microsoft Excel, an error message is displayed stating that the digital signature is broken and you are unable to log on to Teamcenter with Office.

  The Teamcenter macro code is removed from all the standard templates. When you export using standard templates, there is no macro code in the generated sheet. The generated sheet contains the following header:

  "Live" edit on this spreadsheet requires Teamcenter Extensions for Microsoft Office

  However, any custom macro from the template is preserved in the generated sheet.

  **How to work around or avoid**

  Perform the following on standard Excel templates after upgrading to Teamcenter 8.3i:

  1. Search for the standard item in the following My Teamcenter templates and delete it:

     MFG_default_struct_template
     REQ_default_excel_template
     REQ_default_rel_export_template
     REQ_default_RM_template
     REQ_default_struct_template
     REQ_defview_template

  2. Run the **add_reqTemplates** utility.

    This utility installs the new Excel templates to the database.
3. Perform the following steps for the custom templates:
   a. Open a custom template and press Alt-F11. If the custom template does not have any custom macros, delete the Teamcenter macro code and save the macro and template.
      If the custom template has any custom macros, delete only the Teamcenter macro code. Do not delete the custom macro code and save the macro and template.
   b. Repeat this step for all the custom templates. The custom macro code is preserved in the Excel sheet that is generated at the server.

   - **Custom templates must be changed manually to export Systems Engineering BOM lines**
     (First published Teamcenter 8.3i)

     There are fundamental changes in Systems Engineering. The **BOMLine** type is now named **RequirementBOMLine**. So the real type in the database is changed to **Fnd0RequirementBOMLine**. The standard template that had the old **BOMLine** type is therefore changed to **Fnd0RequirementBOMLine**. Due to this change, when you export the run-time objects from Systems Engineering, no objects are exported in the Excel sheet because it does not match any rule in the template. The underlying type name is now changed and the template only works with the real database names.

     **How to work around or avoid**

     The standard **REQ_default_RM_template** template is modified to reflect the real **Fnd0RequirementBOMLine** type name. This change is required so that users can continue to use the standard template when exporting from Systems Engineering. If you export from Systems Engineering, all the custom templates that have the type specified as **BOMLine** must be changed to **Fnd0RequirementBOMLine**. You may also need to change the closure rule clause that specified the old **BOMLine** type.

     This template now has the ability to export **BOMLine** objects and **RequirementBOMLine** objects. If you need any other type of lines, edit the template and specify the real type name in the template.

     If you are upgrading from a previous baseline, follow these steps:

     1. Log on to the rich client and delete the **REQ_default_RM_template** item.
     2. Open the command prompt on the server.
     3. Run the following utility from the server prompt:

        ```
        add_req_templates -u=user-name -p=password -g=group
        ```

        This utility installs the new standard template, and you can start working with this template to export run-time objects from Systems Engineering.

   - **Problem importing large documents in Systems Engineering**
(First published Teamcenter 8.3i)

Importing large documents in Systems Engineering causes server time-out issues. This is specific to an environment where the .NET Web tier (middle tier) is installed.

**How to work around or avoid**

This is a .NET middle tier configuration issue. Browse to the middle tier installation directory. In the Web.config file, modify the `executionTimeout` setting to a higher value. The default is set to 600 seconds (10 minutes). Change it to 7200 as follows:

```xml
<-- This is used to change the default http connection timeout(90seconds) to 600 secs and to change the default maxRequestLength (4MB) to 128MB = 131072 KB -->
<httpRuntime executionTimeout="7200"maxRequestLength="131072"/>
```

Clear the cache, restart the IIS server, the Teamcenter server, and the client.

**Parametric values of attached notes are not shown in the Microsoft Word viewer**

(First published Teamcenter 8.3i)

When you select a parametric note and launch the Microsoft Word viewer, the viewer shows the contents of the selected parametric note in My Teamcenter or Systems Engineering. If you select any other SpecElement revision, the viewer does not show contents of the new selection. The status at the bottom of the rich client shows Ready indicating that the change has not been noted.

**How to work around or avoid**

Before switching to the next selection to display the contents in the Microsoft Word viewer, you must click the Home tab of the My Teamcenter perspective (or the View tab in the Systems Engineering perspective). Then if you change the selection, the contents of changed selection is updated in the Microsoft Word viewer.

**Excel does not automatically refresh non-Workspace object properties**

(First published Teamcenter 8.3)

The rich client does not perform component change events for non-Workspace object property changes. For example, when a user tries to modify the Geography property on the User object (which is a non-Workspace object), the rich client does not fire the component change event to inform Excel about the property change. As a result, Excel does not automatically refresh the property value.

**How to work around or avoid**

Perform a manual refresh in Excel. Perform a manual refresh in scenarios where non-Workspace objects and their properties are involved.

**Importing requirement specifications with SpecElement subtypes that have required attributes**

(First published Teamcenter 8.3)

When importing a requirement specification with a subtype that has required attributes that are null or without initial values, the requirement structure is created in Systems Engineering as expected. However, the new objects’ required attributes remain empty because the import
process does not set values for those attributes. This results in problems when objects are moved or copied within the imported structure and when their properties are updated using live Excel.

*How to work around or avoid*

Define the initial values for all required attributes of subtypes in the Business Modeler IDE and deploy before the import. Otherwise, you must set the required attributes from the properties panel for each object.

- **Microsoft Office 2010 security settings**
  
  (First published Teamcenter 8.3)

  Microsoft Office 2010 has a different user interface than Microsoft Office 2007 for enabling active content security settings. You must be aware of this user interface or the live Excel add-in may not work correctly in the secure environment.

  *How to work around or avoid*

  1. In Microsoft Office 2010, select the following security option in the Trust Settings→Addin tab:

     **Require Application Add-ins to be signed by Trusted Publisher**

  2. Open a live Teamcenter sheet.

     The following message is displayed:

     *Security Warning: Some active content has been disabled.*

     *Click for more details. Button[Enable Content]*

  3. Click the link in the **Some active** sentence and click the **Enable Content** button.

     An **Advanced Options** menu is displayed.

  4. Click **Advanced Options** and select the following options:

     o **Add-in: TcO2k7Addin. Connect Friendly Name**

     o **Enable all code published by this publisher**

  5. Click **OK** and close Excel.

     After you open the sheet again, the live Excel add-in behaves normally.

   **Note**

   To enable this option in Microsoft Office 2010, it is a three-step process. This option is buried deep in the user interface, so it makes it difficult for the user to enable this option.

- **Cascading LOVs are not supported in live Excel and live Word**

  (First published Teamcenter 8)

  Cascading lists of values (LOVs), including hierarchical and interdependent LOVs, cannot be edited in live Excel or live Word.
How to work around or avoid
Currently, users must use the rich client to edit these properties.

• Multichoice properties are not supported in live Word
  (First published Teamcenter 8)
  Editing of multichoice property values is not supported from the embedded live Word using the keyword mechanism.
  How to work around or avoid
  Currently, users must use the rich client to edit these properties.

• Reference designators cannot be imported in packed format
  (First published Teamcenter 2007 MP4)
  Properties, such as Find No, that need a unique value cannot be set on a packed BOM line. Microsoft Excel Import prevents you from updating the property on packed reference designators.
  How to work around or avoid
  Unpack the BOM line and set a unique value on each occurrence. To update the property on packed reference designators, unpack the rows in Excel before importing.

• Duplicate reference designators created during import
  (First published Teamcenter 2007 MP4)
  Duplicate reference designator values are imported when the default value is provided in the control file. If you enter default values for the reference designator columns, a warning is displayed about duplicate reference designators.
  How to work around or avoid
  Do not give default values for reference designators in the control file.

Vendor management
The following release notes pertain to usage of vendor management functionality.

• Multi-Site support for vendor management objects
  (First published Teamcenter 8.3)
  Not all objects from the vendormanagement template have Multi-Site support.
  How to work around or avoid
  Only the following objects in the vendormanagement template have Multi-Site support:
  
  - Vendor without vendor role
  - Vendor with vendor role
  - Vendor with commercial part
  - Vendor with vendor part
  - Vendor with commercial part or vendor part
  - Commercial part without vendor part
Vendor part with commercial part
Vendor part with vendor
Commercial part with preferred vendor parts

**Teamcenter Integration Framework**

The following release notes pertain to usage of Teamcenter Integration Framework.

- **Update of the Active MQ Port via TEM does not work**
  (First published Teamcenter 12)

  Using TEM to change the Active MQ Port from the default port number during install does not work. This includes the case when the port is already in use and TEM automatically updates the port number.

  *How to work around or avoid*

  Use the default port **61616** for the Active MQ Port. Or update the property "activemq.port" in \$TcIF-install-location/tcif/container/etc/system.properties.

- **PMM sync warning message in rich client**
  (First published Teamcenter 12)

  The following warning message appears in the Teamcenter rich client during PMM sync:

  > The initial action was successful, but a subsequent task in the workflow may have failed.

  *How to work around or avoid*

  If the action completes successfully, ignore the warning message.

- **Error in rich client during offline briefcase import**
  (First published Teamcenter 12)

  The following error message appears in the rich client during import of a briefcase into Teamcenter from an unmanaged site:

  > Error while invoking global services (import_from_briefcase) method.

  *How to work around or avoid*

  The briefcase import process completes successfully, so the error message box can be ignored.

- **Problems restarting Teamcenter Integration Framework after a shutdown**
  (First published Teamcenter 12)

  Teamcenter Integration Framework relies on operating system-provided socket services for sub-process life cycle coordination, for example, to shut down support processes when the main Teamcenter Integration Framework process is stopped. Under some specific circumstances, clustered Windows deployments have been observed suffering from QoS issues with these OS provided services, resulting in a noticeable delay between termination of main Teamcenter Integration Framework process and final termination of all its sub processes. This may result
in startup problems if Teamcenter Integration Framework is immediately restarted following a shutdown.

How to work around or avoid
If encountering this problem, wait several minutes prior to restarting a Teamcenter Integration Framework instance. If encountering an unclean Teamcenter Integration Framework restart after issuing 'cluster:refresh' (which results in an instant restart), shut it down and wait before manually restarting it.

• Solaris 10 is no longer supported in Teamcenter Integration Framework 3.1.
(First published Teamcenter 12)
Solaris 10 is no longer supported in Teamcenter Integration Framework 3.1.
How to work around or avoid
Use Solaris 11 or another supported OS.

• Single instance of Teamcenter Integration Framework on an Oracle Solaris operating system might result in data transfer errors
(First published Teamcenter 12)
On a host computer with an Oracle Solaris operating system, if you have configured a single instance of Teamcenter Integration Framework 3.1 for both Supplier Collaboration and Substance Compliance, data transfers result in errors.

How to work around or avoid
Configure two separate instances of Teamcenter Integration Framework for Supplier Collaboration and Substance Compliance. You can also use a host computer with a Windows or Linux operating system to configure Supplier Collaboration and Substance Compliance on the same Teamcenter Integration Framework instance.

• Errors during Teamcenter Integration Framework upgrade
(First published Teamcenter 12)
Stack traces in the tcesb.log file may occur during an upgrade or patch from Teamcenter Integration Framework 3.0 to 3.1 or later. The stack traces may report the following issues:

  o Unable to resolve class com.teamcenter.esb.internal.datastore.ESBDataStore.DataStoreListener
  o Unable to resolve class com.teamcenter.esb.internal.commons.util.IOUtil
  o Cannot find matching method com.teamcenter.esb.internal.datastore.PathUtil#getObjectPaths(java.lang.String, service.dataStore.Update$1, boolean, com.teamcenter.esb.internal.datastore.ESBDataStore)

How to work around or avoid
No workaround necessary. The errors are not harmful and do not affect updates from Teamcenter Integration Framework 3.0 to current versions of Teamcenter Integration Framework.

**Visualization Illustration**

The following release note pertains to the use of Visualization Illustration.

- **TcPublishing page assets must be on a single page in the work instruction**
  (First published Teamcenter 8.3)
  The information that Visualization Illustration requires to support asset updates may be compromised if the assets are not on the visible page when the work instruction is saved.

  **How to work around or avoid**

  Define all assets on a single page (page 1) and always have that page visible when saving the work instruction.

- **Portfolio page list update does not reflect modular variant configurations**
  (First published Teamcenter Engineering 2005 SR1)
  When a structure that is configured with modular variants is used to generate a list of pages in a portfolio, unconfigured pages can appear when the portfolio is updated.

  **How to work around or avoid**

  Use classic variants to configure structures, or cut the unwanted pages from the portfolio after updating.

**Workflow**

The following release notes pertain to Workflow.

- **The new task count for Remote Inbox is not updated when user receives a task at the remote site**
  (First published Teamcenter 12)
  When you receive a new task at the remote site, the new task count is shown on the Remote Inbox link at the local site does not get updated.

  **How to work around or avoid**

  If you click on the Remote Inbox link and launch the client to log in to the remote site, then the task is displayed.

- **Sub-Workflow process inherits parent Workflow process’ Abort action**
  (First published Teamcenter 12)
  When a parent process is aborted, all sub-processes (dependent and independent) are aborted as well. There is no configuration available to avoid abort of the independent sub-processes.

  **How to work around or avoid**
A new `WRKFLW_skip_abort_on_sub_process` preference has been introduced to control which sub-processes are aborted when a parent process is aborted. This preference is honored only for independent sub-processes. By default (pref value = false), all sub-processes are aborted when parent process is aborted. If the preference is set to `true`, then the independent sub-processes are not aborted. Dependent sub-processes are still aborted. Ensure that the new preference is imported in your environment in order to utilize the new behavior.

- **EPM-set-property workflow handler cannot set properties that have no property set methods**

(First published Teamcenter 8 MP1)

The **EPM-set-property** workflow action handler cannot set a property if a property set method does not exist for it. Some run-time properties do not have property set methods.

For example, dynamic participants runtime properties do not have property set methods, so you cannot use the **EPM-set-property** handler to set them.

*How to work around or avoid*

Use Teamcenter core functionality to set properties as required or add a property set method for the given runtime property. If you create a custom property, you should create a property set method and a property get method for it.

If you add a property set method, you can use the **EPM-set-property** handler to set the property.
Chapter 5: Administration release notes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General administration</td>
<td>5-1</td>
</tr>
<tr>
<td>Dispatcher administration release notes</td>
<td>5-4</td>
</tr>
<tr>
<td>Integrated Product Definition</td>
<td>5-6</td>
</tr>
<tr>
<td>Organization</td>
<td>5-6</td>
</tr>
<tr>
<td>Security Services</td>
<td>5-7</td>
</tr>
<tr>
<td>Server Manager</td>
<td>5-8</td>
</tr>
<tr>
<td>Site Consolidation</td>
<td>5-10</td>
</tr>
<tr>
<td>Subscription Administration</td>
<td>5-10</td>
</tr>
<tr>
<td>Utilities</td>
<td>5-10</td>
</tr>
</tbody>
</table>
Chapter 5: Administration release notes

General administration

The following general release notes pertain to the administration of Teamcenter.

- **Server reassignment message**
  
  (First published Teamcenter 12)

  The `TCSession_ServerReassignment_SupportedApplIds` preference is used to control automatic reassignment of a server. If an application plugin is loaded when the server is no longer connected, and the loaded application is listed in the preference, then the server is automatically reassigned.

  *How to work around or avoid*

  If the application ID is not listed in the preference and the bundle is loaded, Teamcenter displays a message to log off and log back on.

- **Observation Characteristics' Last Value not Displaying**
  
  (First published Teamcenter 12)

  The "Last Numeric Value" column in the Show Utilization view, which displays the last value of Observation Characteristics, is not displaying correctly. Other characteristics are unaffected. Missing value can be found in properties window of characteristic's row in Show Utilization.

  *How to work around or avoid*

  To find the missing table value of a given role, perform the following steps:

  1. Refresh Show Utilization either by bringing up the view fresh or switching between tabs in Service Editor.

  2. Right click on row of Observation Characteristic in question

  3. Select "View Properties"

  4. Value will be under "Last Value"

- **"Precise" entry removed from Where Used search**
  
  (First published Teamcenter 12)

  The "Precise" entry option is removed from the Rule combination box that configures Where Used searches. This hard-coded option is no longer required as the Where Used algorithm is redesigned to provide correct results with a rule that contains only a precise entry.

  *How to work around or avoid*

  Customers should now use the "Precise Only" entry option to achieve the desired results. This entry is obtained from the default revision rule.
• **Ensure that Oracle statistics are current**

(First published Teamcenter 12)

Patching or upgrading a Teamcenter environment, with an Oracle database, can leave tables without statistics or with outdated statistics. This can result in performance problems.

*How to work around or avoid*

After every upgrade or patch to an environment using the Oracle database, the customer must collect optimizer statistics. Either of the following two commands can be used to collect statics. The first command collects statistics faster and with nearly the accuracy of the second command.

```sql
exec dbms_stats.gather_schema_stats(ownname=>'infodba',
estimate_percent=>DBMS_STATS.AUTO_SAMPLE_SIZE, method_opt=>
'FOR ALL COLUMNS SIZE AUTO', degree=>DBMS_STATS.AUTO_DEGREE,
cascade=>true, no_invalidate=>FALSE);
```

If there is any possibility of performance issues the customer should collect statistics at 100 percent.

```sql
exec dbms_stats.gather_schema_stats(ownname=>'infodba',
estimate_percent=>100, method_opt=>'FOR ALL COLUMNS SIZE AUTO',
degree=>DBMS_STATS.AUTO_DEGREE, cascade=>true, no_invalidate=>FALSE);
```

Before filing a problem report (PR) associated with a performance issue, the performance issue must be recreated against tables having statistics gathered at 100 percent.

• **Cannot start TCCS**

(First published Teamcenter 11.2)

The Teamcenter 11.2 TCCS standalone installer does not check or notify the user that the Microsoft Visual C++ 2013 Redistributable is a prerequisite.

*How to work around or avoid*

Before running the TCCS standalone installer, install the Microsoft Visual C++ 2013 Redistributable package.

• **Missing parentfsc element**

(First published Teamcenter 11.2)

The parentfsc element is missing from the fcc.xml file after adding a second TCCS configuration using the TCCS installer. The issue can be seen if you launch the Change Teamcenter client communication system Installation executable and select Repair Product. In maintenance mode, click Modify FCC parent settings, click Next, and add one more configuration. After the installation completes, the FSC parents information is deleted from the fcc.xml file.

*How to work around or avoid*

Perform one of the following:

- Add the missing FSC parent information manually to the fcc.xml file:
  ```xml
  <parentfsc
  address="http://host-ID:port/" priority="0" transport="lan"/>
  ```
Start the installer in maintenance mode, select Modify FCC Parent settings and click Next, and add the parent FSC information back and start the installation. This adds the missing FSC parent information to the fcc.xml file.

- **Tuning the Linux TC_DATA/linuxpreload.config file**

(First published Teamcenter 11.2)

The GNU C Library (glibc) 2.12 and later has a very large impact for calls to the dlopen function if the library being loaded is linked directly or indirectly to large numbers of the core Teamcenter libraries. The glibc problem is described in the following article: Sourceware Bugzilla - Bug 17645

RFE: Improve performance of dynamic loader for deeply nested DSO dependencies found at:

https://sourceware.org/bugzilla/show_bug.cgi?id=17645

*How to work around or avoid*

Many such libraries are demand loaded during the client calls during login. There may be other fast-loading shared libraries that do not provide a performance benefit by being configured for preload because they do not link to the core Teamcenter libraries. When there is a configuration file in TC_DATA directory named linuxpreload.config, the first call encountered to try to load libraries dynamically causes the preload configuration to initialize.

In four-tier installations, this happens during tcserver startup and the first call is from the web tier to the management infrastructure. In two-tier installations, this happens during the rich client logon call, and there is less benefit than in four-tier installations. But you still benefit from proxies explained in the previously mentioned article.

Perform a one-time-per installation procedure like the following:

1. In the TC_DATA/logger.properties file, turn on per-call logging of client calls as follows:
   
   aslogging.logger.Teamcenter.Soa.Communication=INFO

   Set to INFO to log each service request.

2. In that same file, turn on debug diagnostics used by the configured library pre-loader:
   
   logging.logger.Teamcenter.VolumeManagement.ss=DEBUG

- **Data Share Manager Over-the-Web Installer error**

(First published Teamcenter 11.2)

If a user who has not installed the Over-the-Web Installer Data Share Manager tries to use the Data Share manager while working in the rich client, the user receives a DataShareManagerError message.

*How to work around or avoid*

Each user should install the Data Share Manager with the stand-alone installer. This installs the Data Share Manager to each user's own directory, ensuring access to their own installation of the Data Share Manager.

- **Removing a project team member**

(First published Teamcenter 9.1)
Removing a user from a project where the project owns data for the user being removed proceeds without warning and removes the user. This is a known issue.

**Note**

This applies only if Aerospace and Defense Foundation template is deployed in the Teamcenter configuration.

*How to work around or avoid*

Project team administrators must make sure a user has no data that is owned by the project before they remove a user.

- **Problems with suggestive interactive hierarchical LOVs**
  (First published Teamcenter 9.1)

  For suggestive interactive lists of values (LOVs), the user can enter values in two ways:
  
  o Select the available values from the LOV list.
  
  o Type values.

  The first method works fine. The second method has some limitations. It does not work in the following cases:
  
  o The displayed value in the LOV is different from the value in the LOV.
  
  o In localized environments, the value entered by the user is used and not the translated value. The autocomplete feature does not work for suggestive interdependent hierarchical LOVs.

  *How to work around or avoid*

  Currently, there is no resolution to convert the values typed in by the user.

- **Idapsync utility crashes when the LDAP_member_list_attr preference points to parent node**
  (First published Teamcenter 2007 MP1)

  If you set the `LDAP_member_list_attr` preference to point to a node on the tree that contains a direct parent of the node being processed, it causes an infinite loop that crashes the `ldapsync` utility. For example, if a parent node has one child node and that child node uses the `LDAP_member_list_attr` preference to point back to the parent, it causes an infinite loop.

  *How to work around or avoid*

  Ensure the `LDAP_member_list_attr` preference does not point to a node that causes an infinite loop.

### Dispatcher administration release notes

The following release notes pertain to Dispatcher administration.

- **On UNIX and Linux platforms, Dispatcher Client does not work.**
On UNIX and Linux platforms, Dispatcher does not work. Dispatcher Client fails with parsing/standard error in script file `senddxdatatosupplierservice.sh`. The script file is incorrect which causes translator to fail to translate any kind of request.

**How to work around or avoid**

The content of the file `senddxdatatosupplierservice.sh` need to be updated with corrected script in installed environment.

1. **Stop Scheduler/Module/dispatcher service if it is running.**

2. **Go to installed environment Dispatcher root and edit the file senddxdatatosupplierservice.sh**

   For example, in the installed environment if dispatcher root is **DR** under **TC_ROOT**:

   ```
   TC_ROOT/DR/Module/Translators/senddxdatatosupplierservice/
   senddxdatatosupplierservice.sh
   ```

3. **Remove existing content and update the file with below content. Make sure to update TC_ROOT, TC_DATA, JRE_HOME with correct value in the installed environment.**

4. **Restart Scheduler / Module / Dispatcher client once update is done.**

```bash
#!/bin/ksh
#
# SCRIPT TO RUN SENDDXDATATOSUPPLIER
#
# Replace CHANGE_ME with correct values as shown in Example
#
# Set TC_ROOT To Directory where TeamCenter is installed
# Example set TC_ROOT=/Tc10.1.5
#
# Check if TC_DATA is valid.
export TC_ROOT=CHANGE_ME
export TC_DATA=$TC_ROOT/tcdata
export JRE_HOME=CHANGE_ME
if [[ "$1" =~ -help || -z "$1" ]]; then
    echo "Usage:
    echo "  " senddxdatatosupplierservice.sh -u="UserName" -p="Password Token"
    " -g="Group" -encrypt="true/false" -uid="Design Exchange UID"
    echo "Where"
    echo "  ARG1 User Name to login to Teamcenter."
    echo "  ARG2 Password token to login to Teamcenter."
    echo "  ARG3 User group to login to Teamcenter."
    echo "  ARG4 Specifies whether or not password is encrypted to login to Teamcenter."
    echo "  ARG5 Specifies the uid of Sc0DesignXChangeRevision"
    echo "Example"
    echo " /scratch/senddxdatatosupplierservice.sh -u=infodba -p=???? -g=dba
    -encrypt=true -uid=uid"
    return
fi
.
$TC_DATA/tc_profilevars
export arg1="$1"
export arg2="$2"
export arg3="$3"
export arg4="$4"
export arg5="$5"

$TC_ROOT/bin/srm_send_dxdata_to_supp $arg1 $arg2 $arg3 $arg4 $arg5
exitvalue=$?
exit $exitvalue
```
Integrated Product Definition

The following release notes pertain to Integrated Product Definition.

• **How to enable/disable database partitioning**
  
  (First published Teamcenter 12)
  
  Even though DB partitioning is available and working on Oracle Enterprise it requires a license at extra cost for customers.
  
  POM-revisable tables (used by 4G) use DB partitioning for historical/space/etc. data automatically during upgrade/install based on the feature availability with database.
  
  Partitioning helps query performance where large volume of historical/latest/space data is present.

  **How to work around or avoid**
  
  Partitioning license can be expensive, hence now TC install/upgrade behavior is to switch it OFF by default.
  
  Customers who decide to enable partitioning for 4G data need to:
  
  o set TC_USE_REV_PARTITIONING=Y environment variable before install/upgrade OR
  
  o Execute install -revisioning -PARTITION utility to enable/disable partitioning install -revisioning <username> <password> <group> PARTITION [REPORT] APPLY[REMOVE]
  
  o REPORT: report about classes supporting minor revisions which use tables that are not partitioned.
  
  o From Install environment console run the above command with REPORT option.
  
  o APPLY: apply database partitioning to tables of classes supporting minor revisions.
  
  o Set environment variable TC_USE_REV_PARTITIONING=Y.
  
  o From Install environment console run the above command with APPLY option.
  
  o REMOVE: remove database partitioning from tables of classes supporting minor revisions.
  
  o Set environment variable TC_USE_REV_PARTITIONING=N.
  
  o From Install environment console run the above command with REMOVE option.

Organization

The following release notes pertain to the Organization application.

• **Access rule to protect ImanType objects.**
  
  (First published Teamcenter 12)
  
  Regular Teamcenter users are able to find ImanType objects in rich client client using a saved query and are able to delete them. ImanType objects are not business objects and cannot be
deleted from rich client. They are schema objects defining the Teamcenter schema and can be created, modified and deleted using BMIDE. The updated schema will be deployed to Teamcenter.

How to work around or avoid

To avoid ImanType objects being found and deleted in rich client, an access manager rule is added out of the box. This rule will grant READ access and WRITE access to the system admin users and just READ access to the non system admin users. Rest of the privileges will be denied. This rule will be installed with new Teamcenter installs. During upgrade this rule will not be added to the rule tree automatically. Customers have to add this rule manually to their rule tree after upgrade. Below are the rule details.

Has Class( ImanType )--->TCTYPEACCESS
Where TCTYPEACCESS is the ACL. Configuration of this ACL is like this.

TCTYPEACCESS!RULETREE

Security Services

The following release notes pertain to Security Services.

Note

For additional Security Services release notes, see the Security Services Release Notes in Teamcenter 12 PDF help collection. This document describes features introduced with the latest version of Security Services. It also contains general notes and descriptions of known defects.

- **Cancel checkout removes object ACL**

  (First published Teamcenter 11.2)

  When an object ACL has been applied to an object, canceling checkout removes the object ACL.

  How to work around or avoid

  If you attempt to cancel checkout for an object containing an object ACL, you receive an error that the object must be checked in. The object ACL can be removed, and the cancel checkout can be repeated, or you can check in the object and retain the object ACL.

- **Use consistent Login Service URLs when configuring different applications for Security Services**

  (First published Teamcenter 8.3)

  If you use different but logically equivalent URLs when configuring Teamcenter applications to Security Services, the hosting Web server may assign distinct JSessionID IDs to the applications. This interferes with the capability of Security Services to host the applications within a single Security Services session. Examples of different but logically equivalent URLs are http://sv10.net.plm.eds:7001/TcSSLLogin and http://sv10:7001/TcSSLLogin.

  The symptoms of this problem are:
The following message appears in an alert window upon starting a second Teamcenter application:

```
Failed to start SSO Session Agent.
Please verify that cookies and Javascript are enabled.
Please see Java Console for more information.
```

The following appears in the Java console:

```
com.teamcenter.ss.SSOException: SSO Session agent is not available
at com.teamcenter.ss.client.login.ClientListener.<init>(Unknown Source)
at com.teamcenter.ss.client.login.applet.SSOSessionAgentApplet._start(Unknown Source)
at com.teamcenter.ss.client.login.applet.AbstractLoginApplet$1.run(Unknown Source)
```

This issue was observed with Apache Tomcat but may apply to other Web Servers.

**How to work around or avoid**

Use consistent Security Services Login Service URLs in all Teamcenter application configurations.

**• Disable the HTTP-only flag in WebLogic 10.x**

(First published Teamcenter 8.3)

Newer versions of WebLogic set the `cookie-http-only` flag by default. This flag prevents browsers from accessing cookies using client-side scripting. Security Services depends on this feature to start a viable session agent applet, so it must be disabled for deployments of the Security Services Login Service servlet.

The symptoms of this problem are:

- The following message appears in an alert window upon starting a second Teamcenter application:

```
Failed to start SSO Session Agent.
Please verify that cookies and Javascript are enabled.
Please see Java Console for more information.
```

- The following appears in the Java console:

```
com.teamcenter.ss.SSOException: SSO Session agent is not available
at com.teamcenter.ss.client.login.ClientListener.<init>(Unknown Source)
at com.teamcenter.ss.client.login.applet.SSOSessionAgentApplet._start(Unknown Source)
at com.teamcenter.ss.client.login.applet.AbstractLoginApplet$1.run(Unknown Source)
```

**How to work around or avoid**

Go to the staging directory created while running the `insweb.bat` file. In the staging directory, go to the `webapp_root\WEB-INF` directory and add a `weblogic.xml` file.

Add the following code to the `weblogic.xml` file:

```
<session-descriptor>
  <cookie-http-only>false</cookie-http-only>
</session-descriptor>
```

**Server Manager**

The following release notes pertain to server manager administration.

**• Management Console login page is not visible in IE browser.**

(First published Teamcenter 12)
The Management Console login page is not visible in IE browser.

*How to work around or avoid*

To display Management Console in IE browser, please disable the "Compatibility View" setting. For instance: In IE browser, open Tools->Compatibility View Settings, and uncheck the two checkboxes for the compatibility view. Restart IE browser and open Management Console.

- **Updating Management Console**
  
  (First published Teamcenter 12)
  
  Following TEM-based update of an existing Management Console application instance, bundles bearing older values are still retained in container's cache, resulting in undesirable runtime behavior.

  *How to work around or avoid*

  Management Console's container cache directory `container/data` must be manually cleaned out before application's first start following a TEM update.

- **JMX HTML Adapter for the Java EE Server Manager and web tier is deprecated**
  
  (First published Teamcenter 12)
  
  Support for JMX HTML Adapter for the Java EE Server Manager and web tier is deprecated in Teamcenter 11.2 and will be obsolete in a future version of Teamcenter.

  *How to work around or avoid*

  Siemens PLM Software recommends using Teamcenter Management Console to manage Java EE Server Manager and web tier.

  **Note**

  By default, Java EE Server Manager JMX HTML Adapter is disabled in Teamcenter 11.2. To enable this JMX HTML Adapter, modify the value of JMX_HTTP_ADAPTOR_PORT property in `TC_ROOT\pool_manager\confs\<conf_name>\serverPool.properties` file to an open port. Restart Java EE Server Manager after making this change.

- **.NET Server Manager could not start after Windows Update KB3102467**
  
  (First published Teamcenter 12)
  
  Windows Update KB3102467 upgrades the earlier version of .NET Framework 4.5.x to .NET Framework 4.6.1 for Windows Server 2012 R2. (https://support.microsoft.com/en-us/kb/3102467). .NET Framework 4.6 introduces a new JIT compiler called RyuJIT and enabled by default for 64-bit process. There are known issues for the .NET Framework 4.6 (KB3047761 - https://support.microsoft.com/en-us/kb/3047761). One of the issues is the RyuJIT settings caused managed applications (e.g. .NET Server Manager) to crash after installing .NET Framework 4.6. (See KB3065367: https://support.microsoft.com/en-us/kb/3065367)

  *How to work around or avoid*

Site Consolidation

The following release notes pertain to Site Consolidation.

- **Site consolidation of Schedule Manager notifications and subscriptions**
  (First published Teamcenter 8.3)
  The list of users, groups, and disciplines to be notified using Schedule Manager notifications and subscriptions is not transferred properly when using Site Consolidation.
  
  *How to work around or avoid*
  Fix the notifications manually after they are transferred.

Subscription Administration

The following release notes pertain to Subscription Administration.

- **Subscription modification fails if duplicate subscriptions exist**
  (First published Teamcenter 9.1)
  Teamcenter 9.1 does not allow modification of duplicate subscriptions that share the same subscriber, object type, and event type. This ensures consistency between creation and modification of subscriptions. If a customer site has duplicate subscriptions from a previous release, editing those subscriptions fails. However, subscriptions that do not have duplicates can be modified as before.
  
  *How to work around or avoid*
  If a customer site upgrades to Teamcenter 9.1, any duplicate subscriptions that exist for the same subscriber, object type, and event type combination should be deleted manually from the Subscription Administration dialog box so there is only one subscription left for that combination. Teamcenter then allows the modification of the subscription. However, there is no need to delete the duplicate subscriptions if they do not need to be modified.

Utilities

The following release notes pertain to utilities.

- **OAR rules that are loaded using oar_data_loader utility are not active in the Teamcenter database**
  (First published Teamcenter 12)
  When running `oar_data_loader` (Linux) and `oar_data_loader.exe` (Windows) to load default or migrated Operation Access Control rule files, none of the loaded rules are marked as active in the Teamcenter database, the rules are not active in the Teamcenter database. As a result, the database does not contain valid Operation Access Control rules.
  
  *How to work around or avoid*
  Download and apply `tc12_oar_fix.zip` to the Teamcenter environment before loading default or migrated Operation Access Control rules. The fix is composed of two files.
- `oar_active_rule_default.xsl` contains an XSLT that marks the value of `find0Active` property as true. This file should be placed in `TC_DATA` directory.

- `oar_data_loader` (Linux) and `oar_data_loader.exe` (Windows) apply the XSLT before as the rules are imported to the Teamcenter database. This file should be placed in `TC_BIN` directory.

**Handling Failure case for AM1 to AM3 migration utility**

(First published Teamcenter 12)

If `migrate_audit_data` utility export fails with below error:

```
ERROR - 2016/12/13-22:33:16.608 UTC - NoId - 1 - FAIL : Unable to parse next audit record from file. Export failed at line "Job Name 53-109917/A"
```

**How to work around or avoid**

Handling Failure case:

Export Failed Due to Unidentified Key in Legacy File: If export fails for file with error "Unable to parse next audit record from file" due to key is not found by utility than user can specify key and value in custom text file (Please refer section "Customize text and error messages" on how to add custom keys):

1. Key Should not have any spaces

2. Key should be specified with prefix value "LegacyAuditKey_<key>"

3. Identify the locale in which utility is running using `TC_language_default` and make a change in that locale of custom text file (Please refer section "Customize text and error messages" on how to add custom keys).

4. Identify key and corresponding value from the list below:

   1. Name of Job or Process(Process Name/ Job Name) k_job_name
   2. Process description(Description ) gk_description_label
   3. Name of process template or procedure(Process Template Name/ Procedure Name) k_procedure_name
   4. Owner Id of process(Owner ID / Eigentümer-ID) gk_owner_name_label
   5. Process creation date(ate Created) gk_date_created_label
   6. Process Id or Job Id(Job/ Process) Job
   7. Procedure definition file(Definition File) k_procedure_def_file

**Example:** If Export fails with below error:

```
ERROR - 2016/12/13-22:33:16.608 UTC - NoId - 1 - FAIL : Unable to parse next audit record from file. Export failed at line "Job Name 53-109917/A"
```

Perform below step to handle this:

1. Identify the key from the error. Here error is failed due to "Job Name."

2. Remove the spaces from the key: "JobName."

3. Add a prefix LegacyAuditKey_. So Now key is "LegacyAuditKey_JobName."
4. Determine a valid value for the identified key using above table is "k_job_name" as it is referring to Job/Process name.

5. Identified locale of the file using TC_language_default=en_US.

6. Add key in English version of custom file as below: <key id="LegacyauditKey_JobName">k_job_name</key>.

Note
Retain the Audit_SUCCESS_FILE_LIST.txt file because if it is deleted and running utility again in export mode, will re-export already successfully exported files.

- Corrections to the item_to_part_design utility
(First published Teamcenter 8.3i)

The item_to_part_design utility does not work due to the core data model changes beginning in Teamcenter 8.0.

How to work around or avoid

The item_to_part_design utility is modified per the new data model changes released in Teamcenter 8.3.

For more information about the utility, see the Utilities Reference.
Chapter 6: Teamcenter interfaces release notes

Rich client ................................................................. 6-1
Rich client

The following release notes pertain to the use of the rich client.

- **Tree in My Teamcenter has the wrong background color after selection or expansion on Linux**

  (First published Teamcenter 12)

  The tree in My Teamcenter has the wrong background color after selection or expansion on Linux.

  This is a known Eclipse bug.

  **How to work around or avoid**

  1. Remove the following bold line in the `rac_lightthemem.css` file (in the configuration plugin).

     ```
     Tree
     {
     color: #000000;
     background-color: #ffffff;
     swt-selection-background-color: #AFD7E1;
     swt-hot-background-color: #DAECF0;
     swt-selection-border-color: #AFD7E1;
     swt-hot-border-color: #DAECF0;
     }
     ```

     It is not necessary to regenerate the registry. Just delete all files in the rich client cache.

  2. Set the `SWT_GTK3` environment variable to 0.

- **Rich client logon errors when connecting to Key Manager enabled Teamcenter**

  (First published Teamcenter 12)

  When you log on through a two-tier rich client to a Key Manager enabled Teamcenter, the following error messages may display:

  - POM not started
  - Invalid Tag

  When you log on through a four-tier rich client to a Key Manager enabled Teamcenter, the following error messages may display:

  - Automatic authentication failed.

  **How to work around or avoid**

  In Teamcenter 12.0, Key Manager has been introduced to provide the capability to manage encryption keys in a fully secure manner in a distributed Teamcenter Site. It consists of a Key Manager satellite program routing the request to a centralized Key Manager server, which
delegates key storage and cryptography to a PKCS #11 standards-based hardware or software plugin selected and installed by the customer.

If Teamcenter is configured by the administrator to use Teamcenter Key Manager and the above errors are displayed, refer to the Teamcenter server syslog for more information. Ensure Teamcenter Key Manager is installed, configured properly, accessible, and online.

- **Favorites list shows the first object added in rich client or Active Workspace**
  (First published Teamcenter 12)

  After upgrade Favorites list shows the first object added in rich client or Active Workspace. Any new objects added to Favorites also do not show. This problem may be seen for other preferences such as HistoryList, MySearchHistory.

  **How to work around or avoid**

  The Teamcenter administrator should modify the "MyFavorites" preference definition using the rich client or **preferences_manager** utility.

  o Using rich client:
    - Launch the Edit->Options dialog.
    - Search for "MyFavorites" preference.
    - Select the result with "None" location.
    - Select "Edit" and modify the "Multiple" field from "Single" to "Multiple".
    - Select Save.

  o Using **preferences_manager** utility:
    1. Create an XML file as shown below.

       ```xml
       <?xml version="1.0" encoding="ISO-8859-1"?>
       <preferences version="10.0">
         <preference name="MyFavorites" type="String" array="true"
           disabled="false" protectionScope="User" envEnabled="false">
           <preference_description>This is an internal preference.
           </preference_description>
         </preference>
       </preferences>
       
       2. Import the file using the below command as a Teamcenter administrator.

          ```bash
          preferences_manager -u= -p= -g=dba -mode=import -scope=SITE
          -action=OVERRIDE -file=<XML file path>
          ```

- **Double click MS WordX dataset, first two named reference files are being opened**
  (First published Teamcenter 12)

  Business Modeler IDE Deploy condition:

  From Business Modeler IDE, double click to open the desired dataset, select "ToolActions" tab, add two or more references for "Open" and "Open Using" action.
Expected behavior in My Teamcenter: If you create an instance of the above dataset and attach more than two named references to it, when you double-click the dataset instance, first two named references will be opened.

MSWordX dataset is an example in OOTB environment without any Business Modeler IDE deploy. From Business Modeler IDE, open MSWordX dataset, and click "ToolActions" tab. You will notice that for "Open" and "OpenUsing" action, two values are defined: "word" and "Fnd0word". The expected behavior is: In My Teamcenter, if you create a MSWordX dataset, attach more than two named references to it; Double-click the dataset, and first two named references will be opened.

How to work around or avoid

Ignore the second word document.

- **Performance tuning for large BOM Line structures**
  (First published Teamcenter 12)

Teamcenter UI response is slow when you deal with large BOM structures in PSE, MPP or any other BOM window UI and perform multiple object selection.

How to work around or avoid

Add VM arg "-Dexpressioncache.enable=Y" to otwportal.bat, so the launch Teamcenter Rich client command will look below:

```
start Teamcenter.exe %* -vm "%JRE_HOME%\bin\javaw.exe" -vmargs
-Xmx%VM_XMX% -XX:MaxPermSize=128m -Dexpressioncache.enable=Y
-Xbootclasspath/a:"%JRE_HOME%\lib\plugin.jar";
"%JRE_HOME%\lib\deploy.jar";
"%JRE_HOME%\lib\javaws.jar" %DJIPJL_VMARG%
```

- **Oracle Bug 14398795 - ORA-7445 [evakdustoopn] on delete from table with add column optimization (Doc ID 14398795.8)**
  (First published Teamcenter 12)

Oracle Bug 14398795 can impact Teamcenter 11.2.3 and later. The act of deleting a row from a table that has a unique conditional index can fail with the following error message in the syslog

```
Deleting object from DataBase
*** EIM_check_error: parse_error_offset 0

*** EIM_check_error: code -3113
NOTE - 2016/05/17-05:07:08.357 UTC - NoId - (EIM_trans_util)
ORA-03113: end-of-file on communication channel
Process ID: 17200
Session ID: 40 Serial number: 1197
```

The following error can be seen in the Oracle trace file to confirm this particular bug has been encountered:

```
Exception [type: ACCESS_VIOLATION, UNABLE_TO_READ] [ADDR:0x6]
[PC:0x144E94DFC, evakdustoopn() 98]
DDE: Problem Key 'ORA 7445 [evakdustoopn() 98]' was flood controlled (0x2) (incident: 26610)
ORA-07445: exception encountered: core dump [evakdustoopn() 98]
```
This typically happens when deleting a TcRelation Object in Teamcenter.

**How to work around or avoid**

Perform either of the following recommended solutions:

- Apply the specific Oracle patch for your specific Oracle release and platform. See Oracle Bug 14398795 "ORA-7445 [evakdustoopn] on delete from table with add column optimization ( Doc ID 14398795.8 )" for additional details and patching information here: [https://support.oracle.com/epmos/faces/BugDisplay?id=14398795&parent=SrDetailText&sourceld=3-12709720971](https://support.oracle.com/epmos/faces/BugDisplay?id=14398795&parent=SrDetailText&sourceld=3-12709720971)

- Upgrade to Oracle 11.2.0.4 or later. Follow Oracle's recommendation for upgrading your database. Refer to the Preserving Performance Baselines and Statistics for the Source Database section of the Oracle Database 11gR2 Upgrade Companion (Version 2.80). (Article ID 785351.1, PDF available at the following URL: [https://support.oracle.com/epmos/main/downloadattachmentprocessor?attachid=785351.1:11g_UC_pdf&clickstream=no](https://support.oracle.com/epmos/main/downloadattachmentprocessor?attachid=785351.1:11g_UC_pdf&clickstream=no))

If you encounter performance issues after upgrading your database you can use the Oracle Enterprise Manager (OEM) SQL Tuning Advisor to create a new plans for SQL statements that are performing poorly. You could also consider setting the Oracle optimizer_features_enable system parameter to the last known good optimizer value. Ex: optimizer_features_enable='11.2.0.3'

- **Additional setting for using Date widget on SUSE Linux 11**
  (First published Teamcenter 12)

  When using Date widget on SUSE Linux 11, it is possible to receive the following error:

  ```
  callHost(firstDay) threw external.callJava is not a function.
  ```

  **How to work around or avoid**

  If receive the mentioned message when using Date widget on Linux, please do the following:

  1. At a shell, use which command or whereis command to find the path for `xulrunner`, for example:

     ```
     which xulrunner
     ```

     or:

     ```
     whereis xulrunner
     ```


- **Attribute becomes uneditable in Viewer tab on UNIX after LOV popup displayed**
  (First published Teamcenter 12)

  On Unix, for any Swing embedded views, after the popup window is displayed, the other fields on the same view becomes unaccessible.
For example, in My Teamcenter, select a checked out object that displays the Swing viewer in Viewer view. Go to viewer view, click on a lov property, after lov popup window is posted down, other fields on this Swing viewer are no longer editable.

Another example, in Organization perspective, select a user, after changing the default group or volumn, the other fields on the user panel are no longer editable.

*How to work around or avoid*

To work around the issue, go to another application such as file explorer or browser, etc, then come back to the rich client, those fields can be accessed again.

- **Issue in reopen saved perspective containing TCComponent View in same session**

  (First published Teamcenter 12)

  Open the My Teamcenter perspective, then:
  
  1. Open the Newstuff folder
  2. Open My Worklist.
  3. Save this new perspective: My Teamcenter New.
  4. Use the command Window/Close perspective ( or using the top right cross) to close My Teamcenter New.
  5. Don't logout, reopen the perspective with Window/Open Perspective/Other/My Teamcenter New, I obtain only the layout of the perspective.
  6. The view NewStuff becomes "Teamcenter Component" view.
  7. The view My Worklist becomes Home view.

  *How to work around or avoid*

  Exit Teamcenter, the opened views and layout are saved in client cache. Relogin, saved perspective is opened with Home, New Stuff and My Worklist. During the same session, close perspective won't save opened components in TCComponent view into client cache as memento.

- **Add date widget regional code in Teamcenter Rich Client**

  (First published Teamcenter 12)

  When running the Teamcenter rich client on operating systems with regional setting United Kingdom, the date widget calendar is not shown in same convention as the operating system calendar, and the calendar embedded in the scroll pane is hard to navigate.

  *How to work around or avoid*

  Locate site scope preference TC_Additional_Date_Region, add the operating system language/country and Jquery region code mapping. For example: user wants to add united kingdom locale for date widget, eclipse_language_country_code for united kingdom is "en_GB", jquery_region_code is "en-GB", the preference value would be en_GB=en-GB.
Then the date widget calendar will show similar calendar convention with the operating system. The preference also support other language_country code mapping. The feature will support from 11.2.3 and onwards.

• **Unable to create product views on Red Hat Linux**
  (First published Teamcenter 11.2)
  When creating product views in the Teamcenter 10.1.4 rich client on Red Hat Linux, the client user interface may hang.
  *How to work around or avoid*
  There is no known workaround at this time.

• **PDF files are not opened in the default PDF reader in UNIX/Linux rich client**
  (First published Teamcenter 11.2)
  On UNIX and Linux hosts, the rich client does not open PDF files in the default PDF viewer.
  *How to work around or avoid*
  In the rich client, save the PDF file to disk, and then open it using Adobe Reader.

• **Icons in the rich client display much smaller in high resolution monitors (3200x1800)**
  (First published Teamcenter 11.2)
  The 16x16 icons in the rich client display much smaller on high resolution monitors (3200x1800). The desktop Teamcenter shortcut icon is very small too.
  *How to work around or avoid*
  Currently, there is no workaround for this problem. This is an Eclipse platform graphics scaling issue:
  
  https://bugs.eclipse.org/bugs/show_bug.cgi?id=421383
  https://bugs.eclipse.org/bugs/show_bug.cgi?id=382972
  The problem is partially fixed in Eclipse 4.4, but the complete fix is targeted for Eclipse 4.6.

• **Layout error when navigating an object in the Relation Browser**
  (First published Teamcenter 11.2)
  When you navigate a successor or predecessor of an object in the Relation Browser perspective, sometimes an Error in applying selected layout error message is displayed and the successor or predecessor is not expanded.
  This is a Java bug related to the Timsort algorithm used by the Relation Browser layout engine. It throws the following error:
  
  `IllegalArgumentException: Comparison method violates its general contract`
  
  You can find the bug details here:
  
  
  *How to work around or avoid*
Add the following VM argument to the -vmarg section of the portal.bat file, after the -Xmx2048 -XX:MaxPermSize=512m line:

-Djava.util.Arrays.useLegacyMergeSort=true

• Default values set through the post hook for create actions are ignored
  (First published Teamcenter 9.1)
  If you customized the post create handler to set the Description property to a specific value, the File→New→Item dialog box does not save the default value. Instead, it creates an object with the value specified by the user.

  How to work around or avoid
  Register the post-action hook on the Save operation to set the appropriate value for the Description property.

• Clicking the date button does not close the calendar dialog box
  (First published Teamcenter 9.1)
  If you click the date button, the calendar dialog box appears. If you click the date button again, the calendar dialog box does not close.

  How to work around or avoid
  Click the date button twice to close the calendar dialog box.

• Unchecking the Display PDF in browser option in Adobe Reader is not supported in Teamcenter
  (First published Teamcenter 9.1)
  If you clear the Display PDF in browser checkbox in Adobe Reader, this setting is not reflected in Teamcenter.

  To observe this issue, perform the following steps:
  1. Launch Adobe Reader.
  2. Click Edit→Preferences.
  3. In the left pane of the Preferences dialog box, click Internet.
  4. Under Web Browser Options, clear the Display PDF in browser check box. Click OK.
  5. Log on to Teamcenter.
  6. Create an item.
  7. Select the item revision and attach a PDF dataset and a DirectModel dataset (.jt) file to the item revision.
  8. Select the PDF dataset and then click the Viewer tab.

    No error is displayed. The external Adobe Reader application opens.
9. Select the **DirectModel** dataset.
   No error is displayed.

10. Select the previously viewed PDF dataset and the external Acrobat Reader does not open.
    The following error is displayed:
    
    ```
    Unable to Download. The system cannot find the path specified.
    ```

This behavior persists if you change the setting in Adobe Reader because Teamcenter does not support the **Display PDF in browser** option in Adobe Reader.

**How to work around or avoid**

Keep the **Display PDF in browser** option selected in Acrobat Reader preferences to view PDF documents in the Web browser plug-in. Double-click a PDF dataset to view a PDF document in the external Acrobat Reader application.

- **Vertical scroll bar does not work**

  (First published Teamcenter 9.1)

  When you select a specific property to edit it, the vertical scroll bar does not work using the keyboard keys. This occurs when you select a property of a checked-out object such as a list or an object array in the **Summary** view, **Viewer** view, or the **Properties** dialog box. This issue sometimes occurs for Swing widgets that are embedded in the SWT widgets.

  **How to work around or avoid**

  Use the mouse to scroll the page.

- **Teamcenter running status is displayed in the system tray and/or Web browser**

  (First published Teamcenter 9.0)

  When Teamcenter is performing a time-consuming task, the window may seem nonresponsive. At these times, the status icon and status text shown in the client window may not be accurate.

  **How to work around or avoid**

  An icon is added to the system tray to indicate the running status of Teamcenter. The icon and tooltip are always available and are updated as the status changes. The icon indicates the status, and you can also click the icon and select **Status**. This invokes a window that contains detailed information about the server and client status. On operating systems that do not provide a system tray, you can view status information in a Web browser. The following table describes the system tray status icons and text.

<table>
<thead>
<tr>
<th>Server</th>
<th>Description</th>
<th>Client</th>
<th>Description</th>
<th>System tray</th>
<th>Tooltip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready icon</td>
<td>There is no current communication request between the client and server.</td>
<td>Ready icon</td>
<td>The client is responsive.</td>
<td>Ready icon</td>
<td>Teamcenter ready</td>
</tr>
<tr>
<td>Working icon</td>
<td>The client is waiting for a response from the server.</td>
<td>Ready icon</td>
<td>The client is responsive.</td>
<td>Working icon</td>
<td>Teamcenter server processing</td>
</tr>
<tr>
<td>Server</td>
<td>Description</td>
<td>Client</td>
<td>Description</td>
<td>System tray</td>
<td>Tooltip</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>----------------------</td>
<td>----------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disconnected</td>
<td>The client is not currently connected to the server.</td>
<td>Ready icon</td>
<td>The client is</td>
<td>Not ready icon</td>
<td>Teamcenter client disconnected from the server</td>
</tr>
<tr>
<td>icon</td>
<td></td>
<td></td>
<td>responsive.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready icon</td>
<td>There is no current communication request between the client and server.</td>
<td>Not ready icon</td>
<td>The client is not</td>
<td>Not ready icon</td>
<td>Teamcenter client not responding</td>
</tr>
<tr>
<td>Working icon</td>
<td>The client is waiting for a response from the server.</td>
<td>Not ready icon</td>
<td>responsive.</td>
<td></td>
<td>Teamcenter client not responding and server processing</td>
</tr>
<tr>
<td>Disconnected</td>
<td>The client is not currently connected to the server.</td>
<td>Not ready icon</td>
<td>The client is not</td>
<td>Not ready icon</td>
<td>Teamcenter client is not responding and disconnected from the server.</td>
</tr>
<tr>
<td>icon</td>
<td></td>
<td></td>
<td>responsive.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Wrong data saved while saving parameter definition objects**
  (First published Teamcenter 9.0)

When modifying the parameter definition object from the viewer or a properties page, if you reduce the number of rows or columns and then directly click the **Save** or **Save and Checkin** buttons, the client saves the wrong data.

*How to work around or avoid*

When you reduce the number of rows or columns during modification of parameter definition objects, after you enter the value, click some other area in the properties dialog before you click the **Save** or **Save and Checkin** buttons.

- **Teamcenter rich client displays ready status before completing some operations**
  (First published Teamcenter 8.3)

The rich client displays a ready status before completing some operations. For example, when opening a large assembly in Structure Manager from My Teamcenter, the ready status displays in the rich client even though the progress bar is active and the assembly is not yet displayed in Structure Manager.

*How to work around or avoid*

When these situations occur, the status is invalid and Teamcenter is still processing information. The system is still locked from the user entering any input. You must wait until control is given back from Teamcenter.

- **Avoid division character (÷)**
  (First published Teamcenter 8.2)

The division character (÷) cannot be used in the rich client when specifying names and descriptions. This character, sometimes copied from Microsoft Office documents, is actually a control character (0xF7) that is not supported by the underlying libraries that the rich client uses.

*How to work around or avoid*
Use something other than the division character when entering names and descriptions in the rich client.

- **Teamcenter rich client modal dialog boxes do not function properly on most UNIX/Linux servers**

  (First published Teamcenter 2007)

  On most UNIX/Linux systems, modal dialog boxes may be hidden behind the main application window. Because the dialog boxes are modal, no keyboard or mouse interaction is permitted with any other part of the user interface except for the modal dialog box.

  **How to work around or avoid**

  The problem occurs due to a focus issue with the window and is being followed up with Eclipse and Sun Microsystems. To work around the problem, do either of the following:

  - Close the dialog box and open it again.
  - Click another application or window and click back in the Teamcenter rich client dialog box. Changing focus and bringing it back usually corrects this problem, and you are then able to edit the text field or text area.
Chapter 7: Internationalization release notes
Chapter 7: Internationalization release notes

The following release notes pertain to the internationalization of Teamcenter.

- **Change in the customization for TextServer files (server language files)**
  
  (First published Teamcenter 12)
  
  Due to stale TextServer shared memory, structure indexing was found to be crashing from time to time.

  **How to work around or avoid**

  Starting Tc11.2.3:
  
  o The Teamcenter files emh_text.xml and tc_text.xml do not need to be modified anymore in order for new resources to be seen by the TextServer layer.
  
  o The shared memory backing store files for the TextServer layer as pointed by the environment variable TC_SHARED_MEMORY_DIR do not need to be deleted anymore. The system will always ensure that new processes are always running with the latest TextServer files.

  The addition of new TextServer resources and the modification of existing ones has been made easier. Many of the previously needed steps are no more needed, and new guidelines for customizing resources are detailed below. Note that the TDoc chapter "Customize text and error messages" will be properly updated in Tc11.3.

  Customized text and error messages can be created for display and usage in Teamcenter. This can apply to text messages (e.g. email text), other text resources (e.g. date formats) and error messages, whether they are already defined in Teamcenter (customization of existing functionalities) or created from scratch (custom functionality). Once defined and properly declared, these messages and resources are accessible through existing ITKs.

  1. Create custom text resources: Text resources can either be non-translatable (i.e. they stay the same regardless of the session language) or translatable.

     a. To create a non-translatable resource, create a file custom-name.xml, where custom-name can be anything. It is recommended (though not mandated) that the file name be unique.

     Ensure that the file is saved as us-ascii and contains the following XML prolog and root:

     ```xml
     <?xml version="1.0" encoding="us-ascii"?>
     <textsrv filename="custom-name.xml">
     <key id="my_custom_unique_key_name">my_custom_value</key>
     </textsrv>
     ```

     The key id must be unique. To ensure that, it is recommended to use a unique custom prefix.
b. To create a translatable resource, create a file custom-name.xml, where custom-name can be anything. It is recommended (though not mandated) that the file name be unique (e.g. custom-name_locale.xml). Ensure that the file is saved in the encoding of the locale it is intended for, and also contains the encoding information in its prolog. That information can be retrieved from any out-of-the-box translatable resource file.

The remaining of the file content is similar to the one for non-translatable resource files.

2. Create a custom error message:
   a. Define an error symbol in order to log an error to the system, an error number is needed. Error numbers are grouped by bases (each base is a multiple of 1000), and Siemens PLM Software recommends to use the pre-defined error base 919000, which is reserved for customers (in the ue_errors.xml file). There are 1000 available user-defined error numbers restricted to a specified error base range (e.g. from 919000 to 919999). It is recommended, however, that the custom code manipulate error symbols rather than the error codes. To this effect, a symbol that represents the custom user error can be defined in your code file or in a dedicated error header file, e.g.:

   ```
   #define UE_MY_FIRST_CUSTOM_ERROR (EMH_USER_error_base 919000)
   ```

   The emh_const.h file contains the definition of the EMH_USER_error_base symbol, and must therefore be included in the file that defines your error symbols. This minimizes upgrade issues if the range of user-defined error numbers changes.

3. Define the error message to be associated to the error symbol.
   o Create a dedicated error file (which name must end with _errors.xml) in the proper language directory.
   o Ensure that the file is saved in the encoding of the locale it is intended for, and also contains the encoding information in its prolog. That information can be retrieved from any out-of-the-box error resource file.
   o Define the error message in this file.

An example of content for a simple error file my_custom_errors.xml would be like this (for the French version):

```xml
<?xml version="1.0" encoding="ISO-8859-1" standalone="yes"?>
<textsrv filename="my_custom_errors.xml">
  <errors module="my_custom_module" error_base="919000">
    <!-- This is my parameterized error message, with parameter value "%1$". -->
    <error id="0">Ceci est mon message d'erreur paramétré, avec un paramètre de valeur "%1$".</error>
  </errors>
</textsrv>
```
4. Render the resources (messages or errors) accessible The newly created resources will become accessible to the regular Teamcenter APIs (e.g. the ones defined in emh.h and textserver.h), once the following is done:
   a. Create a directory to host all the new resources (e.g. MyCustomResourcesDirectory)
   b. Copy the non-translatable resource files to a sub-directory named no_translation (e.g. MyCustomResourcesDirectory/no_translation).
   c. Copy the translatable messages (text and error) to a sub-directory named after their language (e.g. en_US, fr_FR, ja_JP, etc.).
   d. Modify the tc_profilevars file for the environment variable TC_USER_MSG_DIR to point to this main directory (e.g. TC_USER_MSG_DIR=<path to MyCustomResourcesDirectory>).

• Export/Import of translations of compound property values is not fully functional
  (First published Teamcenter 9.1)
  When you export or import translations of compound property values, the master value is lost at the importing site. The import considers the first translation in the XML file as the master.
  You can observe this behavior by performing the following steps:
  1. Add a compound property on a business object.
  2. On the source property of the compound property, set the Localizable constant to true.
  3. Deploy the data model in both the exporting and importing sites.
  4. In the rich client, create the instances of the object where compound property is defined.
  5. Ensure that the value of compound property exists by also creating the source object.
  6. On the source property, set the translations.
  7. Export the objects using PLM XML.
  8. Use the PLM XML file created in step 7 to import the data into another site.
How to work around or avoid

Until the problem is fully resolved, do not use export or import of translations of compound property values. Instead, export the translations of source object.

Text truncated in some TEM panels in Russian locales

(First published Teamcenter 9.1)

In Russian locales, text in some panels in Teamcenter Environment Manager (TEM) is truncated because it does not fit within the TEM panel.

How to work around or avoid

Change the font sizes TEM uses for these panels. This allows the text to fit within the TEM panel.

1. Open the TC_ROOT\install\temui.properties file in a text editor.

2. Locate all instances of the following text:

   font.size=14

   Replace these with the following:

   font.size=12

   For example:

<table>
<thead>
<tr>
<th>Original text</th>
<th>Replacement text</th>
</tr>
</thead>
<tbody>
<tr>
<td>main.panel.intro.font.size=14</td>
<td>main.panel.intro.font.size=12</td>
</tr>
<tr>
<td>main.overview.list.font.size=14</td>
<td>main.overview.title.font.size=12</td>
</tr>
<tr>
<td>textpane.font.size=14</td>
<td>textpane.font.size=12</td>
</tr>
</tbody>
</table>

3. Save the changes to the temui.properties file.

4. Restart TEM.

Localized query using LOVs that have no translations does not find object

(First published Teamcenter 8.2)

When performing a search on a property that has an attached list of values (LOV), the search returns no results if the LOV has no translation, and the search locale is not the master locale.

How to work around or avoid

There are two workarounds. The first workaround is the best to follow:

- If you are not planning on providing translation for the LOV values in all locales, keep the internal value and display value the same for the LOV to avoid the issue with the query.
If the LOV value and display value are different, provide translations for all the locales. This ensures that the other locales get the same value as the master translation. See the example below.

<table>
<thead>
<tr>
<th>Locale</th>
<th>LOV value</th>
<th>LOV display name</th>
</tr>
</thead>
<tbody>
<tr>
<td>En</td>
<td>R</td>
<td>Red</td>
</tr>
<tr>
<td>Fr</td>
<td>R</td>
<td>Red</td>
</tr>
<tr>
<td>De</td>
<td>R</td>
<td>Red</td>
</tr>
<tr>
<td>En</td>
<td>B</td>
<td>Blue</td>
</tr>
<tr>
<td>Fr</td>
<td>B</td>
<td>Blue</td>
</tr>
<tr>
<td>De</td>
<td>B</td>
<td>Blue</td>
</tr>
</tbody>
</table>

**Creation dialog box hides behind the Teamcenter rich client application window**

(First published Teamcenter 9.1)

When you type Japanese characters and click the spacebar twice, the replacement characters appear in a menu. The creation dialog box hides behind the rich client application window. This problem is applicable for Japanese (hiranga) inputs and for machines that have Microsoft Office 2010 Input Method Editor (IME) installed.

*How to work around or avoid*

When dialog box hides behind the application window, click anywhere in the application window to bring the hidden dialog box to the front.

**ThinClient-GlobalOrg role does not return any users**

(First published Teamcenter 9.0)

The ThinClient-GlobalOrg populating role field does not return any users.

*How to work around or avoid*

The name attribute for a group is defined in its parent class, POM_group. Also, the name attribute is marked as Localizable in the subclass Group level, not in the POM_group level. The query uses the POM_group level for group name searches so it does not use L10N search because it is a common search.

**Note**

This is not the same as the role name. The role_name attribute is defined in Role and also marked as localizable in Role, so it is a localized search for role name.

**Warning message dialog boxes for the SaveAs operation**

(First published Teamcenter 8.2)

Due to the legacy implementation, the warning message dialog box of the SaveAs operation behaves differently for the Item and ItemRevision business objects. A SaveAs operation based on an ItemRevision business object behaves more like a Revision operation; that is, there is no way to revert back the string modified in the dialog. As a result, the warning message dialog box
only has an **Acknowledge** button. However, a **SaveAs** operation based on an **Item** business object has the option to proceed with a user response of **Yes** or **No**.

**How to work around or avoid**

When trying to perform a **SaveAs** operation on an **ItemRevision** business object, keep in mind that any modification to the **Localizable** field results in the translations being marked invalid. Do not modify the string in the localized field if you do not want the existing translation status being changed.

- **Non-English characters are not displayed correctly in a text file**
  
  *(First published Teamcenter 8)*

  Some of the characters in a text file are not displayed correctly on non-UTF-8 client connecting to a UTF-8 compliant server.

  **How to work around or avoid**

  When the server is UTF-8 and the clients are non-UTF-8 clients (for example, Japanese), text files must be edited only on a client having the same character set as the text file; otherwise, data loss can occur. Also, when these text files are not viewed on a system that does not have the same character set as the client, characters may not be correctly displayed.

- **Code page 932**
  
  *(First published Teamcenter 8)*

  Teamcenter does not support Japanese characters from code page 932 (abbreviated as CP932, also known by the IANA name Windows-31J). This is Microsoft’s extension of Shift JIS to include NEC special characters (row 13), NEC selection of IBM extensions (rows 89 to 92), and IBM extensions (rows 115 to 119). The coded character sets are JIS X0201:1997, JIS X0208:1997, and these extensions.

  **How to work around or avoid**

  Currently, there is no workaround for this problem.

- **Oracle database character set setting for corporate server installation and upgrade**
  
  *(First published Teamcenter 8)*

  Upgrade of the GM Overlay template and its dependent templates fails with error **54034** *(The list of values has duplicate values.)*

  For example, the update log may contain an error similar to the following:

  
  ```
  Delete  | TcLOVValueAttach  | Discipline LOV
  54034 | The list of values has duplicate values.
  ```

  **How to work around or avoid**

  This problem applies to the GM Overlay template and any template that contains characters that are not compatible with, or supported by, the character set (**NLS_CHARACTERSET**) in the Oracle database.

  If the GM Overlay template contains German characters, when it is deployed to a database that does not support the German character set (**WE8MSWIN1252**), German characters such as
umlauts and the double s (ß) are stored as different characters in the database. This causes the Business Modeler IDE comparator to generate an incorrect delta file.

By default, when an Oracle database instance is created, it is set with the WE8MSWIN1252 character set (option 1) unless the database administrator specifically selects a different character set (option 3).

If the database administrator accepts the default character set in the Initialization Parameters dialog box during Oracle database instance creation, there are no issues with installing the GM Overlay template. However, if the database administrator changes the Oracle database character set to anything other than WE8MSWIN1252, installation or upgrade of the GM Overlay template most likely fails.

To verify whether the character set is set correctly, run the following SQL command:

```sql
SQL> select * from NLS_DATABASE_PARAMETERS;
```

**Note**

This problem can occur if any template having non-ASCII characters is deployed to an Oracle database that has the character set to a value other than WE8MSWIN1252.

For information about how to modify the database character set to work around the problem, see the Oracle documentation.
Chapter 8: Third-party release notes
Chapter 8: Third-party release notes

Third-party release notes

The following release notes pertaining to components supplied by third parties.

- **Teamcenter aborts due to ORA-24347 from Oracle 12.2.0.1 plan**
  
  (First published Teamcenter 12)

  Teamcenter aborts when fetching data due to Oracle generating the following message:

  ORA-24347: Warning of a NULL column in an aggregate function

  This is a problem with Oracle 12.2.0.1 and believed to not be a problem in Oracle releases before Oracle 12.2.

*How to work around or avoid*

Either of the following commands, executed at the system level, should avoid the bad plan that is causing the ORA-24347 to be generated:

- ALTER SYSTEM SET optimizer_features_enable = '12.1.0.2';
- ALTER SYSTEM SET ",_fix_control" = '23210039:0';
Chapter 9: Platform-specific release notes

Microsoft Windows ......................................................... 9-1
Linux platforms ............................................................... 9-1
UNIX platforms ............................................................... 9-2
Apple Macintosh MacOS .................................................... 9-4
Chapter 9: Platform-specific release notes

Microsoft Windows

The following release notes pertain to Microsoft Windows platforms only.

• **English-only toolbars on Windows 8**
  (First published Teamcenter 10.1)

  In the thin client on Windows 8, viewer toolbars are not localized. Toolbars are displayed in English only.

  *How to work around or avoid*

  Currently, there is no workaround for this problem.

• **Viewing contents of a ZIP file from Teamcenter on Windows 7**
  (First published Teamcenter 8.3)

  When a user tries to see the contents of a ZIP file from Teamcenter by double-clicking it, it opens the **My Documents** folder in Windows Explorer instead of showing the contents in the ZIP explorer.

  *How to work around or avoid*

  This is a known issue on Windows 7. To support the current UnZip tool definition, download the latest version of 7-Zip, which does support Windows 7.

• **Data lost when editing Microsoft Excel datasets**
  (First published Teamcenter 2007)

  When you edit a Microsoft Excel dataset and keep the Excel application running, the dataset changes are not saved.

  *How to work around or avoid*

  When editing a Microsoft Excel dataset, close the Excel application after each edit to save the dataset. Otherwise, use Microsoft Office integration.

Linux platforms

The following release notes pertain to Linux platforms only.

• **Cannot Login into Teamcenter rich client on Linux with GTK3**
  (First published Teamcenter 12)

  While Logging into Teamcenter rich client on Linux with GTK3, we get the following error and login is not successful:
java.lang.Thread.State: RUNNABLE
  at org.eclipse.swt.internal.gtk.OS._gdk_window_get_origin
  (Native Method)

*How to work around or avoid*

Check if you have GTK3 using the command below:

```
rpm -q gtk3
```

If the above command returns a GTK3 version and you get the above error during rich client logon, then setting the following will resolve the issue:

```
SWT_GTK3=0
```

- **RedHat Linux machine does not accept connections from Windows or other sources. (SYN packets are ignored.)**

  (First published Teamcenter 12)

  RedHat Linux machine does not accept connections from Windows or other sources. (SYN packets are ignored.)

  *How to work around or avoid*

  This has been found to be a known RedHat Linux TCP daemon issue. This is a third-party issue with a third-party solution.

  To resolve this issue:

  1. Login to each RedHat Linux machine as system admin (root).
  2. Edit the `/etc/sysctl.conf` file. Add or change the following setting: `net.ipv4.tcp_timestamps=0`
  3. Reboot the Linux machine, and restart all servers.

### UNIX platforms

The following release notes pertain to UNIX platforms only.

- **PDF files do not open in PDF reader on UNIX platforms**

  (First published Teamcenter 9.1)

  PDF files do not open in PDF reader on UNIX platforms.

  *How to work around or avoid*

  Save the PDF file on a local directory, then open it using Adobe Acrobat Reader.

- **Dialog box is hidden behind the workbench window on UNIX and Linux**

  (First published Teamcenter 8.3i)

  While running the rich client from a local XWindows session on the UNIX and Linux platforms, a modal dialog box launched from another dialog box is hidden behind the main workbench window.

  *How to work around or avoid*
Move the topmost windows to find the dialog box you were working with.

- **Character set prerequisite for GM Overlay installation on UNIX**

  (First published Teamcenter 2007)

  Installation or upgrade of the GM Overlay feature fails if the ISO8859-1 character set is not loaded.

  **How to work around or avoid**

  Run the `locale --a` command in a shell. If the output does not include ISO8859-1, you must add this character set before you install or use GM Overlay:

  1. Set or export the `LC_ALL` environment variable by typing `LC_ALL=en_US.ISO8859-1` or the equivalent command for your platform.

  2. Verify the setting using the `echo` command or equivalent. Make sure the correct value for `LC_ALL` is displayed.

  3. Run the `locale` command and make sure the `LANG` variable and all the `LC_x` variables are set the same as `LC_ALL`.

  4. If `LANG` is still set to `C`, manually export `LANG` to be the same value as `LC_ALL`.

  5. Launch Teamcenter Environment Manager (`tem.sh`) from the current shell.

  Alternatively, your system administrator may modify the date file (named `TIMEZONE` in the `etc` directory), which can preset this environment, so every time you log on and launch a shell, the environment is preset.

  The recommended method, however, is to log on to the system using the Common Desktop Environment (CDE) with the minimum required locale (ISO8859-1) by choosing `Option→Language→en_US.ISO8859-1` during logon.

  If the ISO8859-1 character set is not loaded on your machine, contact your system administrator to have it installed before you install the GM Overlay.

  This requirement is due to changes in the installation process for Teamcenter 2007, which uses XML files rather than `.dat` files and associated scripts. Because of this, GM Overlay data is transformed from `.dat` files into XML files.

  To read and parse the XML files correctly, the system must be able to process non-English (non-ASCII) locale characters. To facilitate this, the system must be first loaded with the fonts for that locale.

  **Note**

  Ensure the ISO8859-1 character set is loaded before you add any Teamcenter features to your configuration that contains the GM Overlay. If the ISO8859-1 character set is not loaded, lists of values (LOVs) for GM Overlay are corrupted during feature installation.
Apple Macintosh MacOS

The following release notes pertain to the Apple Macintosh MacOS platform only.

- **No files shown in file chooser dialog in thin client in Safari on MacOS**
  
  (First published Teamcenter 11.2)

  In the Teamcenter thin client running in the Apple Safari browser on Macintosh MacOS platforms, the **Choose a file** dialog box contains no files to choose.

  For example, when creating a dataset, click **Browse**. The system displays the **Choose a file** dialog box, but no files are displayed in the dialog box. This is due to the Safari browser's security control.

  **How to work around or avoid**

  1. Choose **Safari→Preferences→Security→Manage Website Settings→Java→Currently Open Websites**.

  2. Select the Teamcenter website, then **Run in Unsafe Mode**.

  3. Log off Teamcenter and log on again.

  The **Choose a file** dialog will now work as expected.

  **Note**

  These steps set Safari to "Unsafe Mode" only for the Java plugin for the Teamcenter website. "Unsafe mode" is not set for all Safari plugins and all websites.

Alternatively, instead of setting "Unsafe Mode" for the Teamcenter Java plugin, you can manually type in a file path in the **Upload file** dialog box.
Siemens Industry Software

Headquarters
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

Americas
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

Europe
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

Asia-Pacific
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.